Contents

Preface

7 Welcome to Final Cut Pro
7 About Final Cut Pro
7 About the Final Cut Pro Documentation
8 Additional Resources

Chapter 1

9 An Overview of Professional Formats and Workflows
10 About Standard Definition Formats
10 About High Definition Video Formats
11 About Digital Cinema Formats

Chapter 2

13 Working with HDV
13 About HDV
17 About the Log and Capture Window
24 Native HDV Editing Workflow
33 Transcoded HDV Editing Workflow
37 Using the Sony HVR-V1 HDV Camcorder
37 HDV Format Specifications

Chapter 3

41 Working with DVCPRO HD
41 About DVCPRO HD
44 Working with DVCPRO HD in Final Cut Pro
49 Choosing 720p60 DVCPRO HD Timecode Display Options
50 Using the DVCPRO HD Frame Rate Converter
56 Working with 24p DVCPRO HD
58 DVCPRO HD Format Specifications

Chapter 4

61 Working with IMX
61 About IMX
62 Working with IMX in Final Cut Pro
63 IMX Format Specifications

Chapter 5

65 Working with Panasonic P2 Cards
65 About Panasonic P2 Cards and Media Files
66 Recording Footage with a P2 Camcorder
Chapter 6

79 Working with AVCHD
79 About AVCHD
79 Working with AVCHD in Final Cut Pro
82 AVCHD Format Specifications

Chapter 7

85 Working with AVC-Intra
85 About AVC-Intra
86 AVC-Intra Formats Supported by Final Cut Pro
86 Working with AVC-Intra Footage
87 Native AVC-Intra Editing Workflow
89 Transcoded AVC-Intra Editing Workflow
90 Finishing and Outputting AVC-Intra Projects
91 AVC-Intra Format Specifications

Chapter 8

93 Working with Sony XDCAM Formats
93 About XDCAM, XDCAM HD, and XDCAM EX
96 Working Natively with Sony XDCAM Formats in Final Cut Pro
101 XDCAM, XDCAM HD, and XDCAM EX Format Specifications

Chapter 9

105 Working with Sony Video Disk Units
105 About Sony Video Disk Units
105 Importing Media from a Sony Video Disk Unit

Chapter 10

109 Working with Apple ProRes
109 About the Apple ProRes Codecs
111 Types of Apple ProRes Codecs
112 Working with Apple ProRes Codecs
115 Apple ProRes Format Specifications
117 Apple ProRes Tips
118 About the Apple Intermediate Codec

Chapter 11

119 Working with REDCODE Media
119 About REDCODE
121 Native REDCODE Editing Workflow
126 Transcoded REDCODE Editing Workflow
129 Finishing and Outputting REDCODE Projects
130 REDCODE Format Specifications
Welcome to Final Cut Pro

This preface covers the following:

- About Final Cut Pro (p. 7)
- About the Final Cut Pro Documentation (p. 7)
- Additional Resources (p. 8)

The first choice of professional editors worldwide, Final Cut Pro delivers high-performance digital nonlinear editing, native support for virtually any video format, and professional-level extensibility and interoperability. Its workflow extends through the other Final Cut Studio applications and Final Cut Server for even more power. Whether you’re working solo or collaborating with a team, Final Cut Pro gives you the creative options and technical control that you need.

About Final Cut Pro

Final Cut Pro is the hub of Final Cut Studio, with powerful capabilities for working with the other Final Cut Studio applications.

Final Cut Pro lets you edit everything from uncompressed SD to HDV, DVCPro HD, and uncompressed HD—as well as Panasonic P2 and Sony XDCAM HD file-based formats. You can mix and match a wide range of formats and even frame rates in the open format Timeline. Final Cut Pro includes a complete set of professional editing and trimming tools that let you work quickly, with a full range of customization options to give you flexibility and control. Also included are powerful multicamera editing tools that allow you to view and cut video from multiple sources in real time.

About the Final Cut Pro Documentation

Final Cut Pro comes with various documents that will help you get started as well as provide detailed information about the application.

- *Exploring Final Cut Pro*: The *Exploring Final Cut Pro* manual presents the basics of Final Cut Pro in an easy, approachable way. Each chapter presents major features and guides you in trying things out. A PDF version of the printed manual is available in Final Cut Pro Help (in Final Cut Pro, choose Help > Final Cut Pro Help).
• **Final Cut Pro 7 User Manual:** The onscreen user manual is a comprehensive document that describes the Final Cut Pro interface, commands, and menus and gives step-by-step instructions for creating Final Cut Pro projects and for accomplishing specific tasks. It is written for users of all levels of experience. The user manual is available in Final Cut Pro Help.

• **Professional Formats and Workflows:** This document covers how to use digital cinema, high definition, and broadcast formats (such as DVCPRO HD, HDV, AVC-Intra, Sony XDCAM, REDCODE, and Apple ProRes) and devices (such as Sony Video Disk Units and Panasonic P2 cards) with Final Cut Pro. This document is available in Final Cut Pro Help.

### Additional Resources
Along with the documentation that comes with Final Cut Pro, there are a variety of other resources you can use to find out more about Final Cut Pro.

**Final Cut Pro Website**
For general information and updates, as well as the latest news on Final Cut Pro, go to:


**Apple Service and Support Websites**
For software updates and answers to the most frequently asked questions for all Apple products, go to the general Apple Support webpage. You'll also have access to product specifications, reference documentation, and Apple and third-party product technical articles.


For software updates, documentation, discussion forums, and answers to the most frequently asked questions for Final Cut Pro, go to:


For discussion forums for all Apple products from around the world, where you can search for an answer, post your question, or answer other users’ questions, go to:

- [http://discussions.apple.com](http://discussions.apple.com)
This chapter covers the following:

- About Standard Definition Formats (p. 10)
- About High Definition Video Formats (p. 10)
- About Digital Cinema Formats (p. 11)

More and more video formats are introduced every year. Making Final Cut Pro the center of your post-production workflow ensures that your suite is compatible with the latest digital cinema, high definition, and broadcast formats.

The diagram below shows the relative frame sizes for common SD, HD, and digital cinema formats that are edited in Final Cut Pro today.
About Standard Definition Formats
During most of the decades of color television broadcasting and video technology, the video medium was defined as 525 or 625 interlaced lines per frame at either 29.97 or 25 frames per second (fps). With the emergence of new high definition (HD) video formats, video signals meeting these older broadcast standards are now referred to as standard definition (SD) video formats.

For complete details about and specifications for standard definition formats, see “Appendix A: Video Formats” in the Final Cut Pro 7 User Manual.

About High Definition Video Formats
Digital high definition (HD) formats are defined by their vertical resolutions (number of lines), scanning methods (interlaced versus progressive), and frame or field rates. For example, the 1080i60 format has 1080 lines per frame, uses interlaced scanning (indicated by the \( i \)), and scans 59.94 fields per second. HD frame rates are compatible with NTSC video, PAL video, or film.

**Note:** For comparison to HD formats, standard definition (SD) video formats are now defined in similar terms. For example, 480i60 has 480 lines, interlaced scanning, and 59.94 fields per second (NTSC).

**NTSC-Compatible HD Formats**
The following table shows common NTSC-compatible HD formats.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1080i60  | - Has high-resolution frames, is able to capture fast movement, and has reduced vertical resolution due to interlacing.  
|          | - Easily downconverts to NTSC. |
| 1080p30  | - Has high-resolution frames.  
|          | - Movement is less smooth but resolution is higher than interlaced formats in areas of movement. |
| 720p60   | - Captures fast-action movement with clarity. However, still frames have lower resolution than 1080-line still frames.  
|          | - Is ideal for sports videography and commercial television.  
|          | - Easily downconverts to NTSC. |
| 720p30   | - Is a variant of 720p60 with a lower frame rate. |

**PAL-Compatible HD Formats**
The following table shows common PAL-compatible HD formats.
### Format Description

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1080i50  | • Has high-resolution frames, is able to capture fast movement, and has reduced vertical resolution due to interlacing.  
          | • Easily downconverts to PAL.                                                                        |
| 1080p25  | • Has high-resolution frames.  
          | • Movement is less smooth but resolution is higher than interlaced formats in areas of movement.     |
| 720p50   | • Captures fast-action movement with clarity. However, still frames have lower resolution than 1080-line still frames.  
          | • Is ideal for sports videography and commercial television.                                         
          | • Easily downconverts to PAL.                                                                        |
| 720p25   | • Is a variant of 720p50 with a lower frame rate.                                                     
          | • Can be slowed down to 24 fps for film transfers or downconverted to PAL.                           |

### Film-Compatible HD Formats
The following table shows common film-compatible HD formats.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080p24</td>
<td>• Has the resolution, scanning method, frame rate, and aspect ratio closest to film.</td>
</tr>
</tbody>
</table>
| 720p24   | • Is the same as 1080p24, but with lower resolution.                                                  
          | • Is ideal for a “film transferred to video” look.                                                    |

### About Digital Cinema Formats
The newest professional video category is that of *digital cinema* cameras and formats. These cameras have large imaging chips (16mm, 35mm, or larger), which allow for the use of cinema lenses with accompanying high image quality and depth-of-field control, as well as high imaging resolution, progressive field image capture, and advanced light sensitivity. Digital cinema cameras record at least 1080 lines per frame. Most of these cameras also record at 2K and 4K resolutions, requiring a proprietary RAW format or DPX image sequence capture. Digital cinema cameras capture 4:4:4 RGB color.

Many digital cinema cameras, such as the RED ONE camera manufactured by the RED Digital Cinema Camera Company, record their own proprietary RAW formats. Some digital cinema cameras can record to other formats. For instance, the Panavision Genesis camera is often configured to record to a Sony HDCAM SR deck. In this case, the media format corresponds to the recording deck, not the camera. The Thomson Viper FilmStream camera, on the other hand, records straight to DPX image sequences, making the process very similar to a digital intermediate (DI) workflow.
Final Cut Pro workflows for digital cinema formats include ingesting native RAW camera media as QuickTime files, ingesting from Sony HDCAM SR video decks, and ingesting DPX image sequences. (See the Color User Manual for more information about DPX image sequence workflows.)

<table>
<thead>
<tr>
<th>Recording format</th>
<th>Description</th>
<th>Example cameras</th>
</tr>
</thead>
</table>
| RAW camera formats       | RAW image files contain uninterpreted, bit-for-bit digital data from the camera's image sensor when the images are captured. Along with the pixels in the image, the RAW file also contains data about how the image was shot, such as exposure settings and the camera and lens type. This information is also known as metadata. Using RAW formats, you can grade and finish using the most accurate and basic 4:4:4 RGB data about an image. | • RED ONE  
• Vision Research Phantom  
• Silicon Imaging SI-2K |
| Sony HDCAM SR            | Sony HDCAM SR is capable of recording in 10-bit 4:2:2 or 4:4:4 RGB, with a video data rate of 440 Mbps in SQ mode and 880 Mbps in HQ mode. Several digital cinema cameras use Sony HDCAM SR as their recording medium. | • Panavision Genesis  
• Arriflex D-20 |
| DPX image sequences      | Digital Picture Exchange (DPX) is a common file format for digital intermediate and visual effects work and is an ANSI/SMPTE standard (268M-2003). Visual information is stored as a series of high-resolution still images. | • Thomson Viper FilmStream  
• Vision Research Phantom  
• Arriflex D-20 (with optional hardware) |
Working with HDV

This chapter covers the following:

• About HDV (p. 13)
• About the Log and Capture Window (p. 17)
• Native HDV Editing Workflow (p. 24)
• Transcoded HDV Editing Workflow (p. 33)
• Using the Sony HVR-V1 HDV Camcorder (p. 37)
• HDV Format Specifications (p. 37)

Final Cut Pro supports native capturing, editing, and output of HDV media. If you already have experience editing DV footage, making the switch to HDV is simple.

About HDV

HDV is an HD format created by a consortium of manufacturers including Sony, JVC, Canon, and Sharp. HDV allows you to record an hour of HD video on standard mini-DV videocassettes. You can connect an HDV camcorder to your computer via FireWire, so you can capture and output just as you would with a DV device.

HDV uses MPEG-2 compression to achieve a maximum video data rate of 25 Mbps, which is the same as the DV data rate. This means you can fit the same amount of video on your scratch disks as you can when using DV.

Although the HDV workflow is nearly identical to a typical DV workflow, a few additional steps are required. This chapter describes the unique features of Final Cut Pro that allow you to capture, edit, and output HDV video in its native format.

HDV Formats Supported by Final Cut Pro

Within the HDV specification, 1080-line and 720-line formats using several frame rates are defined. Final Cut Pro supports the following HDV formats.

59.94 fps–Based Formats

The following table shows the 59.94 fps–based HDV formats supported by Final Cut Pro.
### Final Cut Pro Easy Setup

<table>
<thead>
<tr>
<th>Format</th>
<th>Final Cut Pro Easy Setups</th>
<th>Frame dimensions</th>
<th>Video data rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i60</td>
<td>HDV - 1080i60</td>
<td>1440 x 1080</td>
<td>25 Mbps</td>
</tr>
<tr>
<td>1080i60 (Canon)</td>
<td>HDV - 1080i60 FireWire Basic</td>
<td>1440 x 1080</td>
<td>25 Mbps</td>
</tr>
<tr>
<td>1080F30 (Canon)</td>
<td>HDV - 1080p30 FireWire Basic</td>
<td>1440 x 1080</td>
<td>25 Mbps</td>
</tr>
<tr>
<td>1080F24 (Canon)</td>
<td>HDV - 1080p24 FireWire Basic</td>
<td>1440 x 1080</td>
<td>25 Mbps</td>
</tr>
<tr>
<td>720p60</td>
<td>HDV - 720p60</td>
<td>1280 x 720</td>
<td>18.3 Mbps</td>
</tr>
<tr>
<td>720p30</td>
<td>HDV - 720p30</td>
<td>1280 x 720</td>
<td>18.3 Mbps</td>
</tr>
<tr>
<td>720p24</td>
<td>HDV - 720p24</td>
<td>1280 x 720</td>
<td>18.3 Mbps</td>
</tr>
</tbody>
</table>

#### 50 fps–Based Formats

The following table shows the 50 fps–based HDV formats supported by Final Cut Pro.

<table>
<thead>
<tr>
<th>Format</th>
<th>Final Cut Pro Easy Setups</th>
<th>Frame dimensions</th>
<th>Video data rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i50</td>
<td>HDV - 1080i50</td>
<td>1440 x 1080</td>
<td>25 Mbps</td>
</tr>
<tr>
<td>1080i50 (Canon)</td>
<td>HDV - 1080i50 FireWire Basic</td>
<td>1440 x 1080</td>
<td>25 Mbps</td>
</tr>
<tr>
<td>1080F25 (Canon)</td>
<td>HDV - 1080p25 FireWire Basic</td>
<td>1440 x 1080</td>
<td>25 Mbps</td>
</tr>
<tr>
<td>720p50</td>
<td>HDV - 720p50</td>
<td>1280 x 720</td>
<td>18.3 Mbps</td>
</tr>
<tr>
<td>720p25</td>
<td>HDV - 720p25</td>
<td>1280 x 720</td>
<td>18.3 Mbps</td>
</tr>
</tbody>
</table>

#### Standard Definition Recording with an HDV Camcorder

In addition to recording HD video, most HDV camcorders can also record standard definition DV video. You can capture, edit, and output this DV video just as you would any other DV video.

*Important:* You should avoid recording DV and HDV video on the same tape. (You should also avoid recording HDV footage using different frame sizes and frame rates on the same tape.) This can cause problems during capture and playback.

An additional format defined within the HDV specification, known as SD, is available on some JVC camcorders. Final Cut Pro does not support this format.
About MPEG Compression
HD video requires significantly more data than SD video. A single HD video frame can require up to six times more data than an SD frame. To record such large images with such a low data rate, HDV uses long-GOP MPEG compression. MPEG compression reduces the data rate by removing redundant visual information, both on a per-frame basis and also across multiple frames.

Note: HDV specifically employs MPEG-2 compression, but the concepts of long-GOP and I-frame-only compression discussed below apply to all versions of the MPEG standard: MPEG-1, MPEG-2, and MPEG-4 (including AVC/H.264). For the purposes of this general explanation, the term MPEG may refer to any of these formats.

Spatial Compression
Within a single frame, areas of similar color and texture can be coded with fewer bits than the original frame, thus reducing the data rate with a minimal loss in noticeable visual quality. JPEG compression works in a similar way to compress still images. Spatial, or intraframe, compression is used to create standalone video frames called I-frames (short for intraframe).

Temporal Compression
Instead of storing complete frames, temporal (interframe) compression stores only what has changed from one frame to the next, which dramatically reduces the amount of data that needs to be stored while still achieving high-quality images. Video is stored in three types of frames: a standalone I-frame that contains a complete image, and then predictive P-frames and bipredictive B-frames that store subsequent changes in the image. Every half second or so, a new I-frame is introduced to provide a complete image on which subsequent P- and B-frames are based. Together, a group of I-, P-, and B-frames is called a group of pictures, or GOP. HDV uses a long-GOP pattern, which means that there is at least one P- or B-frame for each I-frame.

For example, suppose you record some typical “talking head” footage, such as an interview in which a seated person moves very little throughout the shot. Most of the person’s body stays still, so most of the visual information is stored in an I-frame; the subsequent P- and B-frames store only the changes from one frame to the next.

Because P- and B-frames depend on other frames to create a meaningful image, your computer spends more processing power decoding HDV frames for display than it does when displaying intraframe-only formats such as DV, uncompressed video, or the Apple Intermediate Codec.
More About Long-GOP Video

The term long refers to the fact that P- and B-frames are used between I-frame intervals. At the other end of the spectrum, the opposite of long-GOP MPEG is I-frame-only MPEG, in which only I-frames are used. Formats such as IMX use I-frame-only MPEG, which reduces temporal artifacts and improves editing performance. However, I-frame-only formats have a significantly higher data rate because each frame must store enough data to be completely self-contained. Therefore, although the decoding demands on your computer are decreased, there is a greater demand for scratch disk speed and capacity.

1080-line HDV media uses an open GOP structure, which means that B-frames in the MPEG stream can be reliant on frames in adjacent GOPs. 720-line HDV media uses a closed GOP structure, which means that each GOP is self-contained and does not rely on frames outside the GOP.

Transcoding HDV to Other Apple Codecs

Instead of working with native MPEG-2 HDV video, you can transcode your HDV video to an Apple ProRes codec or the Apple Intermediate Codec during capture. For more information about these codecs, see “Transcoded HDV Editing Workflow,” “Working with Apple ProRes,” and “About the Apple Intermediate Codec.”

Unlike MPEG-2 HDV, these Apple codecs do not use temporal compression, so every frame can be decoded and displayed immediately, without first decoding other frames.

You can also capture and edit native HDV but render your footage using an Apple ProRes codec. For more information, see “Stage 4: Choosing a Render File Format for HDV Sequences” in “Native HDV Editing Workflow.”

Working with HDV in Final Cut Pro

If you’ve previously worked with DV, you’ll find that the HDV workflow is similar. However, the nature of MPEG-2 long-GOP editing can add significant rendering time when editing native HDV. To avoid this, you may want to choose one of the other HDV editing workflows.

There are two main workflows for working with HDV footage in Final Cut Pro.

Native MPEG-2 HDV Capturing, Editing, and Rendering

This is the default HDV workflow. For more information, see “Native HDV Editing Workflow.”
A slight variation of this native workflow involves rendering using an Apple ProRes codec. For more information, see “Stage 4: Choosing a Render File Format for HDV Sequences” in “Native HDV Editing Workflow.”

You can only output HDV footage to tape using the Print to Video command. The Edit to Tape command is not supported for HDV media. For more information, see “Stage 7: Using the Print to Video Command to Output HDV” in “Native HDV Editing Workflow.”

**Transcoding, Editing, and Rendering Using an Alternative Codec**

In this workflow, you transcode your media to an alternative codec directly on ingest. For more information, see “Transcoded HDV Editing Workflow.”

In the illustration below, the media is transcodded to an Apple ProRes codec, but you can also use the Apple Intermediate Codec in a transcoded HDV workflow.

**About the Log and Capture Window**

You use the Log and Capture window to capture your HDV footage.

**To open the Log and Capture window**

- Choose File > Log and Capture (or press Command-8).
The Log and Capture window appears.

The Log and Capture window contains several general areas:

- **Preview area**: On the left is the area where you view video while logging clips. This area contains transport controls, marking controls, and timecode fields. If device control is not available, the transport controls do not appear.

- **Tabs**: On the right are the Logging, Clip Settings, and Capture Settings tabs.

- **Log and capture buttons**: You click one of these buttons when you are ready to log a clip or capture media.

The resize control in the lower-right corner allows you to adjust the size of the Log and Capture window. This option is available only when you select an HDV Easy Setup.
Preview Area

This section of the Log and Capture window lets you view video from tape while you log and capture it. If your camcorder or deck is not on or there is no tape inserted, you’ll see color bars or black. The following controls appear if your camcorder or deck is on and properly connected, and device control is available.

- **Clip In Point Timecode field**
- **Current Timecode field**
- **Clip Out Point Timecode field**
- **Timecode Duration field**
- **Video preview area**
- **Device status**
- **Shuttle control**
- **Transport controls**
- **Available time**
- **Available space**

**Important:** If your computer has a PCI graphics card installed and you are logging or capturing HDV footage, Final Cut Pro does not preview video or audio in the Log and Capture window. You can still log and capture, but you need to use your HDV camcorder display to preview video.

The preview area contains the following elements:

- **Current Timecode field:** Displays the timecode number of the current frame of your source tape. You can enter a timecode number in this field to navigate to that timecode point on your tape.

  **Tip:** When using the Log and Capture window with a native HDV Easy Setup, you can drag timecode values between the Log and Capture timecode fields by holding down the Option key while you drag a timecode value from one field to another. Dragging timecode from other windows is not supported.

- **Available space and time:** Final Cut Pro displays the amount of available space on all currently assigned scratch disks.
• **Timecode Duration field**: Displays the duration, in timecode, between the current tape In and Out points. If you enter a duration in this field, the Out point is adjusted.

• **Shuttle control**: A shuttle control similar to the one in the Viewer and Canvas is available for navigating through the tape.

In the Log and Capture window, you can use the J, K, and L keys for playback and shuttling, just as you can in the Viewer and Canvas. For more information about using the J, K, and L keys for playback, see the *Final Cut Pro 7 User Manual*.

**Note**: Tape playback is not as efficient as playback from media files on your hard disk. It takes a few seconds for a tape to cue to the proper frame or change playback direction. The video frames and timecode displayed on the camcorder LCD screen may differ from the frames you see in the video preview area. This is because Final Cut Pro is decoding the MPEG-2 HDV in real time.

• **Marking controls**: Use these controls to set In and Out points for a clip on tape.

• **Mark In**: Click this (or press I) to set the In point for a clip on tape.

• **Clip In Point Timecode field**: Shows the timecode value of the currently set In point.

• **Go to In Point**: Click this to cue the connected VTR to the currently set In point.

• **Mark Out**: Click this (or press O) to set the Out point for a clip on tape.

• **Clip Out Point Timecode field**: Shows the timecode value of the currently set Out point.

• **Go to Out Point**: Click this to cue the connected camcorder or VTR to the currently set Out point.

• **Device status**: Shows the readiness of camcorders and decks connected to your computer and being controlled by Final Cut Pro. If you see “VTR OK,” your equipment is connected and working properly.
- **Transport controls:** If you have device control, use these to control your camcorder or deck. These controls are similar to controls in the Viewer and Canvas, except that they control playback of a videotape instead of a media file.

![Transport controls diagram]

**Tabs in the Log and Capture Window**
The Log and Capture window has several tabs you can use for logging and capturing your HDV footage.

**Logging Tab**
Use this tab to add descriptive information to each clip that you log, such as reel name, scene/take number, log notes, markers, and so on. Much of this information can also be added later in the Browser.

![Log and Capture window diagram]
Clip Settings Tab
Use this tab to select which video and audio tracks you capture from tape. You can choose to capture video only, audio only, or both video and audio. You can also specify which audio channels you capture.

When an HDV Easy Setup is chosen, only two audio channels are available for capture. You can choose to capture one channel or you can capture both audio channels, either as two discrete mono tracks or a single stereo pair.
**Capture Settings Tab**
Use this tab to specify scratch disks for capture. You can also specify scratch disk settings by choosing Final Cut Pro > System Settings and then clicking the Scratch Disks tab.

Click here to open the Scratch Disks tab.

Current scratch disk capacity and Capture Now settings are shown here.

---

**Log and Capture Buttons**
As you log and capture, use the following log and capture buttons.

- **Log Clip**: Logs a single clip with the current logging information and clip settings.
- **Capture Clip**: Logs and captures a single clip with the current logging information, clip settings, and capture settings.
- **Capture Now**: Captures the current video and audio input to a media file on disk until you press the Esc (Escape) key. No In or Out points are necessary. You can use this to capture an entire tape in a single pass. When scene breaks are detected, new media files and corresponding clips are created automatically.
- **Capture Batch**: Captures the selected clips in the Browser, or the clips in the currently assigned logging bin.
Native HDV Editing Workflow

If you use this method, you capture, edit, and output your original MPEG-2 HDV data throughout the entire process. This process is referred to as native editing because Final Cut Pro works directly with the MPEG-2 data captured from your HDV tapes. Native HDV playback is processor-intensive because displaying a single frame can require decoding of several frames earlier or later in the video stream. As a result, you may be able to play back fewer real-time effects when editing in this format. However, there are many benefits to native HDV editing:

- Native HDV editing uses less disk space because long-GOP MPEG-2 HDV video has a very low data rate.
- Outputting HDV to tape requires little processing before output because your video is already in the native HDV format. Only segments of your sequence that contain cuts or effects must be reencoded, or conformed, to create the proper HDV GOP pattern.

This workflow is useful for cuts-only edits that you want to quickly output back to tape, or for export to other MPEG formats.

The process for capturing, editing, and outputting HDV in Final Cut Pro is almost identical to the workflow used for DV, but there are several important differences. The differences between the HDV and DV workflows are highlighted in the sections that follow.

- Stage 1: Connecting an HDV Camcorder to Your Computer via FireWire
- Stage 2: Choosing an HDV Easy Setup
- Stage 3: Logging and Capturing Native HDV Footage
- Stage 4: Choosing a Render File Format for HDV Sequences
- Stage 5: Editing HDV Footage Natively
- Stage 6: Rendering and Conforming Long-GOP MPEG-2 Media
- Stage 7: Using the Print to Video Command to Output HDV
Stage 1: Connecting an HDV Camcorder to Your Computer via FireWire

This stage is similar to connecting a DV device via FireWire. Once you have HDV footage on tape, you can connect your camcorder or VTR to your computer to capture.

To connect your HDV camcorder or VTR to your computer

1. Turn on your VTR or camcorder and switch it to VCR (or VTR) mode.
   
   **Note:** On some camcorders, this mode may be labeled “Play.”

2. Connect the connector on one end of your FireWire cable to the FireWire port on your camcorder.

3. Connect the connector on the other end of your FireWire cable to a FireWire 400 port on your computer.

4. Make sure your camcorder is in HDV mode, not DV mode.

   For more information, see the documentation that came with your HDV device.

Stage 2: Choosing an HDV Easy Setup

Final Cut Pro has several native HDV Easy Setups available. Always choose the Easy Setup that corresponds to your footage.

To choose an Easy Setup

1. Choose Final Cut Pro > Easy Setup.

2. Choose HDV from the Format pop-up menu.

3. Choose “(all rates)” from the Rate pop-up menu.

4. Click the Use pop-up menu to see all of the Easy Setups related to your choice in the Format pop-up menu.

   You can further refine the list by choosing a specific frame rate from the Rate pop-up menu.

5. Choose an Easy Setup from the Use pop-up menu.
**Important:** Make sure to choose an Easy Setup that matches the format of your HDV source tapes.

6 Click Setup.

The corresponding capture, sequence, and device control presets are loaded, as well as A/V device settings.

**Stage 3: Logging and Capturing Native HDV Footage**

This stage is much like logging and capturing DV and other video formats. The differences are:

- Some options and controls are different in the Log and Capture window when you capture HDV. For example, you can resize the window in real time.

- When capturing HDV, scene detection is always enabled. A scene break is embedded data on tape that indicates where the camcorder was stopped and then started again. Whenever Final Cut Pro detects a scene break in your incoming HDV footage, a new media file and corresponding clip are created.

Once you’ve connected your camcorder and chosen the appropriate Easy Setup, you can log and capture your footage. When you select a native HDV Easy Setup, the Log and Capture window appears, specifically tailored for use with HDV. For information about the Log and Capture window, see “About the Log and Capture Window.”

For detailed instructions about logging and capturing, see the following chapters in the *Final Cut Pro 7 User Manual*:

- “Overview of Capturing Tape-Based Media”
- “About the Log and Capture Window”
- “Logging from Tape”
- “Capturing Audio from Tape”

When you capture HDV footage, you can control how media files are created when start/stop indicators and timecode breaks are detected. This behavior is slightly different from the way DV footage is handled:

- *When you capture DV:* Start/Stop indicators can be detected after capture if you select the clip and choose Mark > DV Start/Stop Detect.

- *When you capture HDV:* You can control whether start/stop indicators create individual media files by selecting or deselecting the “Create new clip on Start/Stop” checkbox in the Clip Settings tab of the Log and Capture window.

In the General tab of the User Preferences window, the option you choose from the “On timecode break” pop-up menu determines how timecode breaks affect capture, but the Warn After Capture option is disregarded to avoid capturing media files that contain breaks in the middle of an MPEG-2 GOP.
To choose how Final Cut Pro handles start/stop detection when capturing HDV footage

1 If you have not already done so, choose Final Cut Pro > Easy Setup, choose HDV from the Format pop-up menu, and then choose an Easy Setup from the Use pop-up menu.

2 Choose File > Log and Capture (or press Command-8), then click Clip Settings.

3 Select or deselect the “Create new clip on Start/Stop” checkbox to turn start/stop detection on or off:
   - **Start/Stop detection on:** When the checkbox is selected, a new media file and corresponding clip are created each time Final Cut Pro detects start/stop indicators in the incoming HDV stream.
   - **Start/Stop detection off:** When the checkbox is deselected, one continuous media file and corresponding clip are created, and start/stop indicators are ignored.

**Note:** The option to turn off start/stop detection is not available when capturing footage shot on a JVC HDV camcorder because the nature of the MPEG-2 stream requires creation of a new media file at each start/stop indicator.

To determine how timecode breaks are handled when you capture HDV footage

1 Choose Final Cut Pro > User Preferences, then click the General tab.

2 Choose an option from the “On timecode break” pop-up menu:
   - **Make New Clip:** This is the default option. Whenever a timecode break is detected during capture, Final Cut Pro finishes writing the current media file to disk and then begins capturing a new media file. A clip corresponding to the new media file is also created in the Browser.
   - **Abort Capture:** If you choose this option, Final Cut Pro stops capture immediately when a timecode break is detected. All media captured before the timecode break has frame-accurate timecode and is preserved. The resulting media files are saved, and the corresponding clips are placed in the Browser.

Depending on the signal on tape, you may see one of two messages when a timecode break is detected:
   - A “stream error” message
   - A “timecode break error” message
   - **Warn After Capture:** When you capture HDV, this option behaves identically to the Abort Capture option.
How Timecode Breaks Affect Clip and Media Filenames

Filenames for new media files and clips generated by start/stop indicators and timecode breaks are appended with a number to ensure they have unique names. For example, suppose you are capturing a media file named Cafe Wide Shot when a scene or timecode break is detected. At the break detection point, Final Cut Pro begins capturing a new media file named Cafe Wide Shot-1. If there is already a media file named Cafe Wide Shot-1, the new media file is named Cafe Wide Shot-2, and so on.

Recapturing HDV footage is similar to recapturing other video formats. It is important that your clips contain accurate timecode, or you may have difficulty recapturing. For more information about recapturing footage, see the *Final Cut Pro 7 User Manual*.

*Important:* Some HDV camcorders do not record timecode, so recapturing media files from tapes recorded by these camcorders may result in new media files with an offset of one or two frames.

Using an HDV Camcorder to Capture or Output DV Footage

You can use an HDV camcorder as a standard DV device. However, before doing this, make sure that:

- The Log and Capture window is closed.
- The camcorder is set to DV mode, not HDV mode. For more information, see the documentation that came with your camcorder.
- You choose the proper DV Easy Setup before opening the Log and Capture window.

Stage 4: Choosing a Render File Format for HDV Sequences

When you render segments of an HDV sequence, you can choose to create render files using either the native HDV MPEG-2 codec of your sequence or an Apple ProRes codec.

Rendering native MPEG-2 HDV creates small render files that conserve disk space, but rendering takes longer than for other formats because of the interframe compression this format uses.
If native rendering is slowing down the pace of your editing, you can choose to render segments of your native HDV sequences using an Apple ProRes codec. Because Final Cut Pro supports mixed-format sequences, you can play back the entire sequence, including the Apple ProRes codec files, in real time. In this slight variation of the native HDV editing workflow, you continue to edit using a native HDV sequence, but any render files will be in an Apple ProRes codec.

The advantages to using an Apple ProRes codec as the rendering codec are:

• Apple ProRes codecs use I-frame–only (intraframe) encoding, providing faster rendering and real-time playback performance.

• Apple ProRes codecs have a generous color sample ratio and bit depth, allowing for higher-quality rendering of visual effects.

The advantages to rendering natively are:

• Conforming for export or output to HDV tape happens faster because the render files are already in the necessary format. If you aren’t outputting to an HDV format, this may not be an advantage.

• Native HDV render files are smaller than those generated by other HD I-frame–only codecs.

To choose the render file format in an HDV sequence

1 Select your sequence in the Browser or Timeline.
2 Choose Sequence > Settings, then click the Render Control tab.
3 From the Codec pop-up menu, choose one of the following options:
   - Same as Sequence Codec: This option enables rendering with the native MPEG-2 codec of your sequence.
   - Apple ProRes 422 Codec: This option enables rendering with the Apple ProRes 422 codec.

Note: Because HDV, XDCAM HD, and XDCAM EX constant bit rate (CBR) footage use an identical format, the information in this section also applies when rendering XDCAM HD and XDCAM EX footage.
Stage 5: Editing HDV Footage Natively

For the most part, editing HDV footage is identical to editing any other format in Final Cut Pro. However, because of the GOP structure of MPEG-2 media, edits in HDV sequences require some additional processing during playback and output. The additional processing happens automatically, but it is a good idea to understand why it is necessary.

When you edit two HDV clips together in a sequence, the GOP pattern is typically broken. In particular, cutting an HDV clip can remove the I-frame that subsequent P- and B-frames rely on for picture information. When this happens, Final Cut Pro must preserve the I-frame for these other frames to refer to, even though the I-frame is no longer displayed in the sequence. Final Cut Pro reconforms the broken GOPs in the vicinity of the edit and leaves the subsequent GOPs unchanged.

This requires additional processing power and memory not necessary for I-frame-only editing (such as DV editing). During playback, this process happens in real time. For output and export, Final Cut Pro reencodes (or conforms) the areas of your sequence that require new I-frames or GOPs.

To save time during rendering and editing, you can set up your native HDV sequence to render using an Apple ProRes codec. Using an Apple ProRes codec also produces high-quality 4:2:2 render files that, in some cases, may be higher quality than rendering back to native HDV. For more information, see “Stage 4: Choosing a Render File Format for HDV Sequences.”

Note: Some applications, such as DVD Studio Pro, support simple MPEG-2 editing, in which you are allowed to cut only at GOP boundaries. Final Cut Pro allows you to cut on any frame. Although you cannot set Final Cut Pro to edit on GOP boundaries only, you can transcode your source files to an Apple ProRes codec, ensuring I-frame-only editing, or you can temporarily turn off the reconforming of the GOP boundaries by deselecting one or more render status categories in the appropriate Render submenu of the Sequence menu.

Stage 6: Rendering and Conforming Long-GOP MPEG-2 Media

Before you can output or export a native HDV sequence, Final Cut Pro needs to process your media in two ways:

• Render any applied transitions and effects, as well as any leader and trailer elements included in the Print to Video dialog.

• Conform any noncompliant GOPs to the correct I-, P-, and B-frame pattern. Any segments of your sequence that contain cuts, transitions, or other applied effects must be conformed to standard MPEG-2 GOP structures before output, creating new I-frames and GOP boundaries where necessary. Conforming also ensures that your HDV sequence has the proper data rate for the HDV format you are outputting. The time required for conforming depends on the number of edits and effects in your sequence.
Note: Because HDV, XDCAM HD, and XDCAM EX constant bit rate (CBR) footage use an identical format, the information in this section also applies when rendering XDCAM HD and XDCAM EX footage.

Conforming While Rendering in the Timeline
If you choose to use native HDV render files while you edit, your render files can be conformed when they are rendered. You can generate properly conformed render files for your sequence by enabling all options in the Render All, Render Selection, and Render Only submenus of the Sequence menu.

For example, if you enable rendering for all render status categories in the Render Selection submenu and then choose Sequence > Render Selection > Video, the render files created for selected video items in the Timeline are conformed with proper GOP structures. When you output to tape or export using the Export QuickTime Movie command, these render files are already properly conformed, reducing the time required for final rendering and conforming.

Tip: You can disable conforming during rendering in the Timeline by deselecting one or more render status categories in the appropriate Render submenu of the Sequence menu.

Stage 7: Using the Print to Video Command to Output HDV
You can only output HDV footage to tape using the Print to Video command. The Edit to Tape command is not supported for HDV media.

Optionally, you can export your sequence as a QuickTime movie, export your sequence to Compressor, or send your sequence to Color for finishing. You can also use the Share feature to quickly create and deliver output media files in iPod, iPhone, Apple TV, MobileMe, DVD, Blu-ray Disc, YouTube, and Apple ProRes formats.


To prepare for tape output, any effects in your HDV sequence need to be rendered, and then the sequence must be conformed to create a proper MPEG-2 output stream. These steps happen automatically when you begin a Print to Video operation.

During a Print to Video operation, Final Cut Pro renders and conforms video in a single pass, storing properly conformed media within your sequence’s render files. As a result, subsequent Print to Video operations don’t need to conform the video unless you make changes to your sequence. However, leader and trailer elements, as well as gaps in your sequence, are rendered and conformed each time you use the Print to Video command.
To output your HDV sequence to tape

1 Make sure your camcorder is properly connected to your computer via FireWire.
   For more information, see “Stage 1: Connecting an HDV Camcorder to Your Computer via FireWire.”

2 Insert a DV tape into the HDV camcorder.

3 In the Browser, do one of the following:
   • Select a sequence or clip.
   • Double-click a sequence to open it in the Timeline.
   • Double-click a clip to open it in the Viewer.

4 Choose File > Print to Video.
   The Print to Video dialog appears.

5 Select any leader or trailer elements you want to include on your tape, as well as start, end, and looping options.
   **Tip:** If you want Final Cut Pro to start recording automatically, select the Automatically Start Recording checkbox.

6 Click OK.
   If any segments of your sequence require rendering or conforming, Final Cut Pro renders and conforms them now. A progress dialog appears indicating the amount of time that remains until rendering and conforming are complete. Any segments of your sequence where GOP boundaries were broken (such as the frames around edit points or any frames with added filters, motion parameters, and so on) are conformed.

   A second progress dialog briefly appears indicating the time it takes to process leader, trailer, and gap elements in your sequence.

   A dialog appears when your sequence is ready for output.

7 If you did not select the Automatically Start Recording checkbox in the Print to Video dialog, press the record button on your camcorder or deck, then click OK.
   If your tape is write-protected or if frames are dropped during the Print to Video operation, a dialog appears allowing you to try the operation again.

**Note:** When using the Print to Video command with a JVC ProHD device, you can output sequence timecode to tape. For more information about proper deck settings, see the documentation included with your JVC device.
Transcoded HDV Editing Workflow
When you edit using footage encoded with an Apple ProRes codec or the Apple Intermediate Codec, you can edit just as you would with any other I-frame-only encoded footage, such as DV or uncompressed video. This workflow is particularly convenient if your project involves multiple camera formats and you want to standardize on a single codec for editing.

The disadvantage of this workflow is that more scratch disk capacity is required for your footage, and you cannot output HDV to tape without first reencoding your entire sequence back to native HDV. If your sequence is long, the reencoding process can be time-consuming.

- Stage 1: Connecting an HDV Camcorder to Your Computer
- Stage 2: Choosing an Easy Setup
- Stage 3: Capturing and Transcoding HDV Video
- Stage 4: Editing Your Transcoded Clips into a Sequence
- Stage 5: Outputting to HDV Tape or Other Formats

Stage 1: Connecting an HDV Camcorder to Your Computer
This stage is identical to connecting your HDV camcorder for MPEG-2 HDV capture. For details, see “Stage 1: Connecting an HDV Camcorder to Your Computer via FireWire” in “Native HDV Editing Workflow.”

Stage 2: Choosing an Easy Setup
Final Cut Pro includes Easy Setups for capturing and editing HDV transcoded to an Apple ProRes codec or the Apple Intermediate Codec.

To choose an Easy Setup for transcoding HDV
1 Choose Final Cut Pro > Easy Setup.
2 Choose one of the following from the Format pop-up menu:
   • Apple Intermediate Codec
   • Apple ProRes 422
3 Click the Use pop-up menu to see all of the Easy Setups related to your choice in the Format pop-up menu.
   You can further refine the list by choosing a specific frame rate from the Rate pop-up menu.
4 Choose an appropriate HDV Easy Setup from the Use pop-up menu.
   *Important:* Make sure to choose an Easy Setup that matches the format of your HDV source tapes.
**Note:** The Apple ProRes 422 Easy Setup option supports only 1080p24 HDV. You should use this codec when you have 24 fps footage stored with 3:2 pull-down in a 1080i60 HDV signal.

5 Click Setup.

The corresponding capture, sequence, and device control presets are loaded, as well as A/V device settings.

**Stage 3: Capturing and Transcoding HDV Video**

Capturing and transcoding HDV video is very similar to capturing DV video using the Capture Now feature. The main differences are:

- The Log and Capture window is not used.
- Capturing HDV video may not take place in real time because transcoding HDV frames into the Apple Intermediate Codec or an Apple ProRes codec requires special processing steps.

**To capture HDV footage to the Apple Intermediate Codec or to an Apple ProRes codec**

1 Click in the Browser to make it active, then choose File > New Bin.

2 Control-click the bin, then choose Set Logging Bin from the shortcut menu.

Your captured clips will be placed in this bin.

3 Name the bin, then press Enter.

4 Choose File > Log and Capture (or press Command-8).

A Capture dialog appears instead of the Log and Capture window.

5 In the Capture dialog, enter a name for the clip, then click Capture.

The capture preview window appears and the camcorder begins playing back video from its current position. The status area of the capture preview window displays the percentage of real time in which the video is being transcoded from HDV to the target codec.

6 Press the Esc (Escape) key to stop capturing.

The video playback on the camcorder stops immediately. The capture preview window may lag behind, displaying where the video is in the encoding process. As these frames are processed, the status area of the capture preview window displays the percentage of frames left to process.

**Note:** Pressing the Esc (Escape) key a second time stops the encoding process and cancels the capture.

After the capture preview window closes, the captured clip appears in your logging bin.
Capturing Footage with Scene Breaks

When you capture HDV footage using the Apple Intermediate Codec or an Apple ProRes codec, Final Cut Pro detects any scene or timecode breaks on the tape introduced during shooting. At each scene or timecode break, a new clip is created during capture. When capture is completed, these clips appear in the logging bin, and the corresponding media files are placed on your hard disk.

For example, suppose you begin capturing a clip named Cafe Entrance. When a scene or timecode break is detected, Final Cut Pro stops writing the first media file and begins writing a new file named Cafe Entrance-1. Subsequent breaks create media files and clips named Cafe Entrance-2, Cafe Entrance-3, and so on.

Stage 4: Editing Your Transcoded Clips into a Sequence

Editing video transcoded to the Apple Intermediate Codec or an Apple ProRes codec is the same as editing other formats in Final Cut Pro. However, you need to make sure your scratch disk supports the data rate. For more information about the data rates of these formats, see “About the Apple Intermediate Codec,” “Working with Apple ProRes,” and “HDV Format Specifications.”

Stage 5: Outputting to HDV Tape or Other Formats

After you finish editing, you can output your movie to videotape using your camcorder or export your sequence to a QuickTime movie. If you want to output your movie back to tape, Final Cut Pro needs to reencode (or conform) the movie into MPEG-2 data before outputting. Depending on the length of your sequence, this process can be fairly time-consuming, because every frame in your sequence must be reencoded.

Optionally, you can export your sequence as a QuickTime movie, export your sequence to Compressor, or send your sequence to Color for finishing. You can also use the Share feature to quickly create and deliver output media files in iPod, iPhone, Apple TV, MobileMe, DVD, Blu-ray Disc, YouTube, and Apple ProRes formats.


To output Apple Intermediate Codec or Apple ProRes video to an HDV videotape
1 Make sure your HDV camcorder is properly connected to your computer and turned on before you open Final Cut Pro.
2 Insert a DV tape into the HDV camcorder.
3 Click anywhere in the Timeline or Canvas to make it the active window.
4 Choose File > Print to Video (or press Control-M).
The Print to Video dialog appears.

5 If you want Final Cut Pro to start recording automatically, select the Automatically Start Recording checkbox.

6 Select any leader or trailer elements you want to include on your tape, as well as start, end, and looping options.
A progress bar shows the progress of encoding from the codec back to MPEG-2 HDV and gives you a time estimate for when the encoding process will finish.
A dialog appears instructing you to press the record button on the camcorder.

7 Press the record button on your camcorder, then click OK.
If you selected the Automatically Start Recording option, the camcorder automatically begins recording your program to tape.
The camcorder stops after the program is recorded to tape.

To export your sequence to a QuickTime movie
1 Open your Final Cut Pro sequence in the Timeline.
2 Choose File > Export > QuickTime Movie.
The Save dialog appears.
3 Enter a name and choose a location for the movie.
4 At the bottom of the dialog, make sure the Make Movie Self-Contained checkbox is selected.
5 If you need DVD chapter markers from your Final Cut Pro project to be exported to the QuickTime movie, choose DVD Studio Pro Markers from the Markers pop-up menu.
6 Click Save.

About Exporting HDV for DVD Studio Pro
In some cases, using open GOP (1080-line) MPEG-2 media in DVD Studio Pro can cause DVD decoder problems, especially at the start and end frames of media files. To properly transfer open GOP MPEG-2 HDV media to DVD Studio Pro, you should export your media from Final Cut Pro using the Export QuickTime Movie command. This command conforms the beginning of the MPEG-2 media to a closed GOP structure, which is compatible with DVD decoders.
Using the Sony HVR-V1 HDV Camcorder

Final Cut Pro includes support for the Sony HVR-V1 HDV camcorder, which records native 1080i50 and 1080i60 footage. As with other HDV tape-based devices, you can capture natively or capture to either the Apple Intermediate Codec or an Apple ProRes codec. You can also output back to the Sony HVR-V1 HDV camcorder using the Print to Video command.

The camera is also capable of recording 1080p24, 1080p25, and 1080p30 HDV formats that are encoded in either the 1080i50 or the 1080i60 format. This means that the capture of the HVR-V1 HDV 1080p24, 1080p25, or 1080p30 footage results in 1080i50 or 1080i60 footage on your hard disks. Adding effects to this type of progressively scanned footage recorded within an interlaced format can potentially add interlacing artifacts. To achieve 1080p24, 1080p25, or 1080p30 footage with true progressive scanning, you must capture and transcode the HDV footage using the Apple Intermediate Codec or the Apple ProRes 422 codec.

To natively capture 1080p25 or 1080p30 video, you should use the HDV 1080i50 and HDV 1080i60 Easy Setups, respectively. Your footage will retain its progressive scanning even though it will be stored in an interlaced format.

You can natively capture 1080p24 video using the 1080i60 Easy Setup, but your captured footage will retain 3:2 pull-down in this case. For transcoded capture of 1080p24 footage with 3:2 pull-down removed, use the HDV - Apple ProRes 422 1080p24 Easy Setup.

The following table lists the recommended workflows for capturing from and outputting to the Sony HVR-V1 HDV camcorder.

<table>
<thead>
<tr>
<th>Format on tape</th>
<th>Capture format</th>
<th>HVR-V1 recording mode during output</th>
</tr>
</thead>
<tbody>
<tr>
<td>24p/60i</td>
<td>24p Apple Intermediate Codec or Apple ProRes 422 codec</td>
<td>24p/60i</td>
</tr>
<tr>
<td>25p/50i</td>
<td>25p Apple Intermediate Codec or Apple ProRes 422 codec</td>
<td>25p/50i</td>
</tr>
<tr>
<td>30p/60i</td>
<td>30p Apple Intermediate Codec or Apple ProRes 422 codec</td>
<td>30p/60i</td>
</tr>
</tbody>
</table>

HDV Format Specifications

HDV has the following format specifications.

Storage Medium
HDV is recorded on standard mini-DV videocassette tapes or on a hard disk.
Video Standard
The HDV standards were jointly created by a consortium of manufacturers including Sony, Canon, Sharp, and JVC. HDV supports 1080i, 1080p, and 720p HD standards.

Aspect Ratio
HDV has an aspect ratio of 16:9.

Frame Dimensions, Number of Lines, and Resolution
The HDV format supports two HD video resolutions:

- **1080 lines**: 1440 pixels per line, 1080 lines (displayed with an aspect ratio of 16:9, or 1920 x 1080); interlaced or progressive scan
- **720 lines**: 1280 pixels per line, 720 lines; progressive scan

The native and displayed pixel dimensions are shown below.

![Pixel Dimensions](image)

Frame Rate
Final Cut Pro supports the following HDV frame rates:

- **NTSC-compatible frame rates**: 29.97 fps, 59.94 fps (1080i60, 1080p30, 720p60, 720p30)
- **PAL-compatible frame rates**: 25 fps, 50 fps (1080i50, 1080p25, 720p50, 720p25)
- **Film-compatible frame rate**: 23.98 fps (1080p24, 720p24)

Scanning Method
HDV can record either interlaced or progressive scan images:

- **1080 lines**: Interlaced (1080i) or progressive (1080p)
- **720 lines**: Progressive

Color Recording Method
HDV records a 4:2:0 Y’C_bC_r (component) digital video signal. Each sample (pixel) has a resolution of 8 bits.

Data Rate
The following table lists the data rates for MPEG-2 HDV as well as HDV transcoded to the Apple Intermediate Codec and the Apple ProRes 422 codec. DV data rates are included for comparison.
<table>
<thead>
<tr>
<th>Format</th>
<th>Native frame size</th>
<th>Data rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>DV NTSC</td>
<td>720 x 480</td>
<td>3.6 MB/sec. (equivalent to 12 GB/hr.)</td>
</tr>
<tr>
<td>DV PAL</td>
<td>720 x 576</td>
<td>3.6 MB/sec. (equivalent to 12 GB/hr.)</td>
</tr>
<tr>
<td>MPEG-2 HDV 720p30</td>
<td>1280 x 720</td>
<td>2.5 MB/sec. (equivalent to 9 GB/hr.)</td>
</tr>
<tr>
<td>MPEG-2 HDV 1080i60/50</td>
<td>1440 x 1080</td>
<td>3.3 MB/sec. (equivalent to 12 GB/hr.)</td>
</tr>
<tr>
<td>Apple Intermediate Codec HDV 720p30¹</td>
<td>1280 x 720</td>
<td>7 MB/sec. (equivalent to 25 GB/hr.)</td>
</tr>
<tr>
<td>Apple Intermediate Codec HDV 1080i50¹</td>
<td>1440 x 1080</td>
<td>12 MB/sec. (equivalent to 42 GB/hr.)</td>
</tr>
<tr>
<td>Apple Intermediate Codec HDV 1080i60¹</td>
<td>1440 x 1080</td>
<td>14 MB/sec. (equivalent to 49 GB/hr.)</td>
</tr>
<tr>
<td>Apple ProRes 422 codec HDV 1080p24</td>
<td>1440 x 1080</td>
<td>12.6 MB/sec. (equivalent to 45 GB/hr.)</td>
</tr>
</tbody>
</table>

¹ Data rates for the Apple Intermediate Codec are variable; these figures are approximate and may vary according to the complexity of your footage. Images with a lot of detail have a higher data rate, and images with less detail have a lower data rate.

**Note:** Although audio is compressed on an HDV tape, Final Cut Pro converts this signal to an uncompressed format during capture. This means that the overall HDV data rate on tape differs from the captured data rate.

**Video Compression**

HDV uses MPEG-2 compression with a constant bit rate (CBR). I-, P-, and B-frames are used, creating a long-GOP pattern.

MPEG-2 video and audio are composed of a hierarchy of data streams:

- **Elementary stream:** This can be a video, audio, subtitle, or other basic media stream. Formats like HDV contain both video and audio elementary streams.
- **Transport stream:** A transport stream encapsulates elementary streams for real-time distribution, such as television or Internet broadcast.
- **Program stream:** A program stream also encapsulates elementary streams for content stored on media such as DVDs or hard disks.

HDV devices store and transmit elementary video and audio streams in an MPEG-2 transport stream. When you capture HDV video, Final Cut Pro automatically extracts the elementary video and audio streams from the transport stream and stores the data in tracks in a QuickTime media file.
Audio
HDV uses two audio tracks with a sample rate of 48 kHz and 16-bit resolution per sample. The audio is encoded using the MPEG-1 Layer 2 format with a data rate of 384 kbps.

Timecode
The timecode format of an HDV camcorder matches the frame rate of the video format. For example, 1080i50 footage uses 25 fps timecode.

Important: Some HDV camcorders do not record timecode, so you won’t be able to precisely recapture any clips if you delete the corresponding media files.
This chapter covers the following:

• About DVCPRO HD (p. 41)
• Working with DVCPRO HD in Final Cut Pro (p. 44)
• Choosing 720p60 DVCPRO HD Timecode Display Options (p. 49)
• Using the DVCPRO HD Frame Rate Converter (p. 50)
• Working with 24p DVCPRO HD (p. 56)
• DVCPRO HD Format Specifications (p. 58)

In Final Cut Pro, you can natively capture, edit, and output DVCPRO HD video using the built-in FireWire port on your computer.

**About DVCPRO HD**

DVCPRO HD is a high definition addition to the DV/DVCPRO format family, making it simple to adapt your existing DV- and FireWire-based editing workflow to HD video.

**DVCPRO HD Formats Supported by Final Cut Pro**

Final Cut Pro natively supports the following DVCPRO HD formats.

**59.94 fps–Based Formats**

The following table shows the 59.94 fps–based DVCPRO HD formats supported by Final Cut Pro.

<table>
<thead>
<tr>
<th>Format</th>
<th>Final Cut Pro Easy Setup</th>
<th>Sequence dimensions and frame rate</th>
<th>Scanning method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i60</td>
<td>DVCPRO HD - 1080i60</td>
<td>1280 x 1080, 29.97 fps</td>
<td>Interlaced</td>
</tr>
<tr>
<td>1080p30</td>
<td>DVCPRO HD - 1080p30</td>
<td>1280 x 1080, 29.97 fps</td>
<td>Progressive</td>
</tr>
<tr>
<td>1080pA24</td>
<td>DVCPRO HD - 1080pA24</td>
<td>1280 x 1080, 23.98 fps</td>
<td>Progressive</td>
</tr>
<tr>
<td>720p60</td>
<td>DVCPRO HD - 720p60</td>
<td>960 x 720, 59.94 fps</td>
<td>Progressive</td>
</tr>
<tr>
<td>720p30</td>
<td>DVCPRO HD - 720p30</td>
<td>960 x 720, 29.97 fps</td>
<td>Progressive</td>
</tr>
</tbody>
</table>
### 50 fps–Based Formats

The following table shows the 50 fps–based DVCPRO HD formats supported by Final Cut Pro.

<table>
<thead>
<tr>
<th>Format</th>
<th>Final Cut Pro Easy Setup</th>
<th>Sequence dimensions and frame rate</th>
<th>Scanning method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i50</td>
<td>DVCPRO HD - 1080i50</td>
<td>1440 x 1080, 25 fps</td>
<td>Interlaced</td>
</tr>
<tr>
<td>1080p25</td>
<td>DVCPRO HD - 1080p25</td>
<td>1440 x 1080, 25 fps</td>
<td>Progressive</td>
</tr>
<tr>
<td>720p50</td>
<td>DVCPRO HD - 720p50</td>
<td>960 x 720, 50 fps</td>
<td>Progressive</td>
</tr>
<tr>
<td>720p25</td>
<td>DVCPRO HD - 720p25</td>
<td>960 x 720, 25 fps</td>
<td>Progressive</td>
</tr>
</tbody>
</table>

#### DVCPRO HD Frame Rates

DVCPRO HD supports frame rates compatible with both NTSC and PAL frame rates, although most camcorders are designed to work with one or the other. For example, the Panasonic AG-HVX200 camcorder records 1080i60 or 720p60 DVCPRO HD, and the Panasonic AG-HVX200E camcorder (designed for PAL regions) records 1080i50 or 720p50 DVCPRO HD. 1080i footage is described by its field rate (60i or 50i), whereas 720p footage is described by its frame rate (60p or 50p).

Additional formats, such as 24p, can be achieved using pull-down (1080i) or duplicated frames (720p). Variable frame rates for slow- and fast-motion effects are also possible in the 720p format.

**Note:** 1080i60 and 720p60 DVCPRO HD actually operate at 59.94 fps, not 60 fps. See “Setting System Frequency on a Panasonic Varicam Camcorder” for an exception to this rule.

#### 1080pA24 DVCPRO HD

1080pA24 DVCPRO HD is recorded using the 1080i60 format with advanced pull-down (2:3:3:2). This is the same method employed by the Panasonic AG-DVX100 camcorder. For more information, see “Working with DVCPRO HD in Final Cut Pro.”

**Note:** You can also record the 1080p24 DVCPRO HD format using traditional 2:3:2:3 pull-down. Cinema Tools can remove this kind of pull-down, but Final Cut Pro cannot. Don’t use this format unless you have a special reason for doing so. If you want to work with 1080p24 footage, the 1080pA24 format is much easier to use.
720p60 DVCPRO HD

The 720p60 DVCPRO HD format supports 60, 30, and 24 fps recording. When you choose a frame rate lower than 60 fps, the camera CCD captures images at the lower rate but the recording rate stays fixed at 60 fps.

For example, if you record the 720p30 format, the camera CCD produces 30 unique images per second, but each frame is recorded on tape twice. These duplicate frames are digitally flagged during recording and must be removed during or after capture.

Capturing DVCPRO HD

<table>
<thead>
<tr>
<th>Used frames</th>
<th>Deleted frames</th>
</tr>
</thead>
</table>

### 720p60

| 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20 | 21 | 22 | 23 | 24 | 25 | 26 | 27 | 28 | 29 | 30 | 31 | 32 | 33 | 34 | 35 | 36 | 37 | 38 | 39 | 40 | 41 | 42 | 43 | 44 | 45 | 46 | 47 | 48 | 49 | 50 | 51 | 52 | 53 | 54 | 55 | 56 | 57 | 58 | 59 | 60 |

DVCPRO HD tape (59.94 fps)

### 720p30

| 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20 | 21 | 22 | 23 | 24 | 25 | 26 | 27 | 28 | 29 | 30 | 31 | 32 | 33 | 34 | 35 | 36 | 37 | 38 | 39 | 40 | 41 | 42 | 43 | 44 | 45 | 46 | 47 | 48 | 49 | 50 | 51 | 52 | 53 | 54 | 55 | 56 | 57 | 58 | 59 | 60 |

Captured in Final Cut Pro (59.94 fps)

### 720p24

| 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20 | 21 | 22 | 23 | 24 | 25 | 26 | 27 | 28 | 29 | 30 | 31 | 32 | 33 | 34 | 35 | 36 | 37 | 38 | 39 | 40 | 41 | 42 | 43 | 44 | 45 | 46 | 47 | 48 | 49 | 50 | 51 | 52 | 53 | 54 | 55 | 56 | 57 | 58 | 59 | 60 |

DVCPRO HD tape (59.94 fps)

| 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20 | 21 | 22 | 23 | 24 | 25 | 26 | 27 | 28 | 29 | 30 | 31 | 32 | 33 | 34 | 35 | 36 | 37 | 38 | 39 | 40 | 41 | 42 | 43 | 44 | 45 | 46 | 47 | 48 | 49 | 50 | 51 | 52 | 53 | 54 | 55 | 56 | 57 | 58 | 59 | 60 |

Captured in Final Cut Pro (23.98 fps)

Most capture presets for 720p DVCPRO HD enable the Remove Advanced Pulldown and/or Duplicate Frames During Capture From FireWire Sources option to remove redundant frames during capture. For information about modifying capture presets, see “Capture Settings and Presets” in the Final Cut Pro 7 User Manual.

When this checkbox is selected, your captured media files are smaller and ready to edit at the proper frame rate.

**Note:** The 720p60 Easy Setup does not enable this option because no duplicate frames are recorded at 60 fps.
For more information, see “Stage 3: Logging and Capturing Your DVCPRO HD Footage” in “Working with DVCPRO HD in Final Cut Pro.”

**720p50 DVCPRO HD**
The 720p50 DVCPRO HD format supports 50 and 25 fps recording. When you record at 25 fps, the camera CCD captures images at the lower rate but the recording rate stays fixed at 50 fps.

**720pN DVCPRO HD Native Frame Rate Recording**
Camcorders such as the Panasonic AG-HVX200 allow you to record 720p footage onto P2 cards without duplicating frames. Because the footage is recorded at the intended frame rate, this method is called *native frame rate recording* and is often indicated by the letter *N*. For example, 720p60 camcorders can record 720pN30 and 720pN24 formats. 720p50 camcorders can record the 720pN25 format. For details about how to best ingest these formats, see “Panasonic P2 Camcorder Compatibility.”

**720p DVCPRO HD Variable Frame Rate Recording**
Some 720p DVCPRO HD camcorders allow you to create slow- and fast-motion effects by recording at variable frame rates.

- 720p60 camcorders can record frame rates between 4 and 60 fps.
- 720p50 camcorders can record frame rates between 4 and 50 fps.

For example, you can create slow motion with the Panasonic Varicam camcorder by setting an intended playback frame rate of 24 fps and then recording at 60 fps. When 60 fps footage is played at 24 fps, slow-motion effects are created. For more information, see “Using the DVCPRO HD Frame Rate Converter.”

### Setting System Frequency on a Panasonic Varicam Camcorder
The Panasonic Varicam camcorder can record at the standard NTSC-compatible rate of 59.94 fps or at exactly 60 fps. Final Cut Pro only supports DVCPRO HD video transfer via FireWire at 59.94 fps (or one of its variants, such as 29.97 or 23.98 fps). If you want to capture DVCPRO HD footage via FireWire, make sure you record your footage with the system frequency of your camcorder set to 59.94, not 60. For more information, see the documentation included with the Panasonic Varicam camcorder.

### Working with DVCPRO HD in Final Cut Pro
DVCPRO HD footage can be recorded on tape or on Panasonic P2 cards. This chapter focuses on capturing DVCPRO HD footage from tape. For information about transferring DVCPRO HD footage from a Panasonic P2 card, see “Working with Panasonic P2 Cards.”
The steps for capturing, editing, and outputting DVCPRO HD video are almost identical to the workflow used for DV. The following sections describe the basic DVCPRO HD workflow and highlight unique facets of working with DVCPRO HD in Final Cut Pro.

![Workflow Diagram]

- Stage 1: Connecting a DVCPRO HD Device to Your Computer
- Stage 2: Choosing a DVCPRO HD Easy Setup
- Stage 3: Logging and Capturing Your DVCPRO HD Footage
- Stage 4: Editing DVCPRO HD Footage
- Stage 5: Outputting Your DVCPRO HD Sequence

**Stage 1: Connecting a DVCPRO HD Device to Your Computer**

Because DVCPRO HD is part of the DV/DVCPRO family of video formats, setting up Final Cut Pro to capture, edit, and output DVCPRO HD is essentially the same as setting up a system for any other kind of DV editing.

**To set up your computer for DVCPRO HD capture and output**

- Connect your DVCPRO HD camcorder or deck to your computer using a 4-pin-to-6-pin or 6-pin-to-6-pin FireWire cable.

For additional instructions for connecting a DV camcorder or deck to your computer, see the *Final Cut Pro 7 User Manual*.

For information about mounting a Panasonic P2 card for use with the Log and Transfer window, see “Mounting P2 Cards, Disk Images, and Folders.”

**Stage 2: Choosing a DVCPRO HD Easy Setup**

Final Cut Pro comes with several DVCPRO HD Easy Setups. Choose the Easy Setup that matches your source footage on tape. The 720p30, 720p25, and 720p24 Easy Setups remove duplicate frames during capture so that your media files have the proper frame rate. For more information, see “Stage 3: Logging and Capturing Your DVCPRO HD Footage.”

**To choose an Easy Setup**

1. Choose Final Cut Pro > Easy Setup.
2. Choose Panasonic DVCPRO HD from the Format pop-up menu.
3. Choose “(all rates)” from the Rate pop-up menu.
4 Click the Use pop-up menu to see all of the Easy Setups related to your choice in the Format pop-up menu.
You can further refine the list by choosing a specific frame rate from the Rate pop-up menu.

5 Choose an Easy Setup from the Use pop-up menu, then click Setup.
If you need to create a custom Easy Setup, see the Final Cut Pro 7 User Manual.

Stage 3: Logging and Capturing Your DVCPRO HD Footage
You can log and capture DVCPRO HD footage in the same way you log and capture any other DV source footage.

The 720p30, 720p25, and 720p24 DVCPRO HD capture presets enable the option that removes duplicate progressive frames added by the camcorder. For more information, see “720p60 DVCPRO HD” and “720p50 DVCPRO HD.”

The 1080pA24 capture preset also enables the Remove Advanced Pulldown and/or Duplicate Frames During Capture From FireWire Sources option so that unnecessary fields are removed and your captured media file is 23.98 fps instead of 29.97 fps. For more information, see the Final Cut Pro 7 User Manual.
About 720p50 and 720p60 Formats and Devices
When working with 720p formats, keep the following information about timecode and device control in mind.

About Timecode for 720p50 and 720p60 Formats
Although 720p HD formats can record at video frame rates of 60 fps, the timecode recorded on tape is always 30 fps. How can 30 fps timecode account for every frame when the video frame rate is 60 fps? Every two frames are represented by one timecode number, and the second frame in the pair is uniquely flagged so it can be differentiated in the timecode count. For example, the first two timecode numbers of a 720p60 tape are indicated by the timecode numbers :00 and :00*, where the asterisk indicates the second frame. Using this method, 60 frames can be uniquely addressed using only 30 timecode numbers per second.

Note: Drop frame timecode is supported when capturing 720p60 DVCPRO HD.

About Device Control for 720p50 and 720p60 Devices
When you log, capture, or output 720p60 DVCPRO HD, the remote device control displays the tape timecode, which is 30 fps. This means that you can only set In and Out points with 30 fps timecode accuracy, even though the video frame rate is 60 fps. Despite this minor restriction, you can still edit with 60 fps frame accuracy once you capture your footage.

When you capture 720p60 DVCPRO HD media, Final Cut Pro converts the 30 fps timecode on the source tape to a 60 fps timecode track within the QuickTime media file. This timecode can be used to accurately recapture your media at a later time.

For more information about 60 fps timecode, see “Stage 4: Editing DVCPRO HD Footage.”

Important: The rules above also apply to 720p50 DVCPRO HD and 25 fps timecode.

Stage 4: Editing DVCPRO HD Footage
You can edit DVCPRO HD footage just as you would DV footage. Several additional options are available to support the unique frame rates of DVCPRO HD.

Important: If you are editing 720p60 DVCPRO HD media, it is important that you choose the correct timecode display option. For more information, see “Choosing 720p60 DVCPRO HD Timecode Display Options.”
Stage 5: Outputting Your DVCPRO HD Sequence
DVCPRO HD clips and sequences are recorded to tape via FireWire, in the same way as any other DV media. For more information about editing to tape, see the Final Cut Pro 7 User Manual. Optionally, you can export your sequence as a QuickTime movie, export your sequence to Compressor, or send your sequence to Color for finishing. You can also use the Share feature to quickly create and deliver output media files in iPod, iPhone, Apple TV, MobileMe, DVD, Blu-ray Disc, YouTube, and Apple ProRes formats.


Warning: Don’t record DVCPRO HD video to a tape that already has DVCPRO (25) or DVCPRO 50 footage on it. Even though these formats can use the same tape stock, the recording speeds are different.

Here are some things to keep in mind while outputting and exporting:

• Generating color bars and tone for 1080i, 1080p, and 720p video: Final Cut Pro includes bars and tone generators especially for use with 1080i, 1080p, and 720p sequences. These bars and tone generators are available in the Video Generators bin in the Effects tab of the Browser. For more information, see the Final Cut Pro 7 User Manual.

• 720p60 output and playback: When recording a 720p60, 720p30, or 720p24 clip or sequence to tape via FireWire, Final Cut Pro automatically outputs 59.94 fps video, creating duplicate frames if necessary. Likewise, 720p25 and 720p50 clips or sequences are always recorded to tape at 50 fps.

For more information about how DVCPRO HD flags 59.94 fps frames with duplicate frame information, see “720p60 DVCPRO HD.”

• Outputting sequence timecode using DVCPRO HD: When you output a DVCPRO HD sequence or clip to a DVCPRO HD device via FireWire, timecode is also output. This works during Print to Video and Edit to Tape operations, as well as during normal playback when external video output via FireWire is enabled.

For more information, see “Assemble and Insert Editing Using Edit to Tape” in the Final Cut Pro 7 User Manual.

Tip: You can also set a custom starting timecode number when you use the black and code feature with DVCPRO HD tapes. For more information about using the black and code feature in Final Cut Pro, see the Final Cut Pro 7 User Manual. Drop frame timecode is supported when you prepare a 720p tape with black and timecode.
Choosing 720p60 DVCPRO HD Timecode Display Options

It is important that you choose the correct timecode display option for 720p60 DVCPRO HD media. Even though the timecode track of 720p60 DVCPRO HD QuickTime media files is always running at 60 fps, you can choose whether the timecode fields in Final Cut Pro display 60 or 30 fps timecode.

When editing 720p60 video, you can choose from two time display options:

- **HH:MM:SS:FF**: The timecode counts 60 frames per second, from :00 to :59.
- **60 @ 30**: Displays 59.94 and 60 fps video using 30 fps timecode. One timecode number is used for every two video frames, and an asterisk is displayed on every other frame. This timecode display matches the display on DVCPRO HD decks and is useful when you are referring to log notes or EDLs generated with 30 fps timecode.

<table>
<thead>
<tr>
<th>Frames</th>
<th>60 @ 30 fps</th>
<th>60 fps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>01:50:20:28</td>
<td>01:50:20:56</td>
</tr>
<tr>
<td></td>
<td>01:50:20:28*</td>
<td>01:50:20:57</td>
</tr>
<tr>
<td></td>
<td>01:50:20:29</td>
<td>01:50:20:58</td>
</tr>
<tr>
<td></td>
<td>01:50:20:29*</td>
<td>01:50:20:59</td>
</tr>
<tr>
<td></td>
<td>01:50:21:00</td>
<td>01:50:21:00</td>
</tr>
<tr>
<td></td>
<td>01:50:21:00*</td>
<td>01:50:21:01</td>
</tr>
</tbody>
</table>

When editing 720p30 or 720p24 video, you can choose to display clip time instead of source time. The clip time option displays timecode at the media file frame rate, not the media file timecode track rate.

**Important**: These timecode display options do not change the timecode of your media files; only the displayed timecode count is affected.

**To set the timecode display for 720p60 video**

1. Open a 720p60 clip or sequence in the Viewer or Canvas.
2. Control-click a timecode field, then choose HH:MM:SS:FF (this will display 60 fps timecode) or 60 @ 30 from the shortcut menu.

**Note**: The 60 @ 30 timecode display is available only when you are working with 59.94 fps or 60 fps media files and sequences.
To display clip time for a 720p30 or 720p24 clip

1. Open a 720p30 or 720p24 clip in the Viewer.

2. Control-click the Current Timecode field, then choose Clip Time from the shortcut menu.

   The Current Timecode field now displays timecode based on the frame rate of the media file instead of the source timecode rate.

   For more information about changing timecode display options, see “Working with Timecode” in the Final Cut Pro 7 User Manual.

   Important: You can also view timecode for 720p50 video in two modes: HH:MM:SS:FF or 50 @ 25.

Using the DVCPro HD Frame Rate Converter

Some 720p DVCPro HD camcorders can record at variable frame rates, a feature once exclusive to film cameras.

In film, the traditional frame rate is 24 fps, but many cameras can be “overcranked” or “undercranked” to achieve slow- and fast-motion effects. The technique is straightforward: the more frames you record per second, the longer it takes to play them back at 24 fps, and therefore the slower the motion onscreen. The reverse is also true: the fewer frames you record per second, the faster the motion when played back at 24 fps.

Shooting for Slow-Motion and Fast-Motion Effects

Variable frame rate recording with DVCPro HD works the same way it does with film, except that the final playback rate varies (24, 25, 30, 50, or 60 fps) depending on your final output format. During shooting, you need to have an intended playback rate in mind to know what frame rate to record your footage at. For slow-motion effects, you need to record at a frame rate higher than your intended playback rate. For fast motion, shoot at a frame rate lower than your intended playback rate.

For example, if you shoot at 60 fps and play back your footage at 24 fps, the result will be slow motion because the rate at which you recorded was higher than the final playback rate. However, if you record at 24 fps and play back your footage at 24 fps, your footage will play at normal speed.

How DVCPro HD Variable Frame Rate Recording Works

In 720p DVCPro HD variable frame rate recording, the camera CCD outputs a frame rate while the recording rate is fixed at either 59.94 fps or 50 fps (depending on the camcorder model).
A 720p60 camera CCD can generate between 4 and 60 images per second, while the recording unit records at a constant rate of 60 fps (technically, 59.94 fps). When you select any frame rate lower than 60 fps, some images from the CCD are recorded more than once. These redundant frames are tagged for later removal using a special device called a **frame rate converter**.

**What Is a Frame Rate Converter?**

A **frame rate converter**, or **FRC**, is hardware or software that converts the frame rate of your footage by:

- Setting the rate of playback higher or lower, so that each frame lasts a longer or shorter amount of time on the screen. By changing the duration that each frame is shown onscreen compared to its recorded duration, you can speed up or slow down the action in your media.

- Intelligently skipping redundant frames containing variable frame rate flags

Some frame rate converters can also do upconverting and downconverting, allowing you to use 720p for variable speed cinematography and then transfer to 1080i or 480i (standard definition).

**How a Frame Rate Converter Works**

On tape, variable frame rate video footage may look a bit strange—almost stroboscopic—because many frames are repeated with the intention that they will be removed. Once the frame rate converter removes the duplicate frames and only unique frames remain, your footage plays back at the intended rate.

For example, if the camera is set to record 15 fps, three out of every four frames are tagged as duplicates, and the frame rate converter ignores or discards them. The frame rate converter then converts the 15 fps footage to a new media file at a standard frame rate such as 23.98, 29.97, or 59.94 fps.
Several examples of 720p60 DVCPRO HD variable frame rate footage are shown below.

### Recording Variable Frame Rates with DVCPRO HD 720p

<table>
<thead>
<tr>
<th>Used frames</th>
<th>Duplicate frames</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60</td>
<td></td>
</tr>
</tbody>
</table>

DVCPRO HD tape (60 fps)

<table>
<thead>
<tr>
<th>After duplicate frame removal (60 fps)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60</td>
</tr>
</tbody>
</table>

DVCPRO HD tape (60 fps)

<table>
<thead>
<tr>
<th>After duplicate frame removal (30 fps)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60</td>
</tr>
</tbody>
</table>

DVCPRO HD tape (60 fps)

<table>
<thead>
<tr>
<th>After duplicate frame removal (25 fps)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60</td>
</tr>
</tbody>
</table>

DVCPRO HD tape (60 fps)

<table>
<thead>
<tr>
<th>After duplicate frame removal (24 fps)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60</td>
</tr>
</tbody>
</table>

DVCPRO HD tape (60 fps)

<table>
<thead>
<tr>
<th>After duplicate frame removal (15 fps)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60</td>
</tr>
</tbody>
</table>

DVCPRO HD tape (60 fps)

<table>
<thead>
<tr>
<th>After duplicate frame removal (4 fps)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 2 3 4</td>
</tr>
</tbody>
</table>
You can record variable frame rates with a 720p50 camcorder just as you would with a 720p60 camcorder, although the range of variable frame rates is between 4 and 50 fps.

**About Native Variable Frame Rate Recording**
Camcorders such as the Panasonic AG-HVX200 and AG-HVX200E aren’t limited by the constraints of tape-based recording, so they can record native frame rates without duplication of frames. For more information, see “720pN DVCPRO HD Native Frame Rate Recording.”

If you record variable frame rates in these native frame rate modes, the camera can display the results immediately without the use of a frame rate converter. For more information, see the documentation included with the Panasonic AG-HVX200 camcorder.

**About the DVCPRO HD Frame Rate Converter**
The DVCPRO HD Frame Rate Converter in Final Cut Pro provides conversion options formerly available only with expensive hardware. You can use the Frame Rate Converter to create an output movie with a frame rate different from the original frame rate (for example, convert 59.94 fps footage to 23.98 fps).

The Frame Rate Converter can create a new self-contained QuickTime movie or create a QuickTime movie that actually refers to the frames of the original media file while playing them back at a different rate.

The Frame Rate Converter only works with certain 720p DVCPRO HD formats and does not process timecode or audio.

**Original Media File Requirements**
The Frame Rate Converter only processes media files that meet the following requirements:
- The media file must use the DVCPRO HD 720p60 or DVCPRO HD 720p50 codec.
- The media file must be captured or ingested at a frame rate of 59.94 or 50 fps.

To ensure that your media file contains the variable frame rate footage from the camera, make sure that you are using a capture preset with the Remove Advanced Pulldown and/or Duplicate Frames During Capture From FireWire Sources checkbox unselected. For 720p60 footage, the easiest way to ensure you retain proper flags is to capture footage using the DVCPRO HD - 720p60 capture preset.

**Timecode and Audio Restrictions**
The Frame Rate Converter does not include timecode or audio in the processed media file. Although this may seem like a limitation, it is important to remember that the primary purpose of timecode is to link your clip back to particular timecode addresses on a videotape for recapturing. Because the frames of the processed media file do not exactly correspond to the frames on the original tape, including the original timecode would only lead to confusion. It’s best to consider your processed variable frame rate media file as a completely new piece of media.
Audio is not affected or considered when shooting variable frame rate footage. Just as with variable frame rate film cinematography, these shots are usually recorded MOS (without sound), and sound is added later during post-production.

**About the Frame Rate Converter Options**
The options for the Frame Rate Converter are described below.

- **Frame Rate**: The Frame Rate pop-up menu allows you to choose the intended playback rate of the processed media file. For more information, see “Shooting for Slow-Motion and Fast-Motion Effects.”

The options available here depend on the frame rate of your source media.

- **If your source media is 59.94 fps**: You can play back the media at 59.94, 29.97, and 23.98 fps.
- **If your source media is 50 fps**: You can play back the media at 50, 25, and 24 fps.

**Note**: It may sound redundant to convert 59.94 fps to 59.94 fps and 50 fps to 50 fps. In fact, it is redundant unless you have variable frame rate flags in your footage. For example, if you have footage flagged as 10 fps, it contains a considerable number of duplicate frames. These frames can be removed from the original footage while maintaining a final frame rate of 59.94 fps or 50 fps. Because the media file now has fewer frames overall, the clip is shorter and therefore faster. This would not be possible with the standard capture preset options.

- **Remove Duplicate Frames**: If the Remove Duplicate Frames checkbox is selected, the Frame Rate Converter removes any flagged duplicate frames when creating the new file or processing the existing media file (depending on whether the Make Self Contained File checkbox is selected).
• **Make Self Contained File:** If this checkbox is selected, a new self-contained QuickTime media file is written to disk. Select this option if you want the new media file to be completely independent of the original file. You may want to do this if you plan to get rid of the original file, or if you want to copy the new, processed file to another editing system.

  **Note:** If you create a self-contained file, you need to have enough disk space for another copy of the media file.

If this checkbox is unselected, a QuickTime reference movie is created. A QuickTime reference movie refers to frames in the original media file. Reference movies are very small relative to the original media file because they don't actually contain any media (in the same way that a Final Cut Pro project file is small because it doesn't contain any of the media that it refers to). The disadvantage of this option is that reference movies still require the original media file.

For more information, see “Exporting QuickTime Movies” in the *Final Cut Pro 7 User Manual*.

• **Import Result Into Final Cut Pro:** If the Import Result Into Final Cut Pro checkbox is selected, the resulting media file is imported into the current project. The imported clip uses the name you enter in the Save Converted Media dialog.

### Using the Frame Rate Converter

The Frame Rate Covert er processes the source media file and creates either a new, independent file or a reference file for the movie.

**To convert a DVC PRO HD media file using the Frame Rate Converter**

1. Select a clip in the Browser that meets the Frame Rate Converter requirements (see “Original Media File Requirements”).

2. In Final Cut Pro, choose Tools > DVC PRO HD Frame Rate Converter.

3. Select options for processing the media file.

   For more information about the options, see “About the Frame Rate Converter Options.”

4. Click OK.

5. In the Save Converted Media dialog, enter a filename, navigate to a location, then click OK.

The Frame Rate Converter first processes the source media file, removing tagged duplicate frames (if the Remove Duplicate Frames option is selected). The Processing Source Media progress dialog appears to show the status of processing.

Once processing is complete, the final converted movie file is written to disk as a new, independent file (if the Make Self Contained File checkbox is selected) or as a reference movie file pointing to the relevant frames of the original media file.
If the Import Result Into Final Cut Pro option is selected, the converted media file is imported into Final Cut Pro. The clip name is the same as the name you entered in the Save Converted Media dialog. Note that the converted media filename and the resulting clip name are typically not the same, so you need to be especially organized when managing media files created by the Frame Rate Converter.

**Working with 24p DVCPRO HD**

DVCPRO HD supports several 24p recording modes, depending on the camcorder you are using. For more information about 24p video, see “Working with 24p Video” in the *Final Cut Pro 7 User Manual*.

**Working with 1080pA24 DVCPRO HD Video**

The workflow for capturing and outputting 1080pA24 (advanced pull-down) DVCPRO HD footage is outlined below.

*Note:* To remove standard 3:2 (2:3:2:3) pull-down from 1080p24 footage, you need to capture the footage as 1080i60 (29.97 fps) and then use Cinema Tools to remove the pull-down.

**Stage 1: Shooting with Advanced Pull-Down**

To shoot with advanced pull-down (23.98 fps at 29.97 fps), choose the 1080i/24PA recording mode on your camera. This creates 29.97 fps 1080i video that contains 23.98 fps progressive frames using a 2:3:3:2 pull-down pattern.

**Stage 2: Removing 2:3:3:2 Advanced Pull-Down from 24p Video During Capture**

Choose the DVCPRO HD 1080pA24 Easy Setup, which enables the Remove Advanced Pulldown and/or Duplicate Frames During Capture From FireWire Sources option.

Duplicate video fields are discarded during capture, resulting in a 24p (23.98 fps) media file on disk after capture.

You can also remove advanced pull-down while ingesting 1080pA24 or 480pA24 footage recorded on P2 cards.

*Tip:* If you have already captured your video at 29.97 fps, you can remove duplicate fields from your media files after capture. To remove 2:3:3:2 advanced pull-down from your media files after capture, select the 29.97 fps clips in the Browser, then choose Tools > Remove Advanced Pulldown. Your media files will remain the same size, but they will be set to play back at 23.98 fps. If no advanced pull-down flags are detected, the media files remain at 29.97 fps.
Stage 3: Editing at 23.98 fps
You can edit your footage in a 23.98 fps sequence. To preview your video on an external monitor while you are editing, you can choose one of several pull-down options to convert the 23.98 fps video to 29.97 fps. The 2:2:2:4 option is the least processor-intensive, but it should be used only for previewing.

For more information about real-time pull-down options, see “Working with 24p Video” in the Final Cut Pro 7 User Manual.

Stage 4: Outputting Back to 1080i60 Video with Advanced Pull-Down
After you finish editing your movie, you can output back to 1080i60 video by introducing a pull-down pattern on the FireWire output. You can choose one of several pull-down patterns, either from the RT pop-up menu in the Timeline or in the Playback Control tab of the System Settings window. For output back to tape, you should choose advanced pull-down (2:3:3:2) or normal telecine pull-down (2:3:2:3).

You can also export your movie to a 23.98 fps QuickTime movie or image sequence for delivery to a video-to-film transfer lab.

Working with 720p24 DVCPRO HD Video
There are several methods for recording 720p24 DVCPRO HD footage, depending on the camcorder you use.

720p60 DVCPRO HD Recorded at 23.98 fps
Duplicate frames are recorded and can be removed during capture (Panasonic Varicam), during P2 card ingest (Panasonic AG-HVX200), or after capture using the DVCPRO HD Frame Rate Converter. This format is also referred to as 720p24.

For more information, see the information about removing duplicate frames in “About the Frame Rate Converter Options,” as well as “Advanced Topics in Transferring File-Based Media” in the Final Cut Pro 7 User Manual.

Note: The Panasonic Varicam camcorder can record 720p60 video with a frame rate setting of 24 fps, but this format is not supported by Final Cut Pro. For more information, see “Setting System Frequency on a Panasonic Varicam Camcorder.”

720p50 DVCPRO HD Recorded at 24 fps
Duplicate frames are recorded and can be removed during P2 card ingest with the Log and Transfer window or using the DVCPRO HD Frame Rate Converter.

720pN24 DVCPRO HD
DVCPRO HD 24 fps footage is recorded natively to a Panasonic P2 card and can be ingested using the Log and Transfer window. The N in 720pN24 refers to the fact that this mode records exactly 24 “native” frames per second rather than flagging frames in a 29.97 fps video stream. For more information, see “Panasonic P2 Camcorder Compatibility.”
DVCPRO HD Format Specifications

DVCPRO HD is a 100 Mbps extension of the DVCPRO (25) and DVCPRO 50 formats, used for capturing and editing high-quality HD video. Because DVCPRO HD is a DV format, native FireWire capture and output is supported.

Storage Medium
DVCPRO, DVCPRO 50, and DVCPRO HD tapes use a metal particle (MP) tape formulation. Some tape sizes are supported only by decks and not by cameras. As the data rate is doubled from 25 Mbps (DV and DVCPRO) to 50 Mbps (DVCPRO 50) to 100 Mbps (DVCPRO HD), the recording time is halved in each case. Therefore, a 63-minute DV tape stores only 31 minutes of DVCPRO 50 footage, or 15 minutes of DVCPRO HD footage.

**Warning:** DV (sometimes referred to as *mini-DV*) and DVCAM use a metal evaporated (ME) tape formula, whereas DVCPRO uses metal particle tape. When in doubt, always use cassettes explicitly manufactured for the camera or VTR you intend to use.

You can also record DVCPRO, DVCPRO 50, and DVCPRO HD on P2 cards. For more information, see “About Panasonic P2 Cards and Media Files.”

Video Standard
The SMPTE 370M-2006 specification defines the following DVCPRO HD formats.

<table>
<thead>
<tr>
<th>Format</th>
<th>Frame dimensions</th>
<th>Frame rate</th>
<th>Scanning method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i60</td>
<td>1280 x 1080</td>
<td>29.97 fps</td>
<td>Interlaced</td>
</tr>
<tr>
<td>1080i50</td>
<td>1440 x 1080</td>
<td>25 fps</td>
<td>Interlaced</td>
</tr>
<tr>
<td>720p60</td>
<td>960 x 720</td>
<td>59.94 fps</td>
<td>Progressive</td>
</tr>
<tr>
<td>720p50</td>
<td>960 x 720</td>
<td>50 fps</td>
<td>Progressive</td>
</tr>
</tbody>
</table>

Panasonic equipment and Final Cut Pro support additional frame rates within these formats. For more information, see “Frame Rate” and “DVCPRO HD Formats Supported by Final Cut Pro.”

Aspect Ratio
Regardless of the specific resolution used, DVCPRO HD always captures and displays an image with an aspect ratio of 16:9 (or 1.78).

Frame Dimensions, Number of Lines, and Resolution
DVCPRO HD supports three resolutions:

- **1080i60**: 1280 pixels per line, 1080 lines; interlaced (displayed at 16:9, or 1920 x 1080)
- **1080i50**: 1440 pixels per line, 1080 lines; interlaced (displayed at 16:9, or 1920 x 1080)
- **720p60, 720p50**: 960 pixels per line, 720 lines; progressive (displayed at 16:9, or 1280 x 720)
Final Cut Pro captures and processes DVCPRO HD using its native dimensions but displays the image onscreen as you would expect 16:9 video to appear.

Frame Rate
DVCPRO HD supports both NTSC and PAL frame rates:

- **NTSC**: 59.94 and 29.97 fps
- **PAL**: 50 and 25 fps

*Note:* The Panasonic Varicam camcorder has an option for true 60 fps recording (versus 59.94 fps), although Final Cut Pro does not support these rates when capturing via FireWire.

The 1080i60 format can record 24 fps progressive footage with standard pull-down (2:3:2:3) or advanced pull-down (2:3:3:2).

Camcorders capable of recording 720p60 footage can also record 720p30 and 720p24 footage. Camcorders that support 720p50 can also record 720p25 footage. Tape-based camcorders achieve these frame rates by duplicating frames and flagging them for removal during capture (or with a frame rate converter). P2 camcorders such as the Panasonic AG-HVX200 can record natively (without duplicate frames) to the 720pN30 and 720pN24 formats. The Panasonic AG-HVX200E camcorder supports 720pN25.

Some DVCPRO HD camcorders support variable frame rate recording in the 720p format. In this case, the video is actually recorded at 60 or 50 fps and duplicate frames are flagged for removal during post-production. Duplicate frames can be removed using a frame rate converter.

Scanning Method
DVCPRO HD can record either interlaced or progressive scan images, depending on the frame size and format.

- **1080 lines**: Interlaced or progressive (via advanced pull-down)
- **720 lines**: Progressive only

Color Recording Method
DVCPRO HD records a 4:2:2 \( Y'Y'Y' \) \( C_bC_bC_b \) \( C_rC_rC_r \) (component) digital video signal. Each sample (pixel) has a native resolution of 8 bits.
Data Rate
The data rate of DVCPRO HD on tape is fixed at 115 Mbps, which is double the DVCPRO 50 data rate and four times the rate of DVCPRO.

The table below compares the captured data rates for DVCPRO HD formats. These data rates show video only.

<table>
<thead>
<tr>
<th>Format</th>
<th>Data rate (Mbps)</th>
<th>Data rate (MB/sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i60</td>
<td>115 Mbps</td>
<td>14.4 MB/sec.</td>
</tr>
<tr>
<td>1080i50</td>
<td>115 Mbps</td>
<td>14.4 MB/sec.</td>
</tr>
<tr>
<td>720p60</td>
<td>115 Mbps</td>
<td>14.4 MB/sec.</td>
</tr>
<tr>
<td>720p50</td>
<td>115 Mbps</td>
<td>14.4 MB/sec.</td>
</tr>
<tr>
<td>720pN30</td>
<td>58 Mbps</td>
<td>7.2 MB/sec.</td>
</tr>
<tr>
<td>720pN25</td>
<td>58 Mbps</td>
<td>7.2 MB/sec.</td>
</tr>
<tr>
<td>720pN24</td>
<td>46 Mbps</td>
<td>5.8 MB/sec.</td>
</tr>
</tbody>
</table>

The actual disk space used during capture will vary slightly depending on the number of audio channels captured. Each captured audio track adds an additional 0.34 MB/sec.

Because DVCPRO HD is compressed, an internal 7200 rpm parallel or serial ATA drive is sufficient for capturing DVCPRO HD footage. FireWire drives are often sufficient as well.

Video Compression
DVCPRO HD uses a variation of the DV and DVCPRO 50 codecs. The compression ratio is around 8.6:1.

Audio
The DVCPRO HD format supports up to eight audio tracks, though not all devices can access every track. The sample rate is 48 kHz, using 16 bits per sample.

Timecode
On tape or P2 card, 1080i60, 1080p30, and 720p60 DVCPRO HD use 30 fps timecode. 1080i50 and 720p50 DVCPRO HD use 25 fps timecode. When recording 720p60 DVCPRO HD, each timecode number is used twice, with an asterisk used to distinguish frame 1 and frame 2 of each timecode pair. This maintains backward compatibility with SMPTE 30 fps timecode. When 720p60 footage is captured, the 30 fps timecode is converted to 60 fps timecode. To allow you to view 30 fps timecode instead of the 60 fps timecode in your media files, Final Cut Pro has a timecode display option called 60 @ 30 timecode.

Note: Final Cut Pro supports drop frame timecode for 720p formats.
This chapter covers the following:

• About IMX (p. 61)
• Working with IMX in Final Cut Pro (p. 62)
• IMX Format Specifications (p. 63)

Native IMX editing support makes Final Cut Pro a powerful addition to any broadcast post-production environment.

About IMX
IMX is a high-quality, standard definition, MPEG-2-based video format created by Sony. Both NTSC and PAL video standards are supported.

IMX is not bound to a particular tape format or transmission method; IMX can just as easily be stored on tape, hard disk, or optical disc. In addition to standard video signal transfers via analog component and SDI interfaces, SDTI and Ethernet interfaces can be used to transfer native IMX data.

IMX bridges the gap between traditional video formats and computer-based post-production systems by encapsulating video and audio data within an increasingly popular data format known as MXF.

IMX Formats Supported by Final Cut Pro
IMX can be recorded using NTSC or PAL video standards at three possible bit rates (30, 40, and 50 Mbps). Final Cut Pro supports real-time editing and effects using the 30, 40, and 50 Mbps IMX formats.

<table>
<thead>
<tr>
<th>Format</th>
<th>Frame dimensions</th>
<th>Data rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMX - NTSC</td>
<td>720 x 486</td>
<td>30, 40, and 50 Mbps</td>
</tr>
<tr>
<td>IMX - PAL</td>
<td>720 x 576</td>
<td>30, 40, and 50 Mbps</td>
</tr>
</tbody>
</table>
About MXF

Material eXchange Format (MXF) is a generic media container format for the video industry. It is not a compression scheme or specific video type, but rather a container for storage and transmission of video, audio, and associated metadata. An MXF container is similar in concept to a QuickTime movie, which is a general-purpose media container that can contain video and audio with various dimensions, codecs, sample rates, and so on.

For example, the IMX format stores MPEG-2-compressed video and audio within an MXF container. However, because MXF is not codec-specific, it can contain video compressed with other codecs as well, such as DVCAM. Panasonic P2 cards can store DV, DVCPro, DVCPro 50, and DVCPro HD data within an MXF wrapper. The MXF wrapper facilitates transfer and storage of specialized media data within general-purpose computer systems and across multiple media types.

Working with IMX in Final Cut Pro

There are several steps for importing and editing IMX video in Final Cut Pro. Because IMX is an MXF-based format, you need third-party software to extract MPEG-2 IMX media from its MXF container and store it in QuickTime media files.

Stage 1: Transferring IMX Media to Your Computer

IMX media is stored within MXF files, so the first step is to transfer the MXF files containing your IMX media to your computer hard disk. Depending on the media format you are using, you can use a Sony IMX VTR, XDCAM player, or any other device that supports MXF file transfers. For more information about transferring IMX media to your computer, see the documentation that came with your deck.

Stage 2: Importing MXF-Wrapped IMX Media Files into Your Project

Once you have MXF files on your hard disk, you need to extract the IMX MPEG-2 media data and store it within QuickTime media files. This process requires a third-party plug-in that extends the ability of Final Cut Pro to import MXF-encoded media. Once your IMX media has been converted from MXF to QuickTime media files, you can import the QuickTime media files into Final Cut Pro.

Stage 3: Choosing an IMX Easy Setup

After you convert MXF files to QuickTime media files containing IMX MPEG-2 media, you need to choose a sequence preset (or corresponding Easy Setup) that is compatible with your IMX format. Final Cut Pro includes Easy Setups for real-time editing using 30, 40, or 50 Mbps NTSC or PAL IMX media.

Stage 4: Editing Your IMX Clips into a Sequence

No special features or settings are necessary for editing IMX in Final Cut Pro. As with any other format, you simply need to make sure your Easy Setup matches the format of the footage you are editing.
Stage 5: Exporting IMX QuickTime Media Files
When you finish editing your sequence, you can export a QuickTime movie using the corresponding NTSC or PAL IMX codec.

IMX Format Specifications
IMX, also known as Betacam IMX or MPEG IMX, records SD NTSC and PAL video using high-quality MPEG-2 compression.

Storage Medium
One of the features of the IMX format is that it is not restricted to a single media type. IMX can be recorded on XDCAM, a Sony optical disc format, as well as the IMX tape format.

IMX VTRs bridge the gap between conventional tape decks and modern computer editing systems with the following features:

- Playback of older video formats such as Betacam SP, Beta SX, and Digital Betacam. These formats can be converted and output to MPEG IMX in real time.

  Note: Not all IMX VTRs support playback and recording of all Betacam formats.

- IMX digital video file transfer via networking interfaces such as Ethernet and TCP/IP protocols

Video Standard
IMX supports both SD NTSC and SD PAL.

Aspect Ratio
NTSC and PAL IMX both have an aspect ratio of 4:3.

Frame Dimensions, Number of Lines, and Resolution
IMX can store video at two possible resolutions: NTSC (525) and PAL (625). The numbers refer to the number of analog lines of the corresponding video formats. However, many of these analog lines are not used to store picture information. In Final Cut Pro, the following frame dimensions are used:

- **NTSC IMX**: 720 pixels per line, 486 lines
- **PAL IMX**: 720 pixels per line, 576 lines

In both formats, standard definition rectangular pixels are used, just as with DV, DVD, Digital Betacam, and other SD digital video formats.

Frame Rate
IMX supports NTSC and PAL frame rates of 29.97 fps and 25 fps, respectively.

Scanning Method
IMX supports interlaced recording.
**Color Recording Method**
IMX records a 4:2:2 $Y'CbCr$ (component) digital video signal. Each sample (pixel) has a resolution of 8 bits.

**Data Rate and Video Compression**
IMX uses I-frame-only MPEG-2 compression. IMX is a restricted version of MPEG-2 4:2:2 Profile @ ML. The official SMPTE designation is D10, as specified in SMPTE standard 356M.

Three compression ratios are supported:
- **30 Mbps**: 5.6:1 compression
- **40 Mbps**: 4.2:1 compression
- **50 Mbps**: 3.3:1 compression

**Audio**
IMX supports two audio channel configurations:
- Four audio channels, sampled at 48 kHz with 24 bits per sample
- Eight audio channels, sampled at 48 kHz with 16 bits per sample

**Timecode**
IMX supports 30 and 25 fps timecode.
This chapter covers the following:

- About Panasonic P2 Cards and Media Files (p. 65)
- Recording Footage with a P2 Camcorder (p. 66)
- Mounting P2 Cards, Disk Images, and Folders (p. 66)
- Deleting P2 Clips Directly in the Log and Transfer Window (p. 69)
- P2 Card Restrictions During Preview (p. 70)
- Removing Advanced Pull-Down and Duplicate Frames During Transfer (p. 70)
- Working with Spanned Clips (p. 71)
- Using Print to Video to Output to P2 Cards in P2 Camcorders (p. 71)
- Capturing over FireWire as If a P2 Card Were a Tape in a VTR (p. 73)
- Panasonic P2 Camcorder Compatibility (p. 74)
- Panasonic P2 Card Format Specifications (p. 76)

You can use the Log and Transfer window to view footage recorded on Panasonic P2 cards and transfer it to your computer.

**About Panasonic P2 Cards and Media Files**

*A Professional Plug-in* card (P2 card) is a compact, solid-state memory card designed for professional video use. Because they have no moving parts, P2 cards are free from many of the pitfalls associated with tape-based media, such as temperature and moisture sensitivity, tangled tape, dropouts, and tedious logging and capturing. Panasonic currently produces proprietary P2 cameras, decks, and card readers.

The original P2 card had a capacity of 2 GB, or roughly 8 minutes of DV 25 footage. Cards with 64 GB capacities are now available, and capacities are projected to grow geometrically with each new P2 card release.
The following definitions provide some shorthand for discussing P2 cards and media.

- **P2 card**: A solid-state memory card for recording DV, DVCPro, DVCPro 50, DVCPro HD, and AVC-Intra media within MXF container files.
- **P2 device**: A camcorder, deck, or card reader capable of reading and writing to a P2 card. These devices can usually be connected to a Mac computer via a USB or FireWire cable.
- **P2 volume**: Any P2 card or mounted disk image that contains a valid P2 directory structure and MXF media files. For more information, see “Panasonic P2 Card Format Specifications.”
- **P2 folder**: Any folder that contains a valid P2 directory structure and MXF media files. For more information, see “Panasonic P2 Card Format Specifications.”
- **P2 clip**: An XML clip file and its associated MXF video and audio files, stored on a P2 volume. P2 media files use the FAT32 file system and are therefore limited to 4 GB.
- **P2 clip name**: A simple clip name, usually six characters long, assigned automatically by the P2 camcorder.
- **P2 clip ID**: A universally unique ID (UUID) number assigned to each clip recorded by a P2 camcorder. This is also called *global clip ID*.

### Recording Footage with a P2 Camcorder

The Panasonic AG-HVX200 P2 camcorder, a widely used P2 device, supports a large number of SD and HD video formats at various frame rates. The Panasonic AG-HVX200 camcorder can record on either tape or P2 cards, but some formats can only be recorded on P2 cards. For a detailed list of formats supported by the Panasonic AG-HVX200 camcorder, see “Panasonic P2 Camcorder Compatibility.”

### Mounting P2 Cards, Disk Images, and Folders

After you record footage on P2 cards, there are three ways to mount P2 cards in your computer’s file system:

- **Use a Panasonic P2 memory card reader connected to your Mac computer**: For more information, see “Mounting P2 Cards Using a P2 Card Reader or Store Unit.”
- **Use a Panasonic P2 camcorder connected via FireWire as a card reader**: For more information, see “Mounting P2 Cards Using a Panasonic P2 Camcorder.”
- **Insert a P2 card into the PCMCIA slot on a PowerBook computer**: For more information, see “Mounting P2 Cards Using a PowerBook PC Card Slot.”

Alternatively, you can:

- Mount archived disk images of P2 cards that you previously created with the Log and Transfer window.
For more information about using the Log and Transfer window, see “Overview of Transferring File-Based Media” and “About the Log and Transfer Window” in the Final Cut Pro 7 User Manual.

- Ingest MXF media from any P2-compliant folder on a local or networked hard disk
  For more information, see “Using Folders with Valid P2 Card Folder Structure.”

You can also configure the Panasonic P2 camcorder as a VTR and use the Log and Capture window as though the P2 card were a tape in a video deck. This method is slower than mounting P2 cards on the desktop, so it is rarely recommended. For more information, see “Capturing over FireWire as If a P2 Card Were a Tape in a VTR.”

**Important:** When you finish working with a P2 card, make sure you eject (unmount) it from the Finder before physically removing it from the reader device.

### Mounting P2 Cards Using a P2 Card Reader or Store Unit

You can use a Panasonic memory card reader or a Panasonic P2 store (AJ-PCS060G) portable hard disk unit to import or copy P2 media.

**To mount a P2 memory card using a P2 card reader**

1. Connect the P2 memory card device to your computer.
2. Insert a P2 memory card into one of the slots in the P2 memory card device.

Individual memory cards (or partitions on the P2 store portable hard disk unit) appear on the desktop as mounted disks named NO NAME.

**Important:** When you have finished, eject (unmount) the P2 card before disconnecting the card reader, or before removing the card.

### Mounting P2 Cards Using a Panasonic P2 Camcorder

You can use a Panasonic P2 camcorder as a P2 card reader to mount P2 cards on the desktop. The following instructions use a Panasonic AG-HVX200 camcorder as an example.

**To configure a Panasonic AG-HVX200 camcorder as a P2 card reader**

1. Connect one end of a FireWire cable to the corresponding port on the camcorder.
2. Connect the other end of the FireWire cable to a corresponding port on your computer.
On the camcorder, do the following:

a. Choose Camera mode.
b. Press the Menu button.
c. Choose the Other Functions menu and then highlight the PC Mode setting.
d. Set the PC Mode setting to 1394DEVICE.
e. Press the mode button to switch from Camera mode to MCR/VCR mode.
f. Hold down the mode button again for several seconds until the camcorder screen displays solid blue and the PC/Dub mode light is on.

The P2 cards in the camcorder appear as mounted disks on the desktop in the Finder.

Note: If you have already set the PC Mode setting to 1394DEVICE, you can skip steps c and d.

Mounting P2 Cards Using a PowerBook PC Card Slot

To mount a Panasonic P2 card in Mac OS X using the PC Card (cardbus) slot of a PowerBook, you first need to download and install the P2 Driver Software from the Panasonic website at https://eww.pavc.panasonic.co.jp/pro-av/support/desk/e/download.htm.

Note: You may need to provide the serial number of one of your Panasonic P2 devices to download the P2 Driver Software. Carefully follow the installation instructions included with the P2 Driver Software. Installing this driver requires you to restart your computer.

To mount a P2 card inserted in the PC Card slot of a PowerBook

1. Make sure the P2 Driver Software from the Panasonic website is installed on the PowerBook.
2. Insert the P2 card containing the media you want to import into the PowerBook PC Card slot.

The P2 card appears on the desktop as a mounted disk named NO NAME.
Note: You can rename the card after it is mounted in a PowerBook. To be safe, limit P2 card names to alphanumeric characters (numbers and letters—no punctuation or other symbols).

Unmounting P2 Cards
To safely remove a P2 card from a P2 device connected to your computer, make sure you unmount the volume from the desktop in the Finder.

To unmount a P2 card on the desktop
Do one of the following:

- In the Finder, select the mounted P2 card, then choose File > Eject (or press Command-E).
- In the Log and Transfer window, select the P2 card, then click the Eject button.

After unmounting the volume, you can remove the card from the P2 device or PowerBook PC Card slot.

Using Folders with Valid P2 Card Folder Structure
The Log and Transfer window can ingest MXF media from any folder with a valid Panasonic P2 folder structure. You can create these folders by copying them from P2 cards and devices to your hard disk. For more information, see “Panasonic P2 Card Format Specifications.”

For more information about using the Log and Transfer window, see “Overview of Transferring File-Based Media” and “About the Log and Transfer Window” in the Final Cut Pro 7 User Manual.

Important: Final Cut Pro only recognizes P2-compliant folders that include the original media files, the descriptive metadata, and a corresponding set of XML clip files. If you need to copy the contents of a P2 card to a hard disk, duplicate the contents without making any changes. Don’t copy only the CONTENTS folder; copy the enclosing folder.

Deleting P2 Clips Directly in the Log and Transfer Window
If a P2 volume has read-and-write access (as opposed to read-only access), you can delete clips and their associated media by:

- Selecting a clip and pressing Delete
- Control-clicking a clip and choosing Delete from the shortcut menu

Most P2 folders and disk images have read-and-write access. However, if you mount P2 cards via an older Panasonic P2 card reader, certain Panasonic camcorders, or a Panasonic P2 store portable hard disk unit, the volumes have read-only access.
**Important:** If you delete a media file from a P2 card, folder, or disk image, the footage is irretrievable. Because most workflows reuse P2 cards during production, you should develop a plan for backing up original media on P2 cards in case you need to reingest it later.

For more information about using the Log and Transfer window, see “Overview of Transferring File-Based Media” and “About the Log and Transfer Window” in the *Final Cut Pro 7 User Manual*.

### P2 Card Restrictions During Preview

The following restrictions apply when viewing P2 clips in the Preview area of the Log and Transfer window:

- **Listening to audio while scrubbing:** While previewing footage in the Log and Transfer window, you can only hear audio during forward and reverse playback at normal (100 percent) speed. Scrubbing at other speeds is silent.

- **Video playback performance:** Computers with the minimum HD video system requirements (a 1.25 GHz processor and 1 GB of RAM) do not smoothly preview HD video in the Preview area.

- **P2 card and volume playback performance:** If you experience playback issues from a clip stored on a P2 card, copy the CONTENTS folder from the P2 card to a folder on a separate hard disk and then use the copied clip for ingest. If you use this method, make sure to unmount the original P2 card so that there are not multiple occurrences of the same P2 clip in the Log and Transfer window.

For more information about using the Log and Transfer window, see “Overview of Transferring File-Based Media” and “About the Log and Transfer Window” in the *Final Cut Pro 7 User Manual*.

### Removing Advanced Pull-Down and Duplicate Frames During Transfer

The Remove Advanced Pulldown and Duplicate Frames option in the Log and Transfer window preferences allows you to remove redundant (duplicate) frames recorded in variable frame rate DVCPro HD 720p footage. You can also select this option to remove advanced (2:3:3:2) pull-down from 29.97 fps footage such as 1080i and 480i, resulting in 23.98 fps (24p) footage on disk after ingest.

The Panasonic AG-HVX200 camcorder can record 24p footage on P2 cards using three methods:

- Native 23.98 fps (no pull-down or extra frames)
- 23.98 fps with standard 3:2 (2:3:2:3) pull-down
• 23.98 fps with advanced (2:3:3:2) pull-down

*Important:* The Log and Transfer window cannot remove standard 3:2 pull-down. To convert footage with 3:2 pull-down, you can ingest the media at 29.97 fps and then use Cinema Tools to remove the pull-down.

For details about selecting the Remove Advanced Pulldown and Duplicate Frames option, see “Advanced Topics in Transferring File-Based Media” in the *Final Cut Pro 7 User Manual*.

---

**Working with Spanned Clips**

A spanned clip is created any time you record a single shot that is larger than the capacity of the current P2 card or when the file size exceeds 4 GB. When this happens, the camcorder stops recording the current media file and begins recording a new media file on a new P2 volume. The result is a single shot that seamlessly comprises multiple media files.

*Important:* To ingest (or reingest) a spanned clip as a single media file, it is recommended that you mount all of the P2 volumes necessary for the clip. Mounting separate P2 volumes at different times may cause Final Cut Pro to transfer only portions of a P2 clip.

---

**Using Print to Video to Output to P2 Cards in P2 Camcorders**

You can output footage in Final Cut Pro to P2 cards in Panasonic P2 camcorders. This method works only when using the built-in FireWire port on your computer in conjunction with the Print to Video command or when playing footage directly in the Viewer or Timeline.

To output to P2 cards, the following must be true:

- The camcorder recording mode and your footage in Final Cut Pro must have matching settings. For example, if your footage is 720p60, the camcorder recording mode must be set to 720P/60P.

- Your current video playback selection must match the camcorder recording mode. For example, if your camcorder recording mode is set to 720P/60P, you must choose View > Video Playback > DVCPRO HD (720p60) (1280 x 720). The same option appears in the A/V Devices tab of the Audio/Video Settings window. If you don’t see the video playback option you want, try changing the camcorder recording mode (for more information, see the setup steps below).

- You must have available space on the P2 cards inserted in the Panasonic P2 camcorder.

The following instructions for outputting footage from Final Cut Pro to P2 cards use a Panasonic AG-HVX200 camcorder as an example.
To set up Final Cut Pro and a Panasonic AG-HVX200 camcorder for output to P2 cards

1 Connect the camcorder and computer using a 4-pin-to-6-pin FireWire cable.

2 On the camcorder, do the following:
   a Choose Camera mode.
   b Press the Menu button.
   c Choose the Recording Setup menu and then select REC FORMAT.
   d Set the REC FORMAT to the format of your footage in Final Cut Pro.
      For example, if your footage is DVCPRO HD 720p60, select 720P/60P.
   e Press the mode button to switch to MCR/VCR mode.
   f Press the AUDIO DUB/THUMBNAIL button.

   If the current video playback setting in Final Cut Pro does not match the camcorder
   recording mode, you may see “1394 INPUT ERROR” flashing on the camcorder display.

   g Press the Menu button and choose the RECORDING SETUP menu.

   h Turn on the 1394 TC REGEN and 1394 UB REGEN options, then press the Menu button
      to exit the menu.

3 In Final Cut Pro, choose View > Video Playback, then choose the format you want to
   output via FireWire.

   For example, if you want to output 720p60 footage and the camcorder recording mode
   is set to 720P/60P, you should choose View > Video Playback > DVCPRO HD (720p60)
   (1280 x 720).

4 Open a clip in the Viewer or a sequence in the Timeline whose format matches the
   recording mode of the camcorder.

5 Choose View > External Video > All Frames.

   The current frame in the Viewer or Canvas appears on the camcorder display. If the current
   frame does not appear, start over from step 2.

6 Do one of the following:
   • Choose File > Print to Video, choose your output options, then click OK.
   • Press the Space bar to begin playing your footage directly in the Viewer or Timeline.

      Note: For best results, deselect the Automatically Start Recording checkbox in the Print
      to Video window.

7 On the camcorder, press the red and gray record buttons simultaneously.

8 When you have finished recording, press the Pause/Set button on the camcorder and
   then press the Down menu button.
To verify that a clip was created on the P2 card in the camcorder, press the AUDIO DUB/THUMBNAIL button on the camcorder, navigate to the thumbnail for the clip you just recorded, then press the Up menu button to play the clip.

**Important:** Not all formats supported by the Panasonic AG-HVX200 camcorder can be output to P2 cards from Final Cut Pro. Make sure to test the format you want to output before starting your project. For example, 720pN24, 720pN30, 720p25, and variable frame rate formats are not supported.

**Capturing over FireWire as If a P2 Card Were a Tape in a VTR**

You can configure the Panasonic AG-HVX200 camcorder so that Final Cut Pro treats it like a traditional VTR (video deck). Accordingly, inserted P2 cards can emulate the linear nature of tape, allowing you to use the Log and Capture window to transfer media.

**Note:** Because footage is transferred in real time as though it were coming from tape, this method is slower than ingesting media via the Log and Transfer window.

**To use the Log and Capture window to capture media from a P2 card**

1. Connect one end of a FireWire cable to the corresponding port on the camcorder.
2. Connect the other end of the FireWire cable to a corresponding port on your computer.
3. Insert the P2 card containing the clips you want to capture into one of the slots in the camcorder.
4. On the camcorder, do the following:
   a. Choose Camera mode.
   b. Press the Menu button.
   c. Choose the Other Functions menu, then select the PC Mode setting.
   d. Set the PC Mode setting to 1394DEVICE.
   e. Press the mode button to switch from Camera mode to MCR/VCR mode.
      **Important:** Do not open Final Cut Pro until after you switch to MCR/VCR mode. Otherwise, device control or video passthrough may not be available.
5. Use the AUDIO DUB/THUMBNAIL button to switch out of Thumbnail mode.
   **Note:** To start capturing from a particular point in the footage, first use the camcorder’s Thumbnail feature to select a particular clip, then use the AUDIO DUB/THUMBNAIL button to switch out of Thumbnail mode.
6. Open Final Cut Pro and choose Final Cut Pro > System Settings, then click the Scratch Disks tab.
7. Select a scratch disk or folder to which you want to transfer your P2 media.
For more information about selecting scratch disks, see “Connecting DV Video Equipment” in the *Final Cut Pro 7 User Manual*.

8 In Final Cut Pro, choose File > Log and Capture (or press Command-8).

9 Do one of the following:
   • Click the Play button.
   • Press the Space bar.

10 When you’re ready to begin capturing, click the Capture Now button. Final Cut Pro begins capturing your media file to your scratch disk.

   **Important:** If you intend to capture to the end of recorded material, first choose Final Cut Pro > User Preferences and make sure the “Abort capture on dropped frames” checkbox is not selected. Unlike a VTR, which repeats frames when it reaches the end of media, the Panasonic AG-HVX200 camcorder simply stops transmitting frames. This preference setting ensures that the last clip is saved.

11 Press the Esc (Escape) key to stop capturing, or wait until Final Cut Pro automatically stops because the maximum amount of time specified in the Limit Capture Now To field (in the Scratch Disks tab of the System Settings window) has been reached.

   After Final Cut Pro stops capturing, a clip appears in your logging bin. The new clip refers to the media file you just captured.

12 When you have finished, eject (unmount) the P2 card before disconnecting the camcorder, or before removing the card.

**Panasonic P2 Camcorder Compatibility**

Panasonic P2 camcorders support a large number of SD and HD video formats at various frame rates. For example, the table below lists formats supported by the Panasonic AG-HVX200 P2 camcorder and Final Cut Pro. The Panasonic AG-HVX200 camcorder can record on either tape or P2 cards, but some formats can only be recorded on P2 cards.
Panasonic AG-HVX200 (NTSC)
This table shows which NTSC formats supported by the Panasonic AG-HVX200 camcorder are compatible with recent versions of Final Cut Pro.

<table>
<thead>
<tr>
<th>Format</th>
<th>Recorded frame rate</th>
<th>Pull-down/duplicate frame pattern</th>
<th>Timecode</th>
<th>P2</th>
<th>Tape</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i60</td>
<td>29.97i</td>
<td>-</td>
<td>DF, NDF</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1080p30</td>
<td>29.97i</td>
<td>2:2</td>
<td>DF, NDF</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1080p24</td>
<td>29.97i</td>
<td>2:3</td>
<td>NDF</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>1080pA24</td>
<td>29.97i</td>
<td>2:3:3:2</td>
<td>NDF</td>
<td>2, 3</td>
<td>2, 3</td>
</tr>
<tr>
<td>480i60</td>
<td>29.97i</td>
<td>-</td>
<td>DF, NDF</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>480p30</td>
<td>29.97i</td>
<td>2:2</td>
<td>DF, NDF</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>480p24</td>
<td>29.97i</td>
<td>2:3</td>
<td>DF, NDF</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>480pA24</td>
<td>29.97i</td>
<td>2:3:3:2</td>
<td>DF, NDF</td>
<td>2, 3</td>
<td>2, 3</td>
</tr>
<tr>
<td>720p60</td>
<td>59.94p</td>
<td>-</td>
<td>DF, NDF</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>720p30</td>
<td>59.94p</td>
<td>2:2</td>
<td>NDF</td>
<td>3, 4</td>
<td>3, 4</td>
</tr>
<tr>
<td>720p24</td>
<td>59.94p</td>
<td>2:3</td>
<td>NDF</td>
<td>3, 4</td>
<td>3, 4</td>
</tr>
<tr>
<td>720p VFR(^1)</td>
<td>59.94p</td>
<td>-</td>
<td>NDF</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>720pN30</td>
<td>29.97p</td>
<td>-</td>
<td>NDF</td>
<td>1</td>
<td>n/a</td>
</tr>
<tr>
<td>720pN24</td>
<td>23.98p</td>
<td>-</td>
<td>NDF</td>
<td>1</td>
<td>n/a</td>
</tr>
<tr>
<td>720p N VFR(^1)</td>
<td>VFR</td>
<td>-</td>
<td>NDF</td>
<td>1</td>
<td>n/a</td>
</tr>
</tbody>
</table>

\(^1\) 720p variable frame rates: 12, 18, 20, 22, 24, 26, 30, 32, 36, 48, and 60 fps

i = interlaced, p = progressive, A = advanced pull-down,
N = native frame rate (without duplicate fields or frames), DF = drop frame, NDF = non-drop frame,
VFR = variable frame rate

1 - No pull-down removal is necessary; native frame rate is captured or ingested.
2 - Use Remove Advanced Pulldown command in Final Cut Pro or Cinema Tools after capture or ingest.
3 - Enable Advanced Pulldown Removal option during capture (tape) or ingest (P2).
4 - Use Frame Rate Converter (audio and timecode are removed).

For more information about frame rates, see “Using the DVCPro HD Frame Rate Converter.”
Panasonic AG-HVX200E (PAL)
This table shows which PAL formats supported by the Panasonic AG-HVX200E camcorder are compatible with recent versions of Final Cut Pro.

<table>
<thead>
<tr>
<th>Format</th>
<th>Recorded frame rate</th>
<th>Pull-down/duplicate frame pattern</th>
<th>Timecode</th>
<th>P2</th>
<th>Tape</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i50</td>
<td>25i</td>
<td>-</td>
<td>NDF</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1080p25</td>
<td>25i</td>
<td>2:2</td>
<td>NDF</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>576i50</td>
<td>25i</td>
<td>-</td>
<td>NDF</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>576p25</td>
<td>25i</td>
<td>2:2</td>
<td>NDF</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>720p50</td>
<td>50p</td>
<td>-</td>
<td>NDF</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>720p25</td>
<td>50p</td>
<td>2:2</td>
<td>NDF</td>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>720p VFR¹</td>
<td>50p</td>
<td>-</td>
<td>NDF</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>720pN25</td>
<td>25p</td>
<td>-</td>
<td>NDF</td>
<td>1</td>
<td>n/a</td>
</tr>
<tr>
<td>720pN VFR¹</td>
<td>VFR</td>
<td>-</td>
<td>NDF</td>
<td>1</td>
<td>n/a</td>
</tr>
</tbody>
</table>

¹ 720p variable frame rates: 12, 18, 20, 23, 25, 27, 30, 32, 36, 48, and 50 fps

i = interlaced, p = progressive, A = advanced pull-down,
N = native frame rate (without duplicate fields or frames), DF = drop frame, NDF = non-drop frame,
VFR = variable frame rate

1 - No pull-down removal is necessary; native frame rate is captured or ingested.
2 - Ingest is supported but native 720p50 editing is not supported.
3 - Enable Advanced Pulldown Removal option during (P2) ingest.
4 - Use Frame Rate Converter (audio and timecode are removed).

For more information about frame rates, see “Using the DVCPro HD Frame Rate Converter.”

Panasonic P2 Card Format Specifications
A P2 card is a PC Card containing four Secure Digital memory cards ganged together in a RAID 0 array, providing quadruple the capacity and transfer speed of a single Secure Digital card. P2 cards are formatted using the FAT32 file system, which limits the size of a single file to 4 GB. For example, if you record continuously on an 8 GB P2 card, a single shot will be broken into two 4 GB media files (known as a spanned clip). For more information about spanned clips, see the Final Cut Pro 7 User Manual.

The Panasonic file system organizes clips, media, and metadata into the following file hierarchy:

- CONTENTS: This is the root folder of a P2 card, containing folders of all recorded media and metadata.
- AUDIO: Contains audio media of each clip, wrapped within MXF container files.
• **CLIP:** Each clip on a P2 card is defined by an XML file identifying which video and audio MXF files are part of the clip, where the thumbnail (icon) file is located, and additional metadata describing the clip’s media.

• **ICON:** Contains thumbnail files for each clip, usually in BMP format.

• **PROXY:** Contains optional, low-resolution MPEG-4 files representing each clip. Used for reviewing footage or previewing before transfer. (The Panasonic AG-HVX200 camcorder does not record proxy files.)

• **VIDEO:** Contains video media of each clip, wrapped within MXF container files. Common Panasonic codecs such as DV, DVCPRO 50, DVCPRO HD, and AVC-Intra are supported.

• **VOICE:** Contains optional voice annotations that can be associated with each clip. (The Panasonic AG-HVX200 camcorder does not record voice annotations.)
This chapter covers the following:

• About AVCHD (p. 79)
• Working with AVCHD in Final Cut Pro (p. 79)
• AVCHD Format Specifications (p. 82)

The Log and Transfer window allows you to transfer AVCHD footage from file-based camcorders.

**About AVCHD**
AVCHD is an HD video format jointly developed by Sony and Panasonic. AVCHD uses Advanced Video Coding (AVC) compression (also known as MPEG-4 part 10 or H.264) to achieve high-quality images and low data rates. AVCHD camcorders record on a variety of file-based media, including 80 mm DVDs, hard disks, and flash memory (such as Secure Digital cards and memory sticks).

The AVCHD specification allows most SD and HD dimensions and frame rates, though each camcorder usually supports only a few formats. The AVCHD color sample ratio is 4:2:0, with 8 bits per sample. Audio can be recorded in 5.1-channel surround sound with Dolby Digital (AC-3) compression or up to 7.1-channel surround sound (uncompressed). Some camcorders, such as the Panasonic HDC-SD5 camcorder, use a two-channel built-in microphone.

**Working with AVCHD in Final Cut Pro**
Final Cut Pro does not have native editing support for AVCHD footage. You can use the Log and Transfer window to transcode AVCHD footage to an Apple ProRes codec or the Apple Intermediate Codec during transfer.
After you have transferred your footage, you can edit using Apple ProRes or the Apple Intermediate Codec and output to the format of your choice.

In the figure above, the media is transcoded to an Apple ProRes codec, but you can also use the Apple Intermediate Codec in a transcoding workflow.

**Important:** You cannot export footage back to the AVCHD format from Final Cut Pro.

**Transferring AVCHD Footage**
You can transfer AVCHD footage to your scratch disk using the Log and Transfer window in Final Cut Pro. During transfer, you can choose whether the Log and Transfer window transcodes your footage to an Apple ProRes codec or to the Apple Intermediate Codec. For more information about using the Log and Transfer window, see “Overview of Transferring File-Based Media” and “About the Log and Transfer Window” in the *Final Cut Pro 7 User Manual*.

**Important:** Although it is possible to copy AVCHD files directly to your scratch disk, Final Cut Pro won’t recognize these files. You must use the Log and Transfer window to transfer and transcode AVCHD footage.

**Restrictions When Working with AVCHD**
The following restrictions apply when working with AVCHD footage:

- AVCHD camcorders typically connect to computers via USB 2.0, not FireWire.
- AVCHD support is available only on Intel-based Mac computers.
- DVD-based AVCHD camcorders are not supported in Mac OS X Server v10.4 or earlier.
- SD video recorded with AVCHD camcorders can’t be accessed in the Log and Transfer window.
- AVCHD footage is not captured natively but is transcoded to an Apple ProRes codec or the Apple Intermediate Codec. You can choose the destination codec in the Log and Transfer window preferences. For more information, see “Choosing an AVCHD Destination Codec.”
- When you choose to transfer AVCHD audio in the Logging area, audio is automatically mixed down to stereo.
• It is not possible to delete clips on an AVCHD volume, even if read-and-write permissions on the volume are set to allow file deletion. This behavior is different from that of P2 volumes, where clip deletion is allowed when proper read-and-write permissions are set.

• The Log and Transfer window shows only an average duration for AVCHD clips, especially clips longer than 1 minute. After clips are ingested, the correct duration is displayed in the Final Cut Pro Browser.

For more information about using the Log and Transfer window, see “Overview of Transferring File-Based Media” and “About the Log and Transfer Window” in the Final Cut Pro 7 User Manual.

AVCHD Restrictions During Preview
Preview of AVCHD video in the Log and Transfer window is limited to forward playback at 100 percent speed. When you scrub with the playhead, video is not updated in the Preview area until you stop scrubbing. Also, as you enter or scrub to In and Out points, the playhead snaps to the closest I-frame in your footage, which may be slightly different from the precise timecode value you specified.

For more information about using the Log and Transfer window, see “Overview of Transferring File-Based Media” and “About the Log and Transfer Window” in the Final Cut Pro 7 User Manual.

Choosing an AVCHD Destination Codec
Even simple AVCHD decoding for playback requires a lot of processing power. To reduce the processing demands on your computer, the Log and Transfer window transcodes your AVCHD footage to a less processor-intensive codec. The default destination codec is Apple ProRes 422, but you can also choose other Apple ProRes codecs or the Apple Intermediate Codec.

To choose the destination codec for AVCHD footage transferred in the Log and Transfer window
1 In the Log and Transfer window, choose Preferences from the Action pop-up menu (with a gear icon) in the upper-right corner of the Browse area.

2 In the dialog that appears, choose a destination codec for the AVCHD plug-in from the pop-up menu in the “Transcode to” column, then click OK.

For more information about using the Log and Transfer window, see “Overview of Transferring File-Based Media” and “About the Log and Transfer Window” in the Final Cut Pro 7 User Manual.
Note: When ingesting AVCHD audio, the AVCHD plug-in is preset to ingest the audio as Matrix stereo. With some AVCHD camcorders, the audio may sound unbalanced when ingested as Matrix stereo. To correct the imbalance, select the AC-3 Audio decoder option in the AVCHD plug-in preferences, and choose Plain Stereo. Then reingest the AVCHD footage. It’s a good idea to ingest an initial AVCHD clip and check for this sound imbalance. You can then select the appropriate setting before ingesting the remainder of your AVCHD footage.

About Transcoded AVCHD Files and Disk Space
When you ingest AVCHD files using the Log and Transfer window, video is transcoded to either an Apple ProRes codec or the Apple Intermediate Codec. AVCHD has a much higher compression ratio than Apple ProRes, so the ingested files are significantly larger than the original files. For example, a 2-minute native AVCHD file is about 200–300 MB. After transcoding to the Apple ProRes 422 codec, the file size can be as large as 2 GB.

To create smaller files during transfer, transcode AVCHD files to Apple ProRes 422 (LT). For more information about the relative data rates and file sizes for these formats, see “Working with Apple ProRes.”

To see the size of the source file and an estimated size of the file after transcoding, you can display Source Size and Target Size columns in the Log and Transfer window. Control-click a column heading in the Browse area of the Log and Transfer window, then choose the column heading you want from the shortcut menu. You can also see the total free disk space available to you in the bottom-right corner of the Transfer Queue area in the Log and Transfer window.

AVCHD Format Specifications
AVCHD is an HD video format that uses Advanced Video Coding (AVC) compression (also known as MPEG-4 part 10 or H.264).

Storage Medium
AVCHD camcorders record on a variety of file-based media, including 80 mm DVDs (also known as miniDVDs), hard disks, and flash memory (such as Secure Digital cards).

Video Standard
The AVCHD specification was jointly developed by Sony and Panasonic. AVCHD allows for HD recording (1080i, 1080p, and 720p) and SD recording (480i and 576i).

Aspect Ratio
AVCHD records HD video with an aspect ratio of 16:9. SD video can be recorded with either a 4:3 or 16:9 aspect ratio.
Frame Dimensions, Number of Lines, and Resolution
AVCHD supports three HD video resolutions:

- **1920 x 1080**: This format is sometimes called *Full HD* because it contains the full 1920 horizontal pixels of the 1080-line HD format.
- **1440 x 1080**: This is a horizontally subsampled image with 1080 lines.
- **1280 x 720**: This is a full-resolution 720p format.

SD NTSC- and PAL-compatible formats are also defined in the AVCHD specification:

- **720 x 480 at 60i**
- **720 x 576 at 50i**

*Important*: The SD AVCHD formats are not supported by Final Cut Pro.

Frame Rate
The specified AVCHD frame rates are:

- **NTSC-compatible frame rate**: 29.97 fps (1080i60, 720p60)
- **PAL-compatible frame rate**: 25 fps (1080i50, 720p50)
- **Film-compatible frame rate**: 23.98 fps (1080p24, 720p24)

Scanning Method
AVCHD can record either interlaced or progressive scan images:

- **1080 lines**: Interlaced (1080i) or progressive (1080p)
- **720 lines**: Progressive

Color Recording Method
The AVCHD color sample ratio is 4:2:0, with 8 bits per sample.

Data Rate
The amount of storage space required by AVCHD footage depends on the quality setting chosen on the camcorder. Most camcorders support several quality levels, although these quality levels have different names and bit rates on different camcorders. When variable bit rate (VBR) encoding is used, complex and rapidly changing video requires more data, shortening recording time. Therefore, stated variable bit rates are an average.

Sony Camcorder AVCHD Quality Levels
This table lists the bit rates for different quality-level settings on Sony AVCHD camcorders. Sony camcorders use variable bit rate (VBR) encoding at every quality level.

<table>
<thead>
<tr>
<th>Format name</th>
<th>Bit rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>XP (highest quality)</td>
<td>15 Mbps (VBR)</td>
</tr>
<tr>
<td>HQ (high quality)</td>
<td>9 Mbps (VBR)</td>
</tr>
<tr>
<td>SP (standard quality)</td>
<td>7 Mbps (VBR)</td>
</tr>
</tbody>
</table>
Panasonic Camcorder AVCHD Quality Levels
This table lists the bit rates for different quality-level settings on Panasonic AVCHD camcorders. Depending on the quality-level setting, Panasonic camcorders use either constant bit rate (CBR) or variable bit rate (VBR) encoding.

<table>
<thead>
<tr>
<th>Format name</th>
<th>Bit rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>LP (long play)</td>
<td>5 Mbps (VBR)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Format name</th>
<th>Bit rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>PH</td>
<td>21 Mbps (VBR)</td>
</tr>
<tr>
<td>HA</td>
<td>17 Mbps (VBR)</td>
</tr>
<tr>
<td>HF</td>
<td>13 Mbps (CBR)</td>
</tr>
<tr>
<td>HG</td>
<td>13 Mbps (VBR)</td>
</tr>
<tr>
<td>HN</td>
<td>9 Mbps (VBR)</td>
</tr>
<tr>
<td>HE</td>
<td>6 Mbps (VBR)</td>
</tr>
</tbody>
</table>

Audio
AVCHD audio can be recorded in 5.1-channel surround sound with Dolby Digital (AC-3) compression or up to 7.1-channel surround sound (uncompressed). Some cameras, such as the Panasonic HDC-SD5, use a two-channel built-in microphone.
About AVC-Intra
The Panasonic AVC-Intra format is a form of H.264 compression that uses only intraframe compression (I-frame-only compression) as opposed to the interframe (long-GOP) compression used by formats such as HDV and AVCHD. For more information about interframe and intraframe compression, see “About MPEG Compression.”

AVC-Intra is recorded on Panasonic P2 cards at either 100 or 50 Mbps. The 100 Mbps format can record full-width HD video (1920 x 1080 and 1280 x 720) with 4:2:2 color sampling. The 50 Mbps format records at 1440 x 1080 or 960 x 720 with 4:2:0 color sampling. Both formats record 10 bits per color sample.

Final Cut Studio includes its own optimized AVC-Intra decoder that allows media recorded in the Panasonic AVC-Intra format to be ingested natively (without transcoding) and played back with real-time effects in the Timeline. An Apple ProRes codec is the default sequence editing format because encoding to AVC-Intra is not supported. Alternatively, you can transcode AVC-Intra footage directly to an Apple ProRes codec during ingest.
AVC-Intra Formats Supported by Final Cut Pro

Final Cut Pro can ingest all AVC-Intra frame rates and image dimensions in both 50 and 100 Mbps formats. For details, see “AVC-Intra Format Specifications.”

**Important:** You cannot export footage back to the AVC-Intra format from Final Cut Pro because the AVC-Intra codec does not support encoding.

Working with AVC-Intra Footage

AVC-Intra footage can be transferred using the Log and Transfer window in Final Cut Pro. You can choose to transfer the native AVC-Intra media (creating QuickTime files), or you can transcode your footage to an Apple ProRes codec. After you have transferred your footage, you can edit the native media or the transcoded media using the appropriate Apple ProRes codec.

For more information about using the Log and Transfer window, see “Overview of Transferring File-Based Media” and “About the Log and Transfer Window” in the *Final Cut Pro 7 User Manual*.

Copying AVC-Intra Media Files to Your Computer

After shooting AVC-Intra footage, mount the P2 card containing the footage. For more information about Panasonic P2 cards, see “Working with Panasonic P2 Cards.” Download your files to the hard disk storage device that you will access with Final Cut Pro. Be sure to also archive copies of your AVC-Intra footage on a separate storage device for safekeeping.

When downloading your AVC-Intra media files, keep the following recommendations in mind:

- Copy the entire contents of the P2 card or hard disk to a folder or disk image. This enclosing folder or disk image must have a unique name. (This name will be the reel name in Final Cut Pro.) After you copy the media, do not change the directory names or filenames or otherwise modify the files that you've copied. Doing so may jeopardize your ability to later reconform offline sequences to the original source media.
- Do not nest folders of P2 content within each other.
- Do not place the contents of the P2 volume in your Capture Scratch folder.

Restrictions When Working with AVC-Intra

The following restrictions apply when working with AVC-Intra footage:

- AVC-Intra footage is supported on Intel-based Mac computers only.
- Full video preview of AVC-Intra footage requires an Intel-based Mac computer with two dual-core processors. An icon indicating limited preview playback appears when AVC-Intra footage cannot be played back at its full frame rate.
Native AVC-Intra Editing Workflow

You can ingest Panasonic AVC-Intra media natively using the Log and Transfer window (without transcoding) and edit with real-time effects in the Timeline.

Before ingesting the AVC-Intra files, you must configure the Log and Transfer window preferences. For more information, see “Stage 1: Choosing the P2 AVC-Intra Plug-in for Transfer.”

After ingesting your footage, you can create your sequence settings by dragging an AVC-Intra clip into a new, empty sequence. Final Cut Pro automatically conforms the sequence compression setting to the Apple ProRes 422 (HQ) codec, which is the appropriate rendering format for AVC-Intra footage. After you ingest your AVC-Intra footage and convert it to QuickTime files, you cannot render your footage back to native AVC-Intra footage because the AVC-Intra codec does not support encoding.

You edit the resulting AVC-Intra QuickTime files just as you would edit DV or uncompressed video. You should set your sequence settings to Unlimited RT to facilitate editing AVC-Intra footage.

The native AVC-Intra workflow follows the standard process for ingesting file-based media using the Log and Transfer window.

• Stage 1: Choosing the P2 AVC-Intra Plug-in for Transfer
• Stage 2: Transferring Native AVC-Intra Footage
• Stage 3: Editing AVC-Intra Video

Stage 1: Choosing the P2 AVC-Intra Plug-in for Transfer

To ingest the AVC-Intra files, you open the Log and Transfer window and choose the P2 AVC-Intra Log and Transfer plug-in.

To choose the P2 AVC-Intra Log and Transfer plug-in in the Log and Transfer window

1. Mount the volumes that contain your AVC-Intra media.
2. Open the Log and Transfer window, then choose Preferences from the Action pop-up menu (with a gear icon) in the upper-right corner of the Browse area.
3. In the Import Preferences dialog, select P2 AVC-Intra in the Source Format column.
4 Choose Native from the pop-up menu in the Target Format column corresponding to the P2 AVC-Intra item.

5 Click OK.

For more information about using the Log and Transfer window, see “Overview of Transferring File-Based Media” and “About the Log and Transfer Window” in the Final Cut Pro 7 User Manual.

Stage 2: Transferring Native AVC-Intra Footage

You can transfer AVC-Intra footage to your scratch disk using the Log and Transfer window in Final Cut Pro. For more information about using the Log and Transfer window, see “Overview of Transferring File-Based Media” and “About the Log and Transfer Window” in the Final Cut Pro 7 User Manual.

Important: Although it is possible to copy AVC-Intra files directly to your scratch disk, Final Cut Pro won’t recognize these files. You must use the Log and Transfer window to transfer the AVC-Intra footage.

Stage 3: Editing AVC-Intra Video

To edit AVC-Intra video, have Final Cut Pro automatically configure the sequence settings to the Apple ProRes 422 (HQ) codec and use Unlimited RT in the Timeline for maximum responsiveness.

To change a new sequence to support AVC-Intra media

1 If you haven’t already done so, ingest a native AVC-Intra media clip into a Final Cut Pro project. (See “Stage 2: Transferring Native AVC-Intra Footage.”)

2 Create a new sequence and open it.

3 Drag the AVC-Intra clip into the Timeline.

4 When the resulting dialog asks if you want to change the sequence settings to match the clip settings, click Yes.

   Final Cut Pro automatically configures the sequence to Apple ProRes 422 (HQ), the most appropriate setting.

Note: Do not change the compressor setting to AVC-Intra, because encoding functionality is not supported by the AVC-Intra codec.
Transcoded AVC-Intra Editing Workflow

When you ingest the AVC-Intra files for this workflow, you transcode the files to an Apple ProRes codec (or to DVCPRO HD). For the best-quality footage, use the Apple ProRes 422 (HQ) codec. However, if you’re doing an offline edit or producing an EDL, and footage quality for editing is not an issue, you can save disk space and bandwidth by editing with Apple ProRes 422 (LT) files or even Apple ProRes 422 (Proxy) files.

The transcoded footage results in self-contained QuickTime movies that you can edit in the Final Cut Pro Timeline.

Before ingesting the AVC-Intra files, you must specify an Apple ProRes codec as the destination codec in the Log and Transfer window preferences. For more information, see “Stage 2: Choosing an Apple ProRes Codec for Transcoding.”

The transcoded AVC-Intra workflow follows the standard steps of ingesting file-based media using the Log and Transfer window.

- Stage 1: Choosing an Apple ProRes Codec for Transcoding
- Stage 2: Transcoding Your AVC-Intra Footage
- Stage 3: Editing Video Using Transcoded AVC-Intra Footage

Stage 1: Choosing an Apple ProRes Codec for Transcoding

Decoding native AVC-Intra footage for playback requires a lot of processing power. To reduce the processing demands on your computer, you can use the Log and Transfer window to transcode your AVC-Intra footage to the less processor-intensive Apple ProRes format. Your sequence settings then change to the default Apple ProRes settings appropriate to the ingested footage.

To choose the destination codec for transcoded AVC-Intra footage

1. Mount the volumes that contain your AVC-Intra media.
2. Open the Log and Transfer window, then choose Preferences from the Action pop-up menu (with a gear icon) in the upper-right corner of the Browse area.
3. In the Import Preferences dialog, select P2 AVC-Intra in the Source Format column.
Choose an Apple ProRes codec or choose DVCPRO HD from the pop-up menu in the Target Format column corresponding to the P2 AVC-Intra item in the list, then click OK. The recommended codec for high-quality media transcoded from AVC-Intra footage is Apple ProRes 422 (HQ).

**Stage 2: Transcoding Your AVC-Intra Footage**
You transfer AVC-Intra footage to your scratch disk using the Log and Transfer window in Final Cut Pro. In this workflow, the AVC-Intra footage is transcoded as it is transferred. For more information about using the Log and Transfer window, see “Overview of Transferring File-Based Media” and “About the Log and Transfer Window” in the Final Cut Pro 7 User Manual.

*Important:* Although it is possible to copy AVC-Intra files directly to your scratch disk, Final Cut Pro won’t recognize these files. You must use the Log and Transfer window to transfer and transcoding AVC-Intra footage.

**Stage 3: Editing Video Using Transcoded AVC-Intra Footage**
Editing video transcoded to an Apple ProRes codec is the same as editing other formats in Final Cut Pro. However, you need to make sure your scratch disk supports the data rate.

For more information about the data rates of the Apple ProRes codecs, see “Working with Apple ProRes.”

After you have completed your edit in Final Cut Pro, you have a range of finishing and output options for your AVC-Intra project. For more information, see “Finishing and Outputting AVC-Intra Projects.”

**Finishing and Outputting AVC-Intra Projects**
After you’ve completed your edit in Final Cut Pro, you have a range of finishing and output options for your AVC-Intra project, including sending it to Color or Compressor or outputting it to videotape.

**Sending an AVC-Intra Project to Color**
You can send your AVC-Intra project to Color for grading and color correction. To ensure a successful color grading and correction phase of your project, you will want to follow certain guidelines and prepare your Final Cut Pro sequence ahead of time. For complete details, see the *Color User Manual.*

1. Select a sequence in the Browser or open a sequence in the Timeline.
2. Choose File > Send To > Color.
3 In the Send To Color dialog, enter a Color project name in the Color Project Name field, then click OK.

**Outputting an AVC-Intra Project to Tape and Other Formats**
After you finish editing, you can output your movie to videotape or export your sequence to Compressor. You can also use the Share feature to quickly create and deliver output media files in iPod, iPhone, Apple TV, MobileMe, DVD, Blu-ray Disc, YouTube, and Apple ProRes formats.

To output to tape, follow the standard procedures for using the Print to Video command. For more information, see the *Final Cut Pro 7 User Manual*.

**To export your sequence to Compressor**
1 Open your Final Cut Pro sequence in the Timeline.
2 Choose File > Send To > Compressor.

For more information about sending to Compressor, see the *Compressor User Manual*.

**To export a clip or sequence using Share**
1 In Final Cut Pro, select the clip or sequence you want to export.
2 Choose File > Share.

The Share window appears.

For more information about using the Share feature, see “Using Share” in the *Final Cut Pro 7 User Manual*.


**AVC-Intra Format Specifications**
AVC-Intra is an HD video format that uses Advanced Video Coding (AVC) compression, just as with AVCHD. However, AVC-Intra uses only intraframe compression (I-frame-only compression) as opposed to the interframe (long-GOP) compression used by AVCHD. AVC-Intra can also record higher-quality color using 10-bit, 4:2:2 color sampling.

**Storage Medium**
AVC-Intra is recorded on Panasonic P2 cards. As with other formats recorded on Panasonic P2 cards, AVC-Intra is stored in MXF container files. For more information, see “Panasonic P2 Card Format Specifications.”

**Video Standard**
The AVC-Intra specification supports 1080i, 1080p, and 720p HD recording standards.
Aspect Ratio

Frame Dimensions, Number of Lines, and Resolution
AVC-Intra supports the following HD resolutions:

- **1920 x 1080**: This format is sometimes called Full HD because it contains the full 1920 horizontal pixels of the 1080-line HD format.
- **1440 x 1080**: This is a horizontally subsampled image with 1080 lines.
- **1280 x 720**: This is a full-resolution 720p format.
- **960 x 720**: This is a horizontally subsampled image with 720 lines.

Frame Rate
The specified AVC-Intra frame rates are:

- **NTSC-compatible frame rate**: 29.97 fps (1080i60, 1080p30, 720p60, 720p30)
- **PAL-compatible frame rate**: 25 fps (1080i50, 1080p25, 720p50, 720p25)
- **Film-compatible frame rate**: 23.98 fps (1080p24, 720p24)

Scanning Method
AVC-Intra can record either interlaced or progressive scan images:

- **1080 lines**: Interlaced (1080i) or progressive (1080p)
- **720 lines**: Progressive

Color Recording Method
The 100 Mbps AVC-Intra color sample ratio is 4:2:2, with 10 bits per sample. The 50 Mbps AVC-Intra color sample ratio is 4:2:0, with 10 bits per sample.

Data Rate
AVC-Intra can be recorded at either 100 or 50 Mbps. Lower frame rates reduce the storage space used by your footage.

<table>
<thead>
<tr>
<th>Data rate</th>
<th>Frame dimensions</th>
<th>Color sample ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>50 Mbps</td>
<td>1440 x 1080, 960 x 720</td>
<td>4:2:0 with 10 bits per sample</td>
</tr>
<tr>
<td>100 Mbps</td>
<td>1920 x 1080, 1280 x 720</td>
<td>4:2:2 with 10 bits per sample</td>
</tr>
</tbody>
</table>

Audio
AVC-Intra camcorders provide four-channel uncompressed audio recording.
Working with Sony XDCAM Formats

This chapter covers the following:

- About XDCAM, XDCAM HD, and XDCAM EX (p. 93)
- Working Natively with Sony XDCAM Formats in Final Cut Pro (p. 96)
- XDCAM, XDCAM HD, and XDCAM EX Format Specifications (p. 101)

Final Cut Pro allows you to natively transfer and edit XDCAM, XDCAM HD, and XDCAM EX formats.

About XDCAM, XDCAM HD, and XDCAM EX

The XDCAM format records SD DVCAM or IMX video on Sony Professional Disc media. Up to four 16-bit, 48 kHz uncompressed audio channels can be recorded. MPEG-4 proxy files are simultaneously recorded for quick review of footage and even proxy editing directly on the camcorder. Media is stored within MXF container files for easy transfer to your computer via FireWire or optional Ethernet connectors.

XDCAM HD extends XDCAM to include four 1080-line HD video formats using long-GOP MPEG-2 compression (referred to by Sony as MPEG HD). Also supported is an HD422 format that includes 1920 x 1080 and 1280 x 720 frame dimensions.

<table>
<thead>
<tr>
<th>Format</th>
<th>MPEG-2 bit rate</th>
<th>Frame dimensions</th>
<th>Color sample ratio</th>
<th>MPEG-2 standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>LP</td>
<td>18 Mbps (VBR)</td>
<td>1440 x 1080</td>
<td>4:2:0</td>
<td>MPEG MP@HL</td>
</tr>
<tr>
<td>SP (HDV)</td>
<td>25 Mbps (CBR)</td>
<td>1440 x 1080</td>
<td>4:2:0</td>
<td>MPEG MP@HL-1440</td>
</tr>
<tr>
<td>HQ</td>
<td>35 Mbps (VBR)</td>
<td>1440 x 1080</td>
<td>4:2:0</td>
<td>MPEG MP@HL</td>
</tr>
<tr>
<td>HD422</td>
<td>50 Mbps (CBR)</td>
<td>1920 x 1080, 1280 x 720</td>
<td>4:2:2</td>
<td>MPEG 422P@HL</td>
</tr>
</tbody>
</table>
The SP format uses a constant bit rate (CBR) and is compatible with 1080i HDV. The LP and HQ formats use a variable bit rate (VBR) and provide extended recording time with lower-than-HDV quality (LP) and quality that surpasses that of the HDV recording format (HQ). Variable frame rate recording is also supported. The HD422 format uses 50 Mbps CBR.

XDCAM EX is a variation of XDCAM HD that records full HD resolution as either 1920 x 1080 or 1280 x 720 footage. XDCAM EX footage is recorded on SxS cards, based on the PCMCIA ExpressCard/34 form factor.

**XDCAM Formats Supported in Final Cut Pro**

To edit XDCAM footage, choose the DVCAM or IMX Easy Setup that corresponds to your footage.

**XDCAM HD Formats Supported in Final Cut Pro**

Final Cut Pro has Easy Setups for the following XDCAM HD formats.

The installation of the Sony XDCAM Transfer software and an XDCAM plug-in is required. For more information about this software, go to the Sony website at http://www.sony.com/xdcam.

**XDCAM HD VBR Easy Setups**

The following XDCAM HD VBR Easy Setups support both 35 Mbps (HQ) and 18 Mbps (LP) formats:

- XDCAM HD 1080p24 VBR
- XDCAM HD 1080p25 VBR
- XDCAM HD 1080p30 VBR
- XDCAM HD 1080i60 VBR
- XDCAM HD 1080i50 VBR

*Note:* 18 Mbps VBR XDCAM HD footage is edited, rendered, and exported using the 35 Mbps (HQ) codec. However, this format is ingested at a data rate of 18 Mbps, so it still requires less disk space during ingest than the 35 Mbps (HQ) format.

**XDCAM HD CBR Easy Setups**

Final Cut Pro includes the following XDCAM HD CBR (25 Mbps) Easy Setups:

- XDCAM HD 1080p24 CBR
- XDCAM HD 1080p25 CBR
- XDCAM HD 1080p30 CBR
- XDCAM HD 1080i50 CBR
- XDCAM HD 1080i60 CBR
**XDCAM HD422 CBR Easy Setups**

Final Cut Pro includes support for the Sony XDCAM HD422 format,

Final Cut Pro includes the following XDCAM HD422 CBR (50 Mbps) Easy Setups:

- XDCAM HD422 1080p24 CBR
- XDCAM HD422 1080p25 CBR
- XDCAM HD422 1080p30 CBR
- XDCAM HD422 1080i50 CBR
- XDCAM HD422 1080i60 CBR

Final Cut Pro also includes the following 720-line XDCAM HD422 (50 Mbps) Easy Setups:

- XDCAM HD422 720p50 CBR
- XDCAM HD422 720p60 CBR

**XDCAM EX Formats Supported in Final Cut Pro**

Final Cut Pro includes support for the Sony XDCAM EX format, but ingesting XDCAM EX footage requires the installation of the Sony XDCAM Transfer software. Ingesting footage using the Log and Transfer window also requires the installation of an XDCAM EX plug-in. For more information about this software, go to the Sony website at [http://www.sony.com/xdcam](http://www.sony.com/xdcam).

Final Cut Pro includes the following 1080-line XDCAM EX Easy Setups:

- XDCAM EX 1080p24 VBR
- XDCAM EX 1080p25 VBR
- XDCAM EX 1080p30 VBR
- XDCAM EX 1080i50 VBR
- XDCAM EX 1080i60 VBR

Final Cut Pro also includes the following 720-line XDCAM EX Easy Setups:

- XDCAM EX 720p24 VBR
- XDCAM EX 720p25 VBR
- XDCAM EX 720p30 VBR
- XDCAM EX 720p50 VBR
- XDCAM EX 720p60 VBR
Working Natively with Sony XDCAM Formats in Final Cut Pro

Final Cut Pro can ingest and export XDCAM, XDCAM HD, and XDCAM EX using third-party Sony XDCAM Transfer software. Editing XDCAM requires a DV or IMX Easy Setup, and editing XDCAM HD or XDCAM EX requires an Easy Setup corresponding to your format.

The following sections describe the workflow for editing XDCAM, XDCAM HD, and XDCAM EX natively in Final Cut Pro.

- Stage 1: Installing Sony XDCAM Transfer Software
- Stage 2: Connecting an XDCAM Device to Your Computer
- Stage 3: Ingesting XDCAM Media
- Stage 4: Choosing an Easy Setup
- Stage 5: Choosing a Render File Format for XDCAM HD or XDCAM EX Sequences
- Stage 6: Editing XDCAM Media Natively
- Stage 7: Rendering and Conforming XDCAM HD and XDCAM EX Footage
- Stage 8: Outputting to XDCAM Media and Other Formats

Stage 1: Installing Sony XDCAM Transfer Software

Final Cut Pro requires Sony software to mount XDCAM devices, ingest media from them, and export Final Cut Pro sequences back to MXF-wrapped footage. You can download the XDCAM Transfer (PDZK-P1) software from the Sony website at http://pro.sony.com/bbsc/ssr/micro-xdcam.

Complete instructions for using the Sony XDCAM Transfer software and the corresponding XDCAM import and export plug-ins are included with the software.

Stage 2: Connecting an XDCAM Device to Your Computer

Before ingesting your XDCAM footage, you must connect an XDCAM or XDCAM HD deck or an XDCAM EX camcorder or SxS card device to your computer. The instructions in this section use the Sony PDW-1500 XDCAM deck and the Sony PDW-F70 XDCAM HD deck as examples.
To mount XDCAM or XDCAM HD media on your computer desktop
1 Install a Sony XDCAM File Access Mode (FAM) driver. This driver is installed with the Sony XDCAM Transfer software. For more information, see “Stage 1: Installing Sony XDCAM Transfer Software.”
2 Connect the deck to your computer with a FireWire or USB cable.
3 Enable PC Remote mode on the deck.
   To select the PC Remote mode on a Sony PDW-1500 XDCAM deck, the Extended Menu option must be enabled.

To enable the Extended Menu option on a Sony PDW-1500 XDCAM deck
1 On the Sony PDW-1500 deck, press the System Menu button.
2 Press the Counter Select and Set buttons simultaneously.
3 Press the Down button until SETUP MAINTENANCE is selected, then press the Right button to open the menu.
4 Press the Right button to open the EXTENDED MENU menu.
5 Press the Right button, then press the Down button to select ENABLE.
6 Press the Set button to save your settings.

After the Extended Menu option is enabled, you can enable the PC Remote mode.

To enable the PC Remote mode on a Sony PDW-1500 XDCAM deck
1 Make sure the Extended Menu option is enabled on the deck by following the steps above.
2 Disconnect the FireWire cable between the deck and your computer.
3 Press the System Menu button.
4 Rotate the jog dial until i.LINK MODE (menu 21 5) is selected.
5 Hold down the Shuttle button to display the i.LINK MODE options.
6 While holding down the Shuttle button, rotate the jog dial until FAM (PC REMOTE) is selected, then release the Shuttle button.
7 Press the Set button to save your settings.
8 Connect the deck to your computer with a FireWire cable.
   The disk appears mounted on your computer desktop.
   You can also enable remote device control on a Sony PDW-F70 XDCAM HD deck and then connect it to transfer XDCAM HD footage.

To enable remote device control on a Sony PDW-F70 XDCAM HD deck
1 Disconnect the FireWire cable between the deck and your computer.
2 On the deck, press the Menu button.
3 With SETUP MENU selected, press the Right button to display the SETUP MENU options.
4 Press the Down button until INTERFACE SELECT is selected, then press the Right button
to display the INTERFACE SELECT options.
5 Press the Up or Down button until FAM (PC REMOTE) is selected.
6 Press the Set button to save your settings.
7 When the deck asks you to confirm your settings, press the Set button.
8 Connect the deck to your computer with a FireWire cable.

The disk appears mounted on your computer desktop.

Mounting XDCAM EX media on your computer desktop requires fewer steps.

To mount XDCAM EX media on your computer desktop
Do one of the following:
- Connect the camcorder to your computer with a USB cable.
- Insert an SxS card directly into the ExpressCard/34 PCMCIA slot in a MacBook Pro computer.

When connecting an XDCAM EX camcorder to your computer, you must set the camcorder
to target device mode. See the manual that came with your camcorder for instructions.

Stage 3: Ingesting XDCAM Media
Use the Sony XDCAM Transfer (PDZK-P1) software and import plug-in to ingest XDCAM,
XDCAM HD, or XDCAM EX media from MXF-wrapped or MPEG-4-wrapped media to
QuickTime-wrapped media on your scratch disk. For more information, see “Stage 1:
Installing Sony XDCAM Transfer Software.”

Important: Although it is possible to copy MXF or MPEG-4 media directly to your scratch
disk, Final Cut Pro won’t recognize the MXF files. Use the Sony XDCAM Transfer software
instead.

Stage 4: Choosing an Easy Setup
To edit DVCAM or IMX footage ingested from an XDCAM device, simply choose a
_corresponding DV or IMX Easy Setup and begin editing. For more information about IMX,
see “Working with IMX.”

To edit XDCAM HD or XDCAM EX footage, you must first ingest your XDCAM HD or XDCAM
EX footage to QuickTime media files on your scratch disk. Then you can simply choose
the XDCAM HD or XDCAM EX Easy Setup that corresponds to your footage and edit as
you would with any other native format in Final Cut Pro.
**Note:** Final Cut Pro renders and exports LP (18 Mbps VBR) XDCAM HD footage using the 35 Mbps (HQ) codec, so you cannot export back to the 18 Mbps VBR LP format. However, 18 Mbps VBR LP XDCAM HD footage is ingested at a data rate of 18 Mbps, so it still requires less disk space during ingest than the 35 Mbps format.

Final Cut Pro also includes support for real-time playback of XDCAM HD variable frame rate footage.

**Stage 5: Choosing a Render File Format for XDCAM HD or XDCAM EX Sequences**

When you create an XDCAM HD or XDCAM EX sequence, you can choose to create render files using either the native MPEG-2 codec of your sequence or an Apple ProRes codec.

Rendering native MPEG-2 creates small render files that conserve disk space, but rendering takes longer than for other formats because of the interframe compression this format uses.

If native rendering is slowing down the pace of your editing, you can choose to render segments of your native XDCAM HD or XDCAM EX sequences using an Apple ProRes codec. Because Final Cut Pro supports mixed-format sequences, you can play back the entire sequence, including the Apple ProRes codec files, in real time. In this slight variation of the native Sony XDCAM editing workflow, you continue to edit using a native sequence, but any render files will be in an Apple ProRes codec.

The advantages to using an Apple ProRes codec as the rendering codec are:
- Apple ProRes codecs use I-frame–only (intraframe) encoding, providing faster rendering and real-time playback performance.
- Apple ProRes codecs have a generous color sample ratio and bit depth, allowing for higher-quality rendering of visual effects.

The advantages to rendering natively are:
- Conforming for export or output to XDCAM HD or XDCAM EX formats happens faster because the render files are already in the necessary format. If you aren’t outputting to XDCAM HD or XDCAM EX formats, this may not be an advantage.
- Native XDCAM HD or XDCAM EX render files are smaller than those generated by other HD I-frame-only codecs.
To choose the render file format in an XDCAM HD or XDCAM EX sequence

1. Select your sequence in the Browser or Timeline.
2. Choose Sequence > Settings, then click the Render Control tab.
3. From the Codec pop-up menu, choose one of the following options:
   • *Same as Sequence Codec:* This option enables rendering with the native MPEG-2 codec of your sequence.
   • *Apple ProRes 422 Codec:* This option enables rendering with the Apple ProRes 422 codec.

*Note:* Because HDV, XDCAM HD, and XDCAM EX constant bit rate (CBR) footage use an identical format, the information in this section also applies when rendering HDV footage. For more information, see “Stage 4: Choosing a Render File Format for HDV Sequences” in “Native HDV Editing Workflow.”

**Stage 6: Editing XDCAM Media Natively**

For the most part, editing native XDCAM HD or XDCAM EX footage is identical to editing any other format in Final Cut Pro. However, because of the GOP structure of MPEG-2 media, edits in XDCAM HD and XDCAM EX sequences require some additional processing during playback and output. The additional processing happens automatically, but it is a good idea to understand why it is necessary.

When you edit two XDCAM HD or XDCAM EX clips together in a sequence, the GOP pattern is typically broken. In particular, cutting an XDCAM HD or XDCAM EX clip can remove the I-frame that subsequent P- and B-frames rely on for picture information. When this happens, Final Cut Pro must preserve the I-frame for these other frames to refer to, even though the I-frame is no longer displayed in the sequence. Final Cut Pro reconforms the broken GOPs in the vicinity of the edit and leaves the subsequent GOPs unchanged.

This requires additional processing power and memory not necessary for I-frame-only editing (such as DV editing). During playback, this process happens in real time. For output and export, Final Cut Pro reencodes (or conforms) the areas of your sequence that require new I-frames or GOPs.

To save time during rendering and editing, you can set up your native XDCAM HD or XDCAM EX sequence to render using an Apple ProRes codec. Using an Apple ProRes codec also produces high-quality 4:2:2 render files that, in some cases, may be higher quality than rendering back to native XDCAM HD or XDCAM EX. For more information, see “Stage 5: Choosing a Render File Format for XDCAM HD or XDCAM EX Sequences.”

**Stage 7: Rendering and Conforming XDCAM HD and XDCAM EX Footage**

After editing XDCAM HD or XDCAM EX footage, you need to render and conform it.

For details, see “Stage 6: Rendering and Conforming Long-GOP MPEG-2 Media.”
Stage 8: Outputting to XDCAM Media and Other Formats

If you want to export a finished sequence or clip from Final Cut Pro back to an MXF file containing XDCAM or XDCAM HD footage, or an MP4 file containing XDCAM EX footage, you need to use the XDCAM export plug-in included with the Sony XDCAM Transfer (PDZK-P1) software. For more information, see “Stage 1: Installing Sony XDCAM Transfer Software” and “Stage 2: Connecting an XDCAM Device to Your Computer.”

Note: Exported XDCAM sequences must have four mono audio outputs assigned, regardless of how many tracks the sequence contains.

Optionally, you can export your sequence as a QuickTime movie, export your sequence to Compressor, or send your sequence to Color for finishing. You can also use the Share feature to quickly create and deliver output media files in iPod, iPhone, Apple TV, MobileMe, DVD, Blu-ray Disc, YouTube, and Apple ProRes formats.


To assign four mono audio outputs to your sequence
1 Choose Sequence > Settings, then click the Audio Outputs tab.
2 Choose 4 from the Outputs pop-up menu.
3 Select the Dual Mono option for both audio output groups.

XDCAM, XDCAM HD, and XDCAM EX Format Specifications

XDCAM (SD) records MXF file-based media to an optical disc format. XDCAM HD extends XDCAM to include HD video. XDCAM EX adds full-resolution 1920 x 1080 or 1280 x 720 modes and ExpressCard-based recording.

Storage Medium

XDCAM and XDCAM HD use a 120 mm disc—like CD and DVD discs—that can record 23.3 GB of media by using a 405 nm blue-violet laser. Although the Sony Professional Disc uses a blue-violet laser, it is not compatible with Blu-ray Disc technology. The Sony Professional Disc supports a transfer speed of 72 Mbps (or 144 Mbps with dual heads), whereas a consumer Blu-ray disc has a maximum rate of 36 Mbps.

XDCAM EX records to Sony SxS solid-state ExpressCard/34 media.
XDCAM and XDCAM HD video and audio content is stored on disc within MXF container files, and XDCAM EX video and audio content is stored on disc within MP4 container files. Much like QuickTime movie files, MXF and MP4 files can store video and audio data in almost any frame rate and codec, as well as metadata about the content, such as the date of recording, GPS positioning data, and so on.

**Video Standard**

XDCAM supports NTSC and PAL using either the DVCAM or IMX format:

- **DVCAM**: 25 Mbps DV
- **MPEG IMX**: 30, 40, or 50 Mbps MPEG-2 (I-frame-only)

XDCAM camcorders can also record low-resolution MPEG-4 proxy files (1.5 Mbps) for quick previewing before ingesting into your editing system. Proxy file dimensions are 352 x 240 (NTSC) or 352 x 288 (PAL), adhering to the Common Intermediate Format (CIF) standard. 500 MB of disc space is reserved for storing general-purpose files such as text files, EDLs, project files, graphics, and so on.

XDCAM HD can record 1080-line HD video using MPEG-2 compression at four quality levels.

<table>
<thead>
<tr>
<th>Format</th>
<th>MPEG-2 bit rate</th>
<th>Frame dimensions</th>
<th>Color sample ratio</th>
<th>MPEG-2 standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>LP</td>
<td>18 Mbps (VBR)</td>
<td>1440 x 1080</td>
<td>4:2:0</td>
<td>MPEG MP@HL</td>
</tr>
<tr>
<td>SP (HDV)</td>
<td>25 Mbps (CBR)</td>
<td>1440 x 1080</td>
<td>4:2:0</td>
<td>MPEG MP@HL-1440</td>
</tr>
<tr>
<td>HQ</td>
<td>35 Mbps (VBR)</td>
<td>1440 x 1080</td>
<td>4:2:0</td>
<td>MPEG MP@HL</td>
</tr>
<tr>
<td>HD422</td>
<td>50 Mbps (CBR)</td>
<td>1920 x 1080, 1280 x 720</td>
<td>4:2:2</td>
<td>MPEG 422P@HL</td>
</tr>
</tbody>
</table>

The SP format uses a constant bit rate (CBR) and is compatible with 1080i HDV. The LP and HQ formats use variable bit rates (VBR) and provide extended recording time with lower-than-HDV quality (LP) and quality that surpasses that of the HDV recording format (HQ). The HD422 format uses 50 Mbps CBR.

XDCAM EX can record footage at two quality levels.

<table>
<thead>
<tr>
<th>Format</th>
<th>MPEG-2 bit rate</th>
<th>Frame dimensions</th>
<th>Color sample ratio</th>
<th>MPEG-2 standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>SP (HDV)</td>
<td>25 Mbps (CBR)</td>
<td>1440 x 1080</td>
<td>4:2:0</td>
<td>MPEG MP@HL-1440</td>
</tr>
<tr>
<td>HQ</td>
<td>35 Mbps (VBR)</td>
<td>1920 x 1080, 1280 x 720</td>
<td>4:2:0</td>
<td>MPEG MP@HL</td>
</tr>
</tbody>
</table>
Aspect Ratio
XDCAM records 4:3 SD video. XDCAM HD and XDCAM EX record 16:9 HD video.

Frame Dimensions, Number of Lines, and Resolution
XDCAM records DV and IMX video. For more information about these formats, see “IMX Format Specifications,” as well as “Appendix A: Video Formats” in the Final Cut Pro 7 User Manual.

XDCAM HD records 1440 pixels per line and 1080 lines per frame.

XDCAM EX can record either 1920 pixels per line and 1080 lines per frame, or 1280 pixels per line and 720 lines per frame.

XDCAM HD422 can record either 1920 pixels per line and 1080 lines per frame, or 1280 pixels per line and 720 lines per frame.

Note: Variable frame rate (VFR) recording above 30 fps records 540 lines per frame.

Frame Rate
XDCAM supports 25 and 29.97 fps.

XDCAM HD and XDCAM EX support the following formats and frame rates:
• 1080i60, 1080p30
• 1080i50, 1080p25
• 1080p24

XDCAM EX also supports the 720p format at 23.98, 25, 29.97, 50, and 59.94 fps.

XDCAM HD422 supports the 720p format at 50 and 59.94 fps.

A VFR shooting mode is also available on certain XDCAM HD camcorders. You choose a playback frame rate (24p or 30p) and a recording frame rate (from 4 to 60 fps in single increments). Because no duplicate frames are recorded, you can immediately see the results of your VFR footage in-camera without special processing. For example, if you shoot at 60 fps with a playback speed of 24 fps, the resulting video appears to be 40 percent slower than real time.

Note: XDCAM HD records variable frame rates above 30 fps (“overcranking”) by halving the vertical resolution to 540 lines per frame. However, once you capture your footage in Final Cut Pro, its frame dimensions appear as you expect at 1440 x 1080 pixels.

Scanning Method
XDCAM supports interlaced scanning. XDCAM HD and XDCAM EX support both progressive and interlaced scanning, depending on the HD format you are using.
This chapter covers the following:

- About Sony Video Disk Units (p. 105)
- Importing Media from a Sony Video Disk Unit (p. 105)

You can use the Log and Transfer window to view footage recorded on a Sony Video Disk Unit and transfer the footage to your scratch disk.

About Sony Video Disk Units
Final Cut Pro allows you to import video and audio recorded on a Sony Video Disk Unit (VDU), and then edit the resulting media files just as you would edit media files in any other format.

The Sony DSR-DU1 Video Disk Unit is an attachable FireWire disk recorder that uses a 40 GB hard disk drive as its recording media. The drive connects to professional-quality DVCAM camcorders via FireWire and is capable of recording up to 3 hours of video and audio signals in parallel with tape recording.

The Sony Video Disk Unit supports recording, playback, and file transfer via FireWire. You can record video directly onto the drive and then use it as a read-only FireWire drive to import the video and audio contents to your computer.

Importing Media from a Sony Video Disk Unit
To import media from a Sony Video Disk Unit, you need to connect it to your computer via FireWire and then select which media files you want to import using the Log and Transfer window in Final Cut Pro.

Setting Up a Sony Video Disk Unit
Connecting and using a Sony Video Disk Unit is very similar to using an external FireWire hard disk drive.
To connect a Sony Video Disk Unit to your computer

1. Connect the 4-pin connector on one end of your FireWire cable to the 4-pin FireWire port on the Sony Video Disk Unit.

2. Connect the 6-pin connector on the other end of your FireWire cable to a FireWire 400 port on your computer.

3. Turn on the Sony Video Disk Unit.

![](image)

A FireWire hard drive icon named Untitled appears on the desktop.

As with any other external FireWire drive, remember to unmount the Sony Video Disk Unit before disconnecting it or turning it off.

To unmount a FireWire hard drive from the desktop

- Drag the FireWire hard drive icon to the Eject icon in the Dock.

Importing DV Media from a Sony Video Disk Unit

The Log and Transfer window allows you to browse and ingest media files directly from a Sony Video Disk Unit. Transferring footage from a Sony Video Disk Unit is nearly identical to transferring footage from other file-based media devices. Simply mount your Sony Video Disk Unit and then follow the steps in the “Overview of Transferring File-Based Media” chapter in the *Final Cut Pro 7 User Manual*.

To transfer media from a Sony Video Disk Unit

1. Make sure that the Sony Video Disk Unit is connected and mounted on the desktop.

2. Choose Final Cut Pro > System Settings, then click the Scratch Disks tab.

3. Select a scratch disk or folder to which you want to transfer your media.

   For more information about selecting scratch disks, see “Connecting DV Video Equipment” in the *Final Cut Pro 7 User Manual*.

4. Choose File > Log and Transfer.

5. Use the Log and Transfer window to transfer footage from the Sony Video Disk Unit.

   For more information about using the Log and Transfer window, see “Overview of Transferring File-Based Media” and “About the Log and Transfer Window” in the *Final Cut Pro 7 User Manual*. 

---

Chapter 9  Working with Sony Video Disk Units
Important: Do not attempt to copy media files from a mounted Sony Video Disk Unit directly to your scratch disk. Media files copied directly from a Sony Video Disk Unit in this way are not QuickTime media files, and they will not be handled properly if you import them into Final Cut Pro.
This chapter covers the following:

- About the Apple ProRes Codecs (p. 109)
- Types of Apple ProRes Codecs (p. 111)
- Working with Apple ProRes Codecs (p. 112)
- Apple ProRes Format Specifications (p. 115)
- Apple ProRes Tips (p. 117)
- About the Apple Intermediate Codec (p. 118)

Apple ProRes is a post-production format designed for pristine quality, economical hardware configurations, and high-performance, multistream Final Cut Pro real-time editing—for film, digital cinema, high definition (HD), and standard definition (SD) workflows.

**About the Apple ProRes Codecs**

The Apple ProRes codecs provide an excellent solution for the most demanding modern post-production workflows. Many of today’s HD formats were developed under significant camcorder engineering constraints and therefore limit the full quality that can be carried in an HD signal. Other camera codecs preserve full quality but are too complex to achieve the software decoding speeds required for real-time editing. Uncompressed HD formats deliver the highest image quality, but the high-bandwidth, RAID-storage requirements of uncompressed HD video are daunting for most users’ budgets.

The Apple ProRes codecs maintain the highest quality and performance while requiring much less expensive editing and storage hardware (compared to uncompressed video). The Apple ProRes codecs produce video that is indistinguishable from uncompressed HD video and needs less storage space than uncompressed SD video.
The Apple ProRes codecs were designed for great software flexibility and performance. No extra hardware is required for encoding or decoding. In particular, the Apple ProRes codecs have been designed to take advantage of multicore processors. The performance of Apple ProRes codecs scales—which means that the decoding time per frame goes down—as the number of processors increases. When the system spends less time decoding each frame, it has time for more real-time effects processing.

The Apple ProRes family of codecs provides these advantages:

- **Quality indistinguishable from that of the most pristine sources:** Maintains superb quality even after multiple encoding/decoding generations.

- **Mastering-quality 4:4:4:4 RGBA:** Provides a lossless alpha channel with real-time playback (Apple ProRes 4444 only). Mastering-quality 4:4:4 Y’C₈C₇R color and 4:2:2 Y’C₈C₇R color are also available.

- **The quality of uncompressed HD at data and storage rates lower than those of uncompressed SD:** Provides real-time editing performance comparable to or better than that of any other HD codecs in Final Cut Pro.

- **Apple ProRes encoding at any frame size—SD, HD, 2K, 4K, or other:** Apple ProRes codecs can also be encoded into nonstandard frame sizes, but nonstandard frame sizes are not supported for real-time playback in Final Cut Pro.

- **Variable bit rate (VBR) encoding:** “Smart” encoding analyzes the image. Efficiency is increased because excess bits are not wasted on simple frames.

- **10-bit sample depth:** Preserves subtle gradients of 10-bit sources (sunsets, graphics, and the like) with no visible banding artifacts. When you import a file using an Apple ProRes codec, you don’t have to first determine whether the file is an 8-bit or 10-bit file. Apple ProRes codecs always preserve the bit depth of your original source files.

- **I-frame–only (intraframe) encoding:** Ensures consistent quality in every frame, with no artifacts from complex motion, and speeds up editing.

- **Fast encoding and decoding:** Delivers high-quality, real-time playback and faster rendering times.

- **Equipment affordability:** Because of low bit rates, you can edit more streams with more real-time effects on slower drives, or have more users accessing the same media over shared storage devices.

- **Workflow options for any video format that does not have native Final Cut Pro support:** The Apple ProRes format provides an effective workflow for projects involving multiple acquisition formats when you want to standardize on a single codec.

- **Better rendering for native editing:** Can be used to render long-GOP MPEG-2 formats (such as HDV and XDCAM HD) to speed up editing and avoid MPEG-2 reencoding artifacts before output.
Types of Apple ProRes Codecs
The Apple ProRes format comes in five versions: Apple ProRes 4444, Apple ProRes 422 (HQ), Apple ProRes 422, Apple ProRes 422 (LT), and Apple ProRes 422 (Proxy). The following list describes the features of each version. For a complete comparison of the relative data rates of the Apple ProRes codecs, see “Apple ProRes Format Specifications.”

Apple ProRes 4444
The Apple ProRes 4444 codec offers the utmost possible quality for 4:4:4 sources and for workflows involving alpha channels. It includes the following features:

- Full-resolution, mastering-quality 4:4:4:4 RGBA color (an online-quality codec for editing and finishing 4:4:4 material, such as that originating from Sony HDCAM SR or digital cinema cameras such as RED ONE, Thomson Viper FilmStream, and Panavision Genesis cameras). The R, G, and B channels are lightly compressed, with an emphasis on being perceptually indistinguishable from the original material.
- Lossless alpha channel with real-time playback
- High-quality solution for storing and exchanging motion graphics and composites
- For 4:4:4 sources, a data rate that is roughly 50 percent higher than the data rate of Apple ProRes 422 (HQ)
- Direct encoding of, and decoding to, RGB pixel formats
- Support for any resolution, including SD, HD, 2K, 4K, and other resolutions
- A Gamma Correction setting in the codec’s advanced compression settings pane, which allows you to disable the 1.8 to 2.2 gamma adjustment that can occur if RGB material at 2.2 gamma is misinterpreted as 1.8. This setting is also available with the Apple ProRes 422 codec.

Apple ProRes 422 (HQ)
The Apple ProRes 422 (HQ) codec offers the utmost possible quality for 4:2:2 or 4:2:0 sources (without an alpha channel) and provides the following:

- Target data rate of approximately 220 Mbps (1920 x 1080 at 60i)
- Higher quality than Apple ProRes 422

Apple ProRes 422
The Apple ProRes 422 codec provides the following:

- Target data rate of approximately 145 Mbps (1920 x 1080 at 60i)
- Higher quality than Apple ProRes 422 (LT)

Apple ProRes 422 (LT)
The Apple ProRes 422 (LT) codec provides the following:

- Roughly 70 percent of the data rate of Apple ProRes 422 (thus, smaller file sizes than Apple ProRes 422)
• Higher quality than Apple ProRes 422 (Proxy)

**Apple ProRes 422 (Proxy)**
The Apple ProRes 422 (Proxy) codec is intended for use in offline workflows and provides the following:

• Roughly 30 percent of the data rate of Apple ProRes 422
• High-quality offline editing at the original frame size, frame rate, and aspect ratio
• High-quality edit proxy for Final Cut Server

**Working with Apple ProRes Codecs**
Apple ProRes is an extremely flexible post-production format. The post-production possibilities with Apple ProRes range from offline editing on a MacBook Pro to advanced “digital negative” workflows for theatrical releases on film.

**Maximizing Performance by Adjusting Real-Time Playback Quality**
After you have captured to an Apple ProRes codec or transcoded from another format to an Apple ProRes codec, you can take advantage of the exceptional real-time playback performance of Apple ProRes files. With RT Extreme, you can set a project’s sequence for real-time playback at different levels of video quality.

At high-quality, real-time playback settings, Final Cut Pro displays video and effects at full resolution. Medium-quality playback shows video at half its full dimensions, to reserve processor power for more video streams and effects. The Apple ProRes format has been engineered not only for excellent decoding speed at full-resolution playback, but moreover to provide exceptionally fast speed at half resolution. This latter mode provides tremendous value for practical editing productivity.

**To adjust real-time video playback quality to medium quality**
1 Make sure a sequence is open in the Timeline.
2 In the RT pop-up menu, choose Medium in the Playback Video Quality section.

*Note: Additionally, if you are working with native file formats with very large frame sizes, choose Unlimited RT from the RT pop-up menu. For more information, see the *Final Cut Pro 7 User Manual*.*

**Sample Apple ProRes Workflows**
The following sections provide examples of workflows that use Apple ProRes codecs at their core.
Mastering REDCODE Projects
After final grading in Color, you can render to the Apple ProRes 4444 codec and send the project back to Final Cut Pro for conforming and output. REDCODE is a 12-bit, 4:4:4, full-color format. By grading the native R3D files with float processing and then rendering to a 4:4:4 format for editing, you retain the maximum possible quality.

For more information, see “Working with REDCODE Media.”

Capturing Directly to the Apple ProRes 4444 Codec
You can capture from an HDCAM SR deck via dual-link 4:4:4 HD-SDI directly to the Apple ProRes 4444 codec, retaining full color information.

This workflow could include material shot on the Panavision Genesis and Arriflex D-20/D-21 cameras.

Mastering DPX or Cineon Digital Negative Projects
This could include film-scan workflows or digital cinema cameras (such as the Thomson Viper FilmStream and the Vision Research Phantom) that deliver DPX image sequences for the post-production pipeline. Apple ProRes can be the finishing and mastering format, or it can be used as a very high-quality offline format for digital intermediate workflows that will be finished in DPX for film output.

Transcoding Directly to an Apple ProRes Codec on Ingest
Ingesting or transcoding directly to an Apple ProRes codec is particularly convenient if your project involves multiple camera formats and you want to standardize on a single codec for post-production. This includes retaining the quality in 4:4:4 digital cinema formats by transcoding directly to the Apple ProRes 4444 codec.

Compositing and Visual Effects Projects
The 10-bit, 4:4:4 color space plus an alpha channel is especially useful for compositing and effects projects in both Final Cut Pro and Motion. After the motion graphics (with or without an alpha channel) are created in Motion, they can be preserved in the Apple ProRes 4444 format all the way through to the finish. For more information about preserving the alpha channel in Final Cut Pro, see “Sequence Settings and Presets” in the Final Cut Pro 7 User Manual. For more information about Motion, see the Motion User Manual.

Offline Editing with Apple ProRes Codecs
The offline/online workflow allows you to use temporary, low-quality copies of your footage during editing and then finish your project with full-resolution media. Lower-resolution media files require less hard disk space and less computing power to process transitions and effects. This means you can edit on an inexpensive computer or a portable computer and then finish at full resolution on another system.
Depending on your project and your budget, you could use any of the Apple ProRes codecs for offline editing. On the high end, you might use Apple ProRes 4444 as a very high-quality offline codec for digital intermediate workflows that will be finished in DPX for film output. For a typical HD or SD video project, you can get high quality and superb playback performance with Apple ProRes 422 (LT) or Apple ProRes 422 (Proxy) as your offline format.

All Apple ProRes codecs maintain the source frame size and aspect ratio throughout the offline and online editing phases.

Here are possible offline scenarios using the Apple ProRes format:

- **Ingest media as Apple ProRes files:** In this workflow, you transfer the media to an Apple ProRes codec using the Log and Transfer window, complete the offline edit in the Apple ProRes codec, and then retransfer from the source media using an online-quality Apple ProRes codec (or a different format) to create the master version of the project.

- **Transcode media to Apple ProRes files:** In this workflow, you transcode the media files from an existing Final Cut Pro project to an Apple ProRes codec using the Media Manager in Final Cut Pro (or using Compressor or Final Cut Server), complete the offline edit in the Apple ProRes codec, use the Media Manager to create a master version of the project, and remaster the project in the final media format.

**Using Apple ProRes Codecs in Native Workflows**

If you are editing HDV or Sony XDCAM formats natively, you can choose to create render files using either the native MPEG-2 codec of your sequence or an Apple ProRes codec.

For more information, see “Rendering and Video Processing Settings” in the *Final Cut Pro 7 User Manual*.

**Choosing the Appropriate Apple ProRes Codec**

The following table matches specific camera, recording, or film-scan formats with suggested workflows and corresponding versions of Apple ProRes.

<table>
<thead>
<tr>
<th>Acquisition format</th>
<th>Workflow</th>
<th>Most appropriate Apple ProRes codec</th>
</tr>
</thead>
</table>
| REDCODE            | REDCODE workflows  
  See “Native REDCODE Editing Workflow” and “Transcoded REDCODE Editing Workflow.” | Apple ProRes 4444 |
<p>| HDCAM SR REDCODE   | Projects recorded in 4:4:4 RGB mode and transcoded directly to the Apple ProRes 4444 codec on ingest | Apple ProRes 4444 |</p>
<table>
<thead>
<tr>
<th>Acquisition format</th>
<th>Workflow</th>
<th>Most appropriate Apple ProRes codec</th>
</tr>
</thead>
<tbody>
<tr>
<td>DPX image sequences</td>
<td>Projects that generate DPX image sequences, including those using film-scan workflows or digital cinema cameras</td>
<td>Apple ProRes 4444</td>
</tr>
<tr>
<td>Sony HDCAM SR</td>
<td>Projects recorded on Sony HDCAM SR in 4:4:4 RGB or 10-bit 4:2:2 color mode</td>
<td>Apple ProRes 4444 or Apple ProRes 422 (HQ)</td>
</tr>
<tr>
<td>DVCPro HD</td>
<td>Online master phase of projects that don’t use effects or compositing</td>
<td>Apple ProRes 422 (HQ) or Apple ProRes 422</td>
</tr>
<tr>
<td>AVC-Intra</td>
<td>Online master phase of projects that don’t use effects or compositing</td>
<td>Apple ProRes 422 (HQ) or Apple ProRes 422</td>
</tr>
<tr>
<td></td>
<td>See “Transcoded AVC-Intra Editing Workflow.”</td>
<td></td>
</tr>
<tr>
<td>HDV</td>
<td>Online master phase of projects with heavy effects</td>
<td>Apple ProRes 422 (HQ) or Apple ProRes 422</td>
</tr>
<tr>
<td>Any format</td>
<td>Motion graphics or compositing projects that require an alpha channel</td>
<td>Apple ProRes 4444</td>
</tr>
<tr>
<td>Any format</td>
<td>Workflows that involve offline editing on a MacBook Pro</td>
<td>Apple ProRes 422 (Proxy)</td>
</tr>
<tr>
<td>Multiple camera formats</td>
<td>Projects requiring standardization on a single codec for post-production</td>
<td>A single Apple ProRes codec (depending on source and delivery formats)</td>
</tr>
</tbody>
</table>

**Apple ProRes Format Specifications**

With the Apple ProRes format, you can work in a wide variety of frame sizes, frame rates, bit depths, and even color sample ratios.

**Frame Dimensions Supported in Final Cut Pro with Real-Time Playback**

Although the Apple ProRes format itself supports virtually any frame size, the Final Cut Pro RT Extreme real-time effects architecture supports the following Apple ProRes frame sizes only:

- 720 x 480
- 720 x 486
- 720 x 576
- 960 x 720
- 1280 x 720
- 1280 x 1080
• 1440 x 1080
• 1920 x 1080
• 1024 x 512
• 1024 x 576
• 2048 x 1024
• 2048 x 1080 (Apple ProRes 4444 only)
• 2048 x 1152
• 2048 x 1556 (Apple ProRes 4444 only)

Scanning Method
The Apple ProRes format supports both interlaced and progressive scan images and preserves the scanning method used in the source material.

Color Recording Method
The Apple ProRes format supports the following digital video signals:
• RGB
• 4:2:2 \(Y'\text{C}_b\text{C}_r\)
• 4:4:4 \(Y'\text{C}_b\text{C}_r\)

Data Rates
The actual data rate of Apple ProRes codecs depends on the dimensions, frame rate, image complexity, and quality setting you are using.

The Apple ProRes format has a target data size for every frame, regardless of complexity, but allows frames to fall short of that target if they are simple (if they cannot benefit in quality from using more bits). Such a shortfall is not reclaimed for other frames; instead, it just produces a smaller overall file.

The following table shows several sample data rates. The Apple ProRes codecs are designed to target the data rates shown. Because most sequences contain simple frames, actual bit rates are typically 5 to 10 percent lower than these targets.
### Apple ProRes Tips

This section lists some practical tips for working with Apple ProRes codecs.

**Gamma Correction**

Apple ProRes codecs have a native gamma of 2.2. The Gamma Correction setting in the advanced compression settings pane allows you to disable the automatic 1.8 to 2.2 gamma adjustment that can occur if RGB material at 2.2 gamma is misinterpreted as 1.8. In some cases this gamma adjustment is not desirable (for example, if the source image is RGB 2.2, or if the encoded Apple ProRes file is meant to be used in another RGB-based application).

- **Automatic:** Select the Automatic setting to have the Apple ProRes codec convert RGB 1.8 gamma source media files to 2.2 gamma.
- **None:** Select the None setting to disable the adjustment of 1.8 gamma to 2.2 gamma.

---

<table>
<thead>
<tr>
<th>Frame dimensions</th>
<th>Frame rate</th>
<th>Apple ProRes 4444 data rate</th>
<th>Apple ProRes422 (HQ) data rate</th>
<th>Apple ProRes422 (LT) data rate</th>
<th>Apple ProRes422 (Proxy) data rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>720 x 576</td>
<td>29.97 fps</td>
<td>110 Mbps</td>
<td>73 Mbps</td>
<td>49 Mbps</td>
<td>34 Mbps</td>
</tr>
<tr>
<td>960 x 720</td>
<td>23.98 fps</td>
<td>113 Mbps</td>
<td>75 Mbps</td>
<td>50 Mbps</td>
<td>35 Mbps</td>
</tr>
<tr>
<td>960 x 720</td>
<td>25 fps</td>
<td>118 Mbps</td>
<td>79 Mbps</td>
<td>52 Mbps</td>
<td>36 Mbps</td>
</tr>
<tr>
<td>960 x 720</td>
<td>29.97 fps</td>
<td>141 Mbps</td>
<td>94 Mbps</td>
<td>63 Mbps</td>
<td>44 Mbps</td>
</tr>
<tr>
<td>1280 x 720</td>
<td>23.98 fps</td>
<td>132 Mbps</td>
<td>88 Mbps</td>
<td>59 Mbps</td>
<td>41 Mbps</td>
</tr>
<tr>
<td>1280 x 720</td>
<td>25 fps</td>
<td>138 Mbps</td>
<td>92 Mbps</td>
<td>61 Mbps</td>
<td>42 Mbps</td>
</tr>
<tr>
<td>1280 x 720</td>
<td>29.97 fps</td>
<td>165 Mbps</td>
<td>110 Mbps</td>
<td>73 Mbps</td>
<td>51 Mbps</td>
</tr>
<tr>
<td>1440 x 1080</td>
<td>23.98 fps</td>
<td>226 Mbps</td>
<td>151 Mbps</td>
<td>101 Mbps</td>
<td>70 Mbps</td>
</tr>
<tr>
<td>1440 x 1080</td>
<td>25 fps</td>
<td>236 Mbps</td>
<td>157 Mbps</td>
<td>105 Mbps</td>
<td>73 Mbps</td>
</tr>
<tr>
<td>1440 x 1080</td>
<td>29.97 fps</td>
<td>283 Mbps</td>
<td>189 Mbps</td>
<td>126 Mbps</td>
<td>87 Mbps</td>
</tr>
<tr>
<td>1920 x 1080</td>
<td>23.98 fps</td>
<td>264 Mbps</td>
<td>176 Mbps</td>
<td>117 Mbps</td>
<td>82 Mbps</td>
</tr>
<tr>
<td>1920 x 1080</td>
<td>25 fps</td>
<td>275 Mbps</td>
<td>184 Mbps</td>
<td>122 Mbps</td>
<td>85 Mbps</td>
</tr>
<tr>
<td>1920 x 1080</td>
<td>29.97 fps</td>
<td>330 Mbps</td>
<td>220 Mbps</td>
<td>147 Mbps</td>
<td>102 Mbps</td>
</tr>
<tr>
<td>2048 x 1152</td>
<td>23.98 fps</td>
<td>302 Mbps</td>
<td>201 Mbps</td>
<td>134 Mbps</td>
<td>93 Mbps</td>
</tr>
<tr>
<td>2048 x 1152</td>
<td>25 fps</td>
<td>315 Mbps</td>
<td>210 Mbps</td>
<td>140 Mbps</td>
<td>97 Mbps</td>
</tr>
<tr>
<td>2048 x 1152</td>
<td>29.97 fps</td>
<td>377 Mbps</td>
<td>251 Mbps</td>
<td>168 Mbps</td>
<td>116 Mbps</td>
</tr>
</tbody>
</table>

---

Chapter 10   Working with Apple ProRes
Apple ProRes 4444 Files with Alpha Channel and the Video Render Status Bar
When you import an Apple ProRes 4444 file with an embedded alpha channel, Final Cut Pro detects the alpha channel and sets the Alpha value to either Black or Straight (instead of None/Ignore). If you add the clip to a matching Apple ProRes 4444 sequence, the video render status bar in the Timeline may change color accordingly.

About the Apple Intermediate Codec
The Apple Intermediate Codec is a high-quality 8-bit 4:2:0 video codec used mainly as a less processor-intensive way of working with long-GOP MPEG-2 footage such as HDV. The Apple Intermediate Codec is recommended for use with all HD workflows in Final Cut Express and iMovie.

<table>
<thead>
<tr>
<th>Format</th>
<th>Frame dimensions</th>
<th>Frame rate</th>
<th>Scanning method</th>
</tr>
</thead>
<tbody>
<tr>
<td>720p</td>
<td>1280 x 720</td>
<td>29.97 fps</td>
<td>Progressive</td>
</tr>
<tr>
<td>1080i</td>
<td>1440 x 1080</td>
<td>25 and 29.97 fps</td>
<td>Interlaced</td>
</tr>
<tr>
<td>1080p</td>
<td>1440 x 1080</td>
<td>23.98, 25, and 29.97 fps</td>
<td>Progressive</td>
</tr>
</tbody>
</table>
This chapter covers the following:

- About REDCODE (p. 119)
- Native REDCODE Editing Workflow (p. 121)
- Transcoded REDCODE Editing Workflow (p. 126)
- Finishing and Outputting REDCODE Projects (p. 129)
- REDCODE Format Specifications (p. 130)

You can use Final Cut Pro to ingest and edit REDCODE media for output to film, digital cinema formats, and HD and SD video.

**About REDCODE**

REDCODE is an ultra high-resolution format used by the RED ONE camera manufactured by the RED Digital Cinema Camera Company. The REDCODE format is designed to produce digital media with resolutions sufficient for film and digital cinema distribution. With resolutions much higher than those used in HD video, REDCODE is not strictly an HD format, although it can be transcoded and downconverted to standard HD and SD video formats.

You can use Final Cut Pro to edit the native REDCODE media. When Final Cut Pro ingests REDCODE files, it wraps the native R3D files in a QuickTime wrapper, which provides compatible applications with the ability to access the native data at whatever resolution you choose. You then edit your media in Final Cut Pro. You can also send your media to Color for grading and color correction. When you finish color correction, you can use Color to output the media as Apple ProRes files, as uncompressed HD files, or as DPX image sequences for use with other finishing software or digital intermediate workflows.

You can also use Final Cut Pro to transcode the REDCODE media to an Apple ProRes codec and then do an online or offline edit of the project.
About the RED ONE Camera

The RED ONE camera uses a 12-megapixel CMOS sensor to capture images at a number of resolutions. For Final Cut Studio workflows, 4K and 2K are recommended resolutions. For the latest information about the RED ONE camera specifications and formats, go to the RED Digital Cinema Camera Company website at http://www.red.com.

<table>
<thead>
<tr>
<th>Format</th>
<th>Resolution</th>
<th>Aspect ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>2K RAW</td>
<td>2048 x 1152 pixels</td>
<td>16:9</td>
</tr>
<tr>
<td>2K RAW</td>
<td>2048 x 1024 pixels</td>
<td>2:1</td>
</tr>
<tr>
<td>4K RAW</td>
<td>4096 x 2304 pixels</td>
<td>16:9</td>
</tr>
<tr>
<td>4K RAW</td>
<td>4096 x 2048 pixels</td>
<td>2:1</td>
</tr>
</tbody>
</table>

The RED ONE camera is designed to produce high-resolution media for editing and digital intermediate processing without requiring film scanning. During post-production, film is typically digitally scanned at 2K or 4K resolution to produce digital files for editing and grading. This digital stage of theatrical film production is called digital intermediate (DI). During post-production, the DI files are edited, graded, and then typically output to film.

Because the sensor in the RED ONE camera can capture images at the same frame sizes as Super 35mm film or Super 16mm film and at 2K or 4K resolution, the REDCODE image information is closely equivalent in definition to 2K or 4K digitized film footage. In effect, the RED ONE camera captures media directly to the digital intermediate stage. This provides the advantage of skipping film scanning and allows immediate previewing and post-production editing and grading, especially streamlining the production of dailies.

Using the REDCODE codec, the RED ONE camera captures 4K RAW data at up to 30 fps and captures 2K RAW data at up to 120 fps. The REDCODE color sample ratios are 4:4:4 RGB and 4:2:2 Y’CbCr with 12 bits per sample. Audio is recorded in 24-bit, four-channel uncompressed sound at a 48 KHz sample rate.

The camera records data directly to proprietary hard disk drives and CompactFlash cards. Hard disk drives can be connected directly to your computer, and CompactFlash cards can be connected to your computer using a card reader. You can then download the files to other large storage devices, such as large-capacity hard disk drives or RAID storage servers. You can access and edit the files using Final Cut Pro, or further process them using the RED ONE camera software or other DI finishing software.

Working with REDCODE Media in Final Cut Pro

Although there are several alternative workflows, depending on the final output you want, there are two main recommended workflows for working with REDCODE media in Final Cut Pro:

- **Native editing for REDCODE media**: For more information, see “Native REDCODE Editing Workflow.”
• **Transcoding using Apple ProRes codecs**: For more information, see “Transcoded REDCODE Editing Workflow.”

**Important**: The RED ONE camera can produce REDCODE media and QuickTime reference movies that represent the media, storing all the files together in clip folders. However, Apple doesn’t recommend using the QuickTime reference movies. The recommended workflows are to ingest and edit the native REDCODE files or to transcode the REDCODE files to an Apple ProRes codec.

The following restrictions apply when working with REDCODE media:

• REDCODE media support is available only on Intel-based Mac computers.

• Final Cut Pro can ingest either 4K or 2K REDCODE files, but the working resolution inside Final Cut Pro and QuickTime will be 2K. Grading and color correction in Color is not subject to this limitation. The working resolution in Color, and any output from Color, will match the native (4K or 2K) resolution.

• You must install the latest RED QuickTime codec and software.

• Working with RED ONE camera media requires your Mac to have Mac OS X version 10.4.11 or later.

• To preview REDCODE media in the Log and Transfer window, you must install the RED FCP Log and Transfer plug-in, available at http://www.red.com/support.

**Native REDCODE Editing Workflow**

It’s recommended that you use the RED ONE camera to shoot in 4K RAW. You ingest the REDCODE files using the RED QuickTime codec, and the media is converted to QuickTime files. (Technically, you are wrapping the R3D source media in a QuickTime wrapper, which provides compatible applications with the ability to access the native 4K source data at whatever resolution you choose.) You then perform an edit of your media with 2K sequence settings.
After the edit, you can send your media to Color, which can extract the full-resolution 4K data from one of these QuickTime-wrapped R3D source files. You use Color to grade the sequence and render it as DPX files, uncompressed HD files, or Apple ProRes files. You can also transfer the DPX files to a digital intermediate software finishing application or output the finished DPX files to film or to digital cinema files.

Important: Ingesting REDCODE files requires the RED QuickTime plug-in and the RED FCP Log and Transfer plug-in to be installed and selected when you ingest the REDCODE files. These items are available for download from the RED Digital Cinema Camera Company website at http://www.red.com/support.

Before ingesting the REDCODE files, you must configure the Log and Transfer window preferences. For more information, see “Stage 2: Choosing the RED FCP Log and Transfer Plug-in for Transfer.”

After ingesting your media, you can configure your sequence settings by dragging a REDCODE clip into a new, empty sequence. Final Cut Pro automatically conforms the sequence compression setting to the Apple ProRes 4444 codec, which is the appropriate rendering format for REDCODE media. After you ingest your REDCODE media and convert it to QuickTime files, you cannot render your media back to native REDCODE media because the REDCODE codec does not support encoding.

You edit the resulting REDCODE QuickTime files just as you would edit DV or uncompressed video. To facilitate editing REDCODE media, you should set your sequence settings to Unlimited RT and medium quality (to display the video at half its full dimensions).

The advantage of this workflow is that you can output from Final Cut Studio to DPX files or Apple ProRes 4444 files at 2K or 4K resolution, suitable for final processing by a digital intermediate finishing system. However, this workflow requires large amounts of disk space to hold the REDCODE and DPX files. In addition, you won’t have full real-time playback in Final Cut Pro and must use Unlimited RT.
Important: New methods for ingesting REDCODE files into Final Cut Pro are being developed on a regular basis. For more information about the latest workflows for working with REDCODE media, go to the RED Digital Cinema Camera Company website at http://www.red.com.

The native REDCODE workflow follows the standard process for ingesting file-based media using the Log and Transfer window.

• Stage 1: Copying REDCODE Media Files to Your Computer
• Stage 2: Choosing the RED FCP Log and Transfer Plug-in for Transfer
• Stage 3: Transferring REDCODE Media
• Stage 4: Editing REDCODE Video

Stage 1: Copying REDCODE Media Files to Your Computer
After shooting REDCODE media, connect the camera’s hard disk drive to your computer, or insert the CompactFlash card into a card reader connected to your computer. See the documentation that came with your RED ONE camera for more detailed information. Download your files to the hard disk storage device that you will access with Final Cut Pro. Be sure to also archive copies of your REDCODE media on a separate storage device for safekeeping.

Because REDCODE media can require large amounts of disk space, be sure to have adequate storage capacity available to hold your entire project. When recording 4K RAW at 24 fps, a 320 GB hard disk can record about 180 minutes of media. When recording 2K RAW at 24 fps, a 320 GB hard disk can hold about 720 minutes of media.

When downloading your REDCODE media files, keep the following recommendations in mind:

• Copy the entire contents of the CompactFlash card or hard disk to a folder or disk image. Each folder or disk image you copy REDCODE media into must have a unique name, preferably one that clearly identifies the contents. After you copy REDCODE media into a folder, the folder will have one or more subfolders with an .RDM extension that contain the actual REDCODE media. During the log and transfer process, Final Cut Pro uses the name of the .RDM folder as the reel name for any source media file enclosed in that folder.

• Because the reel name is a critical part of organizing a post-production project and crucial to any further use of the REDCODE media, it’s a good idea to rename the .RDM folder to something meaningful and easily identifiable for your workflow. For example, you could change the automatically generated folder name H046_100145.RDM to Day01_Scene05.RDM. The .RDM folder must have a unique name. Do not under any circumstances change the names of any folders or files inside the .RDM folder.
• After you have ingested the media using the Log and Transfer window, do not change the name of the .RDM folder again, and do not change the name of any other file or folder. Doing so will jeopardize your ability to later reconform offline sequences to the original source media.

**Important:** Make sure to name the .RDM folder before ingesting. Using the Reel field of the Log and Transfer window to enter new reel names for REDCODE media during ingest is not recommended.

• Always copy the entire contents of each RED volume to an individually named folder or disk image. Do not combine the contents of several RED volumes into a single folder. For example, don’t make a folder called RED MEDIA and put all the .rdc and .profile items in it.

• Do not nest folders of RED content within each other.

• Do not place the contents of the RED volume in your Capture Scratch folder.

• If you plan to output to film, be sure to follow these instructions:
  • Your base project frame rate should be either 23.98 or 24 fps. All media in a sequence should be REDCODE media. You cannot transfer mixed-format sequences for grading in the Color RED room.
  • Do not mix REDCODE volumes and media with folders of DPX images in the same folder structure.

Stage 2: Choosing the RED FCP Log and Transfer Plug-in for Transfer

To ingest the REDCODE files, you open the Log and Transfer window and choose the RED FCP Log and Transfer plug-in.

Make sure you have installed the RED QuickTime codec and the RED FCP Log and Transfer plug-in. These items are available for download from the RED Digital Cinema Camera Company website at [http://www.red.com/support](http://www.red.com/support).

**To choose the RED FCP Log and Transfer plug-in in the Log and Transfer window**

1. Mount the volumes that contain your REDCODE media.

2. Open the Log and Transfer window, then choose Preferences from the Action pop-up menu (with a gear icon) in the upper-right corner of the Browse area.

3. In the Import Preferences dialog, choose Native from the pop-up menu in the “Transcode to” column corresponding to the RED Digital Cinema REDCODE item in the list.

4. Click OK.

For more information about using the Log and Transfer window, see “Overview of Transferring File-Based Media” and “About the Log and Transfer Window” in the *Final Cut Pro 7 User Manual*. 
Stage 3: Transferring REDCODE Media

You can transfer REDCODE media to your scratch disk using the Log and Transfer window in Final Cut Pro. For more information about using the Log and Transfer window, see “Overview of Transferring File-Based Media” and “About the Log and Transfer Window” in the Final Cut Pro 7 User Manual.

After ingesting the REDCODE files, the working resolution of your ingested clips will be 2K, with either a resolution of 2048 x 1024 pixels and an aspect ratio of 2:1 or a resolution of 2048 x 1152 pixels and an aspect ratio of 16:9.

Important: Although it is possible to copy REDCODE files directly to your scratch disk, Final Cut Pro won’t recognize these files. You must use the Log and Transfer window to transfer the REDCODE media.

Stage 4: Editing REDCODE Video

To edit REDCODE video, have Final Cut Pro automatically configure the sequence settings to Apple ProRes and use Unlimited RT in the Timeline for maximum responsiveness.

To configure a new sequence to support REDCODE media

1. If you haven’t already done so, ingest a REDCODE media clip into a Final Cut Pro project. (See “Stage 3: Transferring REDCODE Media.”)

2. Create a new sequence and open it.

3. Drag the REDCODE clip into the Timeline.

4. When the resulting dialog asks if you want to change the sequence settings to match the clip settings, click Yes.

   Final Cut Pro automatically configures the sequence to Apple ProRes 4444. This the most appropriate setting because REDCODE media uses 4:4:4 RGB color and Apple ProRes 4444 retains the full color with no chroma subsampling.

   Note: Do not change the compressor setting to REDCODE, because encoding functionality is not supported by the REDCODE codec.

To set the Timeline to use Unlimited RT

- Choose the following settings in the RT pop-up menu in the upper-left corner of the Final Cut Pro Timeline:
  - Unlimited RT
  - Playback Video Quality: Low or Medium
    Medium-quality playback shows video at half its full dimensions.
  - Playback Frame Rate: Full

After you’ve completed your edit, you have a range of finishing and output options. For more information, see “Finishing and Outputting REDCODE Projects.”
Transcoded REDCODE Editing Workflow

When you ingest the REDCODE files for this workflow, you transcode the files to an Apple ProRes codec. For the best-quality media, use the Apple ProRes 4444 codec or the Apple ProRes 422 (HQ) codec. However, if you're doing an offline edit or producing an EDL, and media quality for editing is not an issue, you can save disk space and bandwidth by editing with Apple ProRes 422, Apple ProRes 422 (LT), or even Apple ProRes 422 (Proxy) files.

The transcoded media results in self-contained QuickTime movies that you can edit in the Final Cut Pro Timeline. Note that transcoding REDCODE files to one of the Apple ProRes codecs can take an extended time because of the size and complexity of the REDCODE files.

**Important:** Transcoding REDCODE files requires the RED QuickTime plugin and the RED FCP Log and Transfer plugin to be installed and selected when you ingest the REDCODE files. These items are available for download from the RED Digital Cinema Camera Company website at http://www.red.com/support.

Before ingesting the REDCODE files, you must specify an Apple ProRes codec as the destination format in the Log and Transfer window preferences. For more information, see “Stage 2: Choosing an Apple ProRes Codec for Transcoding.”

You edit the transcoded files just as you would edit DV or uncompressed video. You can send the files to Color, grade them, and return the graded files to Final Cut Pro for further finishing. You can then output to tape or media file in any of the standard Final Cut Pro HD or SD video formats.

The disadvantage of this workflow is that you must grade the files that have been transcoded to an Apple ProRes codec; you cannot grade your native REDCODE media. Your native REDCODE media provides direct access to the original RAW camera data for specifically compatible applications.

The transcoded REDCODE workflow follows the standard process for ingesting file-based media using the Log and Transfer window.

- Stage 1: Downloading REDCODE Media Files to Your Computer
- Stage 2: Choosing an Apple ProRes Codec for Transcoding
Stage 1: Downloading REDCODE Media Files to Your Computer

After shooting REDCODE media, connect the camera’s hard disk drive to your computer, or insert the CompactFlash card into a card reader connected to your computer. See the documentation that came with your RED ONE camera for more detailed information. Download your files to the hard disk storage device that you will access with Final Cut Pro. Be sure to also archive copies of your REDCODE media on a separate storage device for safekeeping.

Because REDCODE media can require large amounts of disk space, be sure to have adequate storage capacity available to hold your entire project. When recording 4K RAW at 24 fps, a 320 GB hard disk can record about 180 minutes of media. When recording 2K RAW at 24 fps, a 320 GB hard disk can hold about 720 minutes of media.

When downloading your REDCODE media files, keep the following recommendations in mind:

- Copy the entire contents of the CompactFlash card or hard disk to a folder or disk image. Each folder or disk image you copy REDCODE media into must have a unique name, preferably one that clearly identifies the contents. After you copy REDCODE media into a folder, the folder will have one or more subfolders with an .RDM extension that contain the actual REDCODE media. During the log and transfer process, Final Cut Pro uses the name of the .RDM folder as the reel name for any source media file enclosed in that folder.

- Because the reel name is a critical part of organizing a post-production project and crucial to any further use of the REDCODE media, it’s a good idea to rename the .RDM folder to something meaningful and easily identifiable for your workflow. For example, you could change the automatically generated folder name H046_100145.RDM to Day01_Scene05.RDM. The .RDM folder must have a unique name. Do not under any circumstances change the names of any folders or files inside the .RDM folder.

- After you have ingested the media using the Log and Transfer window, do not change the name of the .RDM folder again, and do not change the name of any other file or folder. Doing so will jeopardize your ability to later reconform offline sequences to the original source media.

**Important:** Make sure to name the .RDM folder before ingesting. Using the Reel field of the Log and Transfer window to enter new reel names for REDCODE media during ingest is not recommended.
Always copy the entire contents of each RED volume to an individually named folder or disk image. Do not combine the contents of several RED volumes into a single folder. For example, don’t make a folder called RED MEDIA and put all the .rdc and .profile items in it.

Do not nest folders of RED content within each other.

Do not place the contents of the RED volume in your Capture Scratch folder.

**Stage 2: Choosing an Apple ProRes Codec for Transcoding**

Decoding native REDCODE media for playback requires a lot of processing power. To reduce the processing demands on your computer, you can use the Log and Transfer window to transcode your REDCODE media to the less processor-intensive Apple ProRes format. Your sequence settings then change to the default Apple ProRes settings appropriate to the ingested media.

**To choose the destination codec for transcoded REDCODE media**

1. Mount the volumes that contain your REDCODE media.
2. Open the Log and Transfer window, then choose Preferences from the Action pop-up menu (with a gear icon) in the upper-right corner of the Browse area.
3. In the Import Preferences dialog, click the disclosure triangle beside “RED FCP Log and Transfer plugin” in the Source column, then select RED Digital Cinema REDCODE.
4. Choose an Apple ProRes codec from the pop-up menu in the “Transcode to” column corresponding to the RED Digital Cinema REDCODE item in the list, then click OK.

For more information about using the Log and Transfer window, see “Overview of Transferring File-Based Media” and “About the Log and Transfer Window” in the *Final Cut Pro 7 User Manual*.

**Stage 3: Transcoding Your REDCODE Media**

You transfer REDCODE media to your scratch disk using the Log and Transfer window in Final Cut Pro. During the transfer, your media will be transcoded to an Apple ProRes codec. For more information about using the Log and Transfer window, see “Overview of Transferring File-Based Media” and “About the Log and Transfer Window” in the *Final Cut Pro 7 User Manual*.

After you ingest the REDCODE files, your ingested clips will have a working resolution in Final Cut Pro of either 2048 x 1024 (with a 2:1 aspect ratio) or 2048 x 1152 (with a 16:9 aspect ratio).

**Important:** Although it is possible to copy REDCODE files directly to your scratch disk, Final Cut Pro won’t recognize these files. You must use the Log and Transfer window to transfer REDCODE media.
Stage 4: Editing Video Using Transcoded REDCODE Media

Editing video transcoded to an Apple ProRes codec is the same as editing other formats in Final Cut Pro. However, you need to make sure your scratch disk supports the data rate.

For more information about the data rates of the Apple ProRes codecs, see “Working with Apple ProRes.”

After you've completed your edit, you have a range of finishing and output options. For more information, see “Finishing and Outputting REDCODE Projects.”

Finishing and Outputting REDCODE Projects

After you've completed your edit in Final Cut Pro, you have a range of finishing and output options for your REDCODE project.

Using Color in a REDCODE Project

You can send your REDCODE project to Color for grading and color correction.

For more information, see the Color User Manual.

Sending a Project to Color

To ensure a successful color grading and correction phase of your project, you should follow certain guidelines and prepare your Final Cut Pro sequence ahead of time. For example, if you will be exporting your files from Color as DPX files, it’s best to do a cuts-only edit. You can export any selected REDCODE sequence, but you can export only one sequence to Color at a time. For complete details, see the Color User Manual.

1. Select a sequence in the Browser or open a sequence in the Timeline.
2. Choose File > Send To > Color.
3. In the Send To Color dialog, enter a Color project name in the Color Project Name field, then click OK.

Outputting DPX Files from Color

After you use Color to grade the native REDCODE files, you can output your project to DPX files for further finishing and output in a DI software finishing application. For a detailed explanation of outputting DPX files and preparing them for final DI output, see “Color Correction Workflows” in the Color User Manual.
Outputting to Tape and Other Formats
After you finish editing, you can output your movie to videotape or export your sequence to Compressor. You can also use the Share feature to quickly create and deliver output media files in iPod, iPhone, Apple TV, MobileMe, DVD, Blu-ray Disc, YouTube, and Apple ProRes formats.

Few video decks support media formats with digital cinema frame sizes, such as REDCODE. You may have to choose another format for output to tape, such as an HD or SD format.

Before you output the Apple ProRes video to tape, make sure the video is output at a legal size and frame rate for the format you want. You can place your Apple ProRes media in a sequence that has the output settings you want, or you can use a video interface card to crop the media to an HD frame size. You can also use Compressor to configure a crop or to scale down the media to HD or SD formats.

To output to tape, follow the standard procedures for using the Print to Video command. For more information, see the Final Cut Pro 7 User Manual.

To export your sequence to Compressor
1. Open your Final Cut Pro sequence in the Timeline.
2. Choose File > Send To > Compressor.
   For more information about sending to Compressor, see the Compressor User Manual.

To export a clip or sequence using Share
1. In Final Cut Pro, select the clip or sequence you want to export.
2. Choose File > Share.
   The Share window appears.

REDCODE Format Specifications
REDCODE has the following format specifications.

Storage Medium
REDCODE media is recorded on RED-DRIVE (RAID) hard disks, RED FLASH hard disk drives, and RED FLASH CompactFlash cards.

Aspect Ratio
REDCODE media has aspect ratios of 2:1 and 16:9.
Frame Dimensions and Resolution
The REDCODE format supports a number of RAW native video resolutions.

<table>
<thead>
<tr>
<th>Format</th>
<th>Resolution</th>
<th>Aspect ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>1K RAW</td>
<td>1024 x 576 pixels</td>
<td>16:9</td>
</tr>
<tr>
<td>1K RAW</td>
<td>1024 x 512 pixels</td>
<td>2:1</td>
</tr>
<tr>
<td>2K RAW</td>
<td>2048 x 1152 pixels</td>
<td>16:9</td>
</tr>
<tr>
<td>2K RAW</td>
<td>2048 x 1024 pixels</td>
<td>2:1</td>
</tr>
<tr>
<td>3K RAW</td>
<td>3072 x 1728 pixels</td>
<td>16:9</td>
</tr>
<tr>
<td>3K RAW</td>
<td>3072 x 1536 pixels</td>
<td>2:1</td>
</tr>
<tr>
<td>4K RAW</td>
<td>4096 x 2304 pixels</td>
<td>16:9</td>
</tr>
<tr>
<td>4K RAW</td>
<td>4096 x 2048 pixels</td>
<td>2:1</td>
</tr>
</tbody>
</table>

Frame Rate
Final Cut Pro supports the following REDCODE frame rates for film workflows:
- 4K 2:1 and 2K 2:1 at 23.98 and 24 fps

Final Cut Pro supports the following REDCODE frame rates for video workflows:
- 4K 2:1 and 2K 2:1 at 23.98, 24, 25, 29.97, 50, and 59.94 fps

Scanning Method
4K and 2K REDCODE are recorded as progressive scan images.

Color Recording Method
REDCODE records 12-bit RGB color.

Audio
REDCODE uncompressed audio has four audio channels, a sample rate of 48 kHz, and 24-bit resolution per sample.

Timecode
The RED ONE camera records two independent timecode tracks:
- *Edge code:* SMPTE timecode that always starts at 1:00:00:00 on the first frame of the first clip recorded onto a blank magazine. The timecode of each subsequent clip is recorded sequentially and continuously as more and more clips are recorded.
- *Timecode:* SMPTE timecode that records the camera’s clock or an externally supplied SMPTE master timecode signal